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Chapitre 1 : Introduction 1

chapitre 1

Introduction

Ce chapitre présente les nouvelles 
fonctionnalités de Pro Tools® HD 8.0 pour les 
systèmes Pro Tools|HD® sur des versions agréées 
par Digidesign® de Windows ou Mac OS X.

Configuration requise et 
compatibilité
Digidesign peut assurer la compatibilité et 
fournir une assistance uniquement pour les 
matériels et les logiciels testés et approuvés par 
ses soins. 

Pour connaître la configuration système 
complète et la liste des ordinateurs, systèmes 
d’exploitation, disques durs et périphériques 
tiers approuvés par Digidesign, reportez-vous 
aux informations de compatibilité sur le site 
Web de Digidesign, à l'adresse :

www.digidesign.com/compatibility

Nouvelles fonctions de 
Pro Tools HD 8.0
Pro Tools HD 8.0 inclut les éléments suivants :

Améliorations et nouveautés Pro Tools 
générales

• Interface utilisateur améliorée et actualisée

• Boîte de dialogue Pro Tools Quick Start 
permettant de créer rapidement et facilement 
des sessions entièrement ou en les basant sur 
des modèles, ou encore d'ouvrir des sessions 
existantes

• Nouveaux modèles de session

• Notification de mise à jour automatique et 
vérification automatique des mises à jour 

• Ouverture de session avec des plug-in 
désactivés

• Gestion du cache DSP pour accélérer 
l'ouverture et la fermeture de sessions

• Gestion des fenêtres améliorée : 

• Mosaïque

• Cascade

• Configurations de fenêtres avec la fenêtre 
de l'éditeur Score et la fenêtre cible de 
l'éditeur MIDI

• Palette de couleurs améliorée

• Nouveaux paramètres de buffer matériel RTAS

• Augmentation de la taille limite des fichiers 
audio

• Augmentation de la résolution de forme 
d'onde

• Décalage d'échantillon MIDI Beat Clock 
individuel sur chaque port
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Modification des préférences de 
Pro Tools

Préférences d'affichage

• Option “MIDI Note Color Shows Velocity”

Préférences de fonctionnement

• Option “Latch Forward/Rewind”

• Option “Automatically Create New 
Playlists When Loop Recording”

• Option “Show Quick Start Dialog When 
Pro Tools Starts”

Préférences d'édition

• Les options suivantes de la liste des prises 
“Matching Start Time” ont été déplacées vers 
la boîte de dialogue Match Criteria :

• “Includes Take Region Names That Match 
Track Names”

• “Includes Take Regions Lengths That 
Match”

Préférences MIDI

• L'option “Play MIDI Notes When Editing” a 
été déplacée vers la fenêtre Edit et les fenêtres 
de l'éditeur MIDI et Score

• Option “Remove Range Selection After 
Opening the MIDI/Score Editor”

• Le paramètre “Default Note On Velocity” a été 
déplacé vers la fenêtre Edit et les fenêtres de 
l'éditeur MIDI et Score

• Options “Double-clicking a Region 
Opens…” :

• MIDI Editor

• Score Editor

• MIDI Event List

• Name Dialog

• Section Affichage de l'éditeur MIDI/Score :

• Paramètre “Additional Empty Bars in the 
Score Editor”

Préférences de synchronisation

• Section Synchronization :

• Paramètre “Delay Before Locking to 
Longitudinal Time Code”

• Paramètre “Delay Before Locking to Serial 
Time Code”

• Section Satellite Link :

• Transmit Solos

• Receive Solos

• Solo Independent Of Linked State

• DAE Errors Stop All Linked Systems

• Transmit Play Selections

• Receive Play Selections

Améliorations et nouveautés d'édition

Fonctionnalités de la fenêtre Edit

• Nouvelle vue Universe

• Nouvelle vue de l'éditeur MIDI

• Nouvelles vues Waveform

• Barre d'outils personnalisable

• Règle de symboles d'accord

• Restauration de la dernière sélection

• Commandes et améliorations principales 
de la sélection d'édition

• Edition des régions et verrouillage temporel

• Les pistes MIDI et instrumentales s'ouvrent 
par défaut dans la vue Regions de la fenêtre 
Edit

• Indicateur Timeline Insertion Follows 
Playback

• Suppression du silence jusqu'à –96 dB
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Transposition de la hauteur du son basée sur les 
régions Elastic Audio (demi-tons et cents)

• Les opérations d'événement de 
transposition sont désormais applicables 
aux régions Elastic Audio

• Paramètre Pitch Elastic Audio Property

Préparation de pistes composites

• Vue Playlists Track

• Classement des régions

• Critères d'équivalence

Fenêtres de l'éditeur MIDI

• Pistes MIDI et d'instrument superposées

• Pistes d’entrée auxiliaire

• Plusieurs lignes d'automation et de contrôleur 
(par exemple, vélocité, volume et 
panoramique)

• Vue Notation ou Piano Roll

• Edition de groupe de régions MIDI

• Améliorations supplémentaires au niveau de 
l'édition MIDI :

• Séparation des notes MIDI

• Regroupement des notes MIDI

• Coupures du son des notes MIDI

• Fonctions Scrub/Shuttle MIDI

• Ecoute des changements de vélocité

• Lecture des notes MIDI lors de la tabulation

Fenêtre de l'éditeur Score

• Vous pouvez afficher plusieurs pistes MIDI et 
d'instrument dans la fenêtre de l'éditeur Score 
indépendamment de la fenêtre Edit et de la 
fenêtre de l'éditeur MIDI

• Transcription MIDI en temps réel

• Edition en temps réel (lien entre la fenêtre 
Edit, les fenêtres de l'éditeur MIDI et de 
l'éditeur Score et la liste des événements MIDI)

• Mise en page

• Impression de la musique ou des partitions 
telle qu'à l'écran

• Attributs de portée globaux et locaux

• Chaque piste est affichée sur une double 
portée ou une portée simple :

• Double portée avec point de séparation 
défini automatiquement ou par l'utilisateur

• Clef de sol, d'ut, ténor et de fa

• Affichage de la transposition des instruments 
transposés

• Affichage et modification des signatures de 
tonalité

• Affichage et modification des changements de 
métrique

• Affichage et modification des symboles 
d'accord

• Exportation de fichiers Sibelius (.sib)
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Améliorations et nouveautés de 
mixage de Pro Tools

• Lignes d'automation des pistes et du 
contrôleur pour modifier l'automation des 
pistes (par exemple, l'automation du volume, 
du panoramique et des plug-in) et le 
contrôleur continu MIDI (par exemple, 
vélocité, pitchbend et modulation) sans 
changer l'affichage des pistes 

• 10 inserts par piste

• Amélioration de la compensation 
automatique des retards pour les 
enregistrements fractionnés

Plug-in

Plug-in Creative Collection A.I.R.

• Plug-in d'instrument : 

• Boom

• DB-33

• Mini Grand

• Structure Free

• Vacuum

• Xpand!2

• Plug-in d'effet :

• Chorus 

• Decimator

• Distortion

• Dynamic Delay 

• Enhancer

• Ensemble

• Filter-Gate-Sequencer

• Flanger

• Frequency Shifter

• FuzzWah

• KillEQ

• MultiChorus

• MultiTap Delay 

• Nonlinear Reverb 

• Phaser

• Reverb

• Spring Reverb 

• StereoWidth

• Talkbox

• Vintage Filter

Plug-in supplémentaires fournis avec Pro Tools 
(payants dans les versions précédentes)

• Eleven™ Free

• Digidesign Maxim™

• Digidesign D-Fi™

• Sci-Fi™

• Lo-Fi™

• Recti-Fi™

• Vari-Fi™

• Bomb Factory Sans Amp

Utilitaires TL gratuits et installés avec Pro Tools

• TL Metro™

• TL InTune™

• TL MasterMeter™

DigiRack EQ III

• Stereo version

DigiRack D-Verb 

• Chorus ajouté à la version RTAS

• Glisser-déposer dans les plug-in (par exemple, 
Transfuser™) :

• Régions MIDI

• Groupes de régions

• Fonctions de recherche et de rétablissement 
des liens pour les plug-in pouvant importer 
des fichiers audio (Transfuser par exemple)

• Améliorations des aperçus AudioSuite ™
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Améliorations et nouveautés du 
contrôleur Pro Tools

• Accès à 10 inserts

• Affectation de plug-in

• Nouveau mode Matrix Assign

• Interrogation des paramètres d'E/S piste par 
piste

• Améliorations D-Command® :

• Edition des voies de plug-in

• Modification de paramètres de plug-in

• Améliorations des touches programmables 
ICON :

• Nouvelle disposition AutoWrite

• Prise en charge des configurations de 
fenêtres Pro Tools

• Emplacements mémoire d'écriture

• Affichage de l'éditeur MIDI 
(activer/désactiver)

• Touche programmable Audio Files

• Touche programmable Modes

• Touche programmable Operations de 
D-Command

• Touches programmables avec aucune 
session ouverte

• Indentification des inserts et des départs vides

• Aucun membre de groupe sur les codeurs VCA 
principaux

• Suppression de plusieurs assignations dans 
ICON

Compatibilité vidéo entre Pro Tools et 
Avid 

• Prise en charge de la lecture QuickTime HD à 
l'aide d'une carte vidéo Blackmagic DeckLink 
agréée Digidesign (Mac uniquement)

• Prise en charge de Windows Vista pour 
Interplay

Option logicielle Media Composer Video Satellite

• Prise en charge de Video Satellite avec 
Pro Tools et Avid® Media Composer® 3.1 avec 
des périphériques Avid Mojo® DX et 
Nitris® DX

Option logicielle Video Satellite LE 

(Mac uniquement)

• Vous permet de relier un système Pro Tools 
LE® Mbox® 2 Micro à un système Pro Tools 
HD pour une utilisation au format Video 
Satellite QuickTime HD

Option logicielle Satellite Link

• Prise en charge permettant de relier un 
transport Pro Tools à plusieurs systèmes 
Pro Tools|HD
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chapitre 2

Améliorations et nouveautés Pro Tools 
générales

Nouvelle interface utilisateur Pro Tools
Pro Tools 8.0 présente une nouvelle interface utilisateur graphique (GUI) à la fois intuitive et 
esthétique. Vous retrouverez la plupart des fonctionnalités habituelles de Pro Tools, avec quelques 
subtiles améliorations et un accès simplifié à des options d'édition qui se trouvaient auparavant dans 
les préférences de Pro Tools.

Figure 1.  Nouvelle interface utilisateur graphique Pro Tools : fenêtres Edit, Mix, Plug-in et Transport affichées
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Boîte de dialogue Quick Start 
Session
Pro Tools 8.0 fournit une nouvelle boîte de 
dialogue Quick Start au démarrage, qui vous 
permet de créer facilement et rapidement une 
session ou d'en ouvrir une existante. Vous 
pouvez choisir d'afficher ou de masquer la boîte 
de dialogue Quick Start au démarrage dans les 
préférences de fonctionnement de Pro Tools.

Au premier démarrage de Pro Tools, la boîte de 
dialogue Quick Start vous invite à effectuer l'une 
des opérations suivantes :

• Créer une session à partir d'un modèle.

• Créer une session vide.

• Ouvrir l'une des dix dernières sessions 
utilisées.

• Ouvrir une autre session de votre système.

Création d'une session à partir d'un 
modèle

Pour créer une session à partir d'un modèle :

1  Sélectionnez Create Session from Template.

2  Dans le menu déroulant Session Template, 
sélectionnez la catégorie des modèles de session 
souhaités.

3  Sélectionnez dans la liste le modèle de session 
à utiliser (sur la droite).

Pour plus d'informations sur les fonctions d'édition associées à la nouvelle interface, reportez-vous 
au chapitre 4, “Améliorations et nouveautés d'édition”.

Maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) pendant que 
vous cliquez sur la touche fléchée Haut/Bas 
pour sélectionner les différentes options 
Quick Start de la session. Vous pouvez 
également utiliser les flèches vers Haut/Bas 
pour sélectionner différents éléments de la 
liste des sessions récentes et des modèles de 
session.

Boîte de dialogue Quick Start

Bouton d'affichage 
Liste des modèles 

Menu déroulant Session Template 

des paramètres de session 
de session
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4  Pour modifier l'un des paramètres de session, 
cliquez sur le bouton Session Parameters.

5  Configurez un ou plusieurs des paramètres de 
session suivants, le cas échéant :

• Type de fichier audio

• Bit Depth

• Fréquence d'échantillonnage

6  Cliquez sur OK.

7  Dans la boîte de dialogue d'enregistrement, 
attribuez un nom à la session, choisissez 
l'emplacement où vous voulez l'enregistrer, puis 
cliquez sur Save.

Création d'une session vide

Pour créer une session vide :

1  Sélectionnez Create Blank Session.

2  Pour modifier l'un des paramètres de session, 
cliquez sur le bouton Session Parameters. 

3  Configurez un ou plusieurs des paramètres de 
session suivants, le cas échéant :

• Type de fichier audio

• Bit Depth

• Fréquence d'échantillonnage

• Paramètres d’E/S

4  Cliquez sur OK.

5  Dans la boîte de dialogue d'enregistrement, 
attribuez un nom à la session, choisissez 
l'emplacement où vous voulez l'enregistrer, puis 
cliquez sur Save.

Boîte de dialogue Quick Start, section Session 
Parameters affichée

Boîte de dialogue Quick Start, Create Blank Session
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Ouverture d'une session récente

Pour ouvrir une session récente :

1  Sélectionnez Open Recent Session.

2  Sélectionnez une session parmi les dix 
dernières les plus récentes de la liste (sur la 
droite).

3  Cliquez sur OK.

Ouverture d'une session

Pour ouvrir une session :

1  Sélectionnez Open Session.

2  Dans la boîte de dialogue Choose a Session, 
naviguez jusqu'à l'emplacement du fichier de 
session et sélectionnez-le.

3  Cliquez sur Open.

Affichage ou masquage de la boîte de 
dialogue Quick Start au démarrage

Pour éviter que la boîte de dialogue Quick Start ne 
s'affiche au démarrage de Pro Tools :

Désélectionnez l'option Show Quick Start Dialog 
when Pro Tools Starts dans la boîte de dialogue 
Quick Start ou dans les préférences de 
fonctionnement de Pro Tools (Setup > 
Preferences).

Pour que la boîte de dialogue Quick Start s'affiche 
au démarrage de Pro Tools :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet Operation.

3  Dans la section Miscellaneous de la page des 
préférences de fonctionnement, sélectionnez 
l'option Show Quick Start Dialog when Pro Tools 
Starts.

4  Cliquez sur OK.

L'option Open Recent Session n'est pas 
disponible au premier démarrage de 
Pro Tools (ou si vous avez effacé le contenu 
de la liste des sessions récentes en 
sélectionnant File > Open Recent > Clear).

Boîte de dialogue Quick Start, Open Recent Session

Option Show Quick Start Dialog When Pro Tools Starts
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Nouvelles sessions
Pro Tools 8.0 fournit des améliorations au 
niveau de la boîte de dialogue New Session qui 
vous permet de créer une session vide à partir 
d'un modèle ou de créer une nouvelle session 
entièrement nouvelle (sans piste ni support).

Pour créer une session à partir d'un modèle :

1  Choisissez File > New.

2  Dans la boîte de dialogue New Session, 
sélectionnez Create Session from Template.

3  Dans le menu déroulant Session Template, 
sélectionnez la catégorie pour les modèles de 
session souhaités :

• Guitar

• Music Creation

• Record & Mix

4  Sélectionnez dans la liste le modèle de session 
à utiliser (sur la droite).

5  Configurez un ou plusieurs des paramètres de 
session suivants, le cas échéant :

• Type de fichier audio

• Bit Depth :

• Fréquence d'échantillonnage

6  Cliquez sur OK.

7  Dans la boîte de dialogue d'enregistrement, 
accédez à l'emplacement où vous voulez 
enregistrer la session, puis cliquez sur Save.

Pour créer une session vide :

1  Choisissez File > New.

2  Dans la boîte de dialogue New Session, 
sélectionnez Create Blank Session.

3  Configurez un ou plusieurs des paramètres de 
session suivants, le cas échéant :

• Type de fichier audio

• Bit Depth :

• Fréquence d'échantillonnage

• Paramètres d’E/S

4  Cliquez sur OK.

5  Dans la boîte de dialogue d'enregistrement, 
accédez à l'emplacement où vous voulez 
enregistrer la session, puis cliquez sur Save.

Boîte de dialogue New Session, Create Session from 
Template

Boîte de dialogue New Session, Create Blank Session
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Modèles de session
Outre les modèles de session figurant dans la 
liste des modèles de la boîte de dialogue Quick 
Start de la session Pro Tools, Pro Tools vous 
permet de créer et de partager vous propres 
modèles de session personnalisés. Les fichiers de 
modèle de session Pro Tools portent l'extension 
.ptt pour les différencier des fichiers de session 
Pro Tools ordinaires (.ptf).

Création et enregistrement de modèles 
personnalisés

Pour créer un modèle de session Pro Tools  
personnalisé :

1  Créez une session Pro Tools et configurez-la 
pour le modèle de session de votre choix. 

2  Choisissez File > Save As Template.

3  Configurez les paramètres de la boîte de 
dialogue Save Session Template comme vous le 
souhaitez (voir “Boîte de dialogue Save Session 
Template”, page 12).

4  Sélectionnez l'option Include Media si vous 
voulez inclure un support audio, MIDI ou vidéo 
dans le modèle. 

5  Cliquez sur OK.

Si vous avez sélectionné l'option Install Template 
In System, votre modèle de session sera 
disponible dans la boîte de dialogue Quick Start 
de la session Pro Tools. 

Si vous avez sélectionné l'option Select Location 
For Template, la boîte de dialogue Save As 
Template vous demande d'enregistrer le fichier à 
un autre emplacement de votre système.

Boîte de dialogue Save Session 
Template

La boîte de dialogue Save Template fournit les 
options suivantes :

Install Template In System

Sélectionnez cette option pour enregistrer le 
fichier de modèle dans le dossier système auquel 
la boîte de dialogue Quick Start de la session 
Pro Tools fait référence (modèles Session 
Templates dans le dossier d'application de 
Pro Tools).

Par exemple, si vous composez des 
chansons, vous aurez peut-être simplement 
besoin d'une session composée d'une piste 
d'instrument et d'un plug-in instrumental 
(tel que Xpand! 2 avec présélection de 
piano), une piste audio mono (pour la piste 
vocale), une piste d'entrée auxiliaire (pour le 
bus d'effets) et une piste stéréo de fader 
principal. Vous pouvez ensuite utiliser ce 
modèle à chaque fois que vous composez 
une nouvelle chanson.

Boîte de dialogue Save Session Template

Lorsque l'option Include Media est activée, 
tous les supports de la session sont inclus 
dans le modèle. Si vous voulez inclure le 
support dans votre modèle de session, 
vérifiez que votre session contient 
uniquement le support souhaité.
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Category

Le menu déroulant Category est disponible 
uniquement lorsque l'option Install Template In 
System est activée. Le menu Category vous 
permet de sélectionner le sous-répertoire 
d'enregistrement du fichier de modèle. Il fournit 
aussi des options d'ajout de catégorie et 
d'affichage du dossier Session Templates dans 
l'Explorateur Windows ou le Finder Mac.

Add Category Sélectionnez cette option dans le 
menu déroulant Category pour créer un nouveau 
sous-répertoire dans le dossier Session 
Templates.

Name

Le paramètre Name est disponible uniquement 
lorsque l'option Install Template In System est 
activée. Cela vous permet de saisir un nouveau 
nom pour le fichier de modèle. A partir du menu 
déroulant Name (à droite du champ Name), 
vous pouvez effectuer une sélection dans la liste 
de tous les modèles disponibles de la catégorie 
sélectionnée. Lorsque vous sélectionnez une 
catégorie, son nom s'affiche dans le champ 
Name et vous permet de remplacer ou de créer 
une version incrémentielle du modèle existant.

Select Location For Template

Sélectionnez cette option pour enregistrer le 
fichier de modèle sur un répertoire de votre 
système. Notez que le modèle de session 
enregistré ne s'affiche pas dans la boîte de 
dialogue Quick Start de la session Pro Tools, sauf 
s'il a été placé dans un sous-répertoire (Category) 
dans le dossier Session Templates du dossier 
d'application de Pro Tools.

Include Media

Sélectionnez cette option pour inclure un 
support audio, MIDI ou vidéo à la session avec le 
modèle.

Création de sessions à partir de 
modèles

Vous pouvez créer une session à partir de 
modèles en ouvrant un modèle. Outre par le 
biais de la boîte de dialogue Quick Start de la 
session Pro Tools, vous pouvez aussi 
simplement ouvrir un fichier de modèle de 
session Pro Tools (.ptt) pour commencer une 
nouvelle session basée sur ce modèle.

Pour ouvrir un modèle de session Pro Tools et 
l'enregistrer en tant que nouvelle session :

1  Choisissez File > Open, accédez au fichier 
Session Template recherché, puis ouvrez-le.

2  Dans la boîte de dialogue New Session From, 
sélectionnez les valeurs Audio File Type, Sample 
Rateet Bit Depth de la nouvelle session qui sera 
créée à partir du modèle. 

3  Cliquez sur OK.

Pour plus d'informations sur la création de 
sessions à partir de modèles à l'aide de la 
boîte de dialogue Quick Start, voir 
“Création d'une session à partir d'un 
modèle”, page 8.

Boîte de dialogue New Session From
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4  Dans la boîte de dialogue Save New Session As, 
accédez à l'emplacement où vous voulez 
enregistrer la session, puis cliquez sur Save.

Recherche de mises à jour 
logicielles
Pro Tools permet de rechercher 
automatiquement ou manuellement les mises à 
jour disponibles pour l'application Pro Tools et 
les plug-in Digidesign. Pour cela, une connexion 
Internet est requise. Environ toutes les deux 
semaines, Pro Tools vérifie les mises à jour 
disponibles en ligne pour l'application et les 
plug-in.

Si une mise à jour est disponible pour Pro Tools 
ou un plug-in, Pro Tools indique les mises à jour 
disponibles et l'importance de celles-ci. Pour 
rechercher, télécharger et installer les mises à 
jour appropriées pour votre système Pro Tools, 
visitez le site Web de Digidesign.

Pour rechercher manuellement les mises à jour :

1  Assurez-vous que votre connexion Internet 
fonctionne correctement.

2  Lancez Pro Tools.

3  Sélectionnez Help > Check For Updates. 
Une barre de progression s'affiche.

4  Effectuez l'une des procédures suivantes selon 
le cas :

• Si aucune mise à jour n'est disponible, cliquez 
sur OK.

– ou –

• Si des mises à jour sont disponibles, procédez 
comme suit :

• Cliquez sur Details pour lancer votre 
navigateur Web et afficher les mises à jour 
disponibles.

• Cliquez sur Not Now si vous souhaitez 
vérifier ou télécharger les mises à jour 
ultérieurement.

Pour désactiver la vérification automatique des 
mises à jour :

Dans la boîte de dialogue Software Update, 
activez l'option Do Not Check For Updates 
Automatically.

Pour activer la vérification automatique des mises à 
jour :

1  Vérifiez les mises à jour manuellement (Help > 
Check For Updates). 

2  Dans la boîte de dialogue Software Update, 
désactivez l'option Do Not Check For Updates 
Automatically.

Ouverture de session avec 
des plug-in désactivés
Pro Tools vous permet d'ouvrir des sessions alors 
que tous les plug-in de la session sont inactifs. 
Etant donné que le délai de chargement des 
sessions contenant de nombreux plug-in peut 
être très long, cela vous permet d'ouvrir 
rapidement une session pour un examen visuel 
et une lecture audio immédiats (sans plug-in). 
S'il s'agit de la session sur laquelle vous voulez 
travailler, vous pouvez alors la rouvrir 
facilement en activant les plug-in.
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Pour ouvrir une session Pro Tools avec tous les 
plug-in désactivés :

1  Dans Pro Tools, choisissez File > Open Session.

2  Dans la boîte de dialogue Open Session, 
localisez et sélectionnez la session de votre 
choix.

3  Cliquez sur Open en maintenant la touche Maj 
enfoncée.

Pour rouvrir la même session avec tous les plug-in 
activés, effectuez l'une des opérations suivantes :

Choisissez File > Revert To Saved.

– ou –

Choisissez File > Open Recent et sélectionnez la 
session la plus récente dans le sous-menu.

Cache DSP
Pro Tools HD 8.0 inclut un cache de plug-in et 
de mixage pour les DSP alloués, lors de la 
fermeture et de l'ouverture de session. Cela n'a 
aucun effet sur le temps d'ouverture de la 
première session. Une fois que vous avez ouvert 
Pro Tools une première fois, les ouvertures et les 
fermetures de session Pro Tools suivantes sont 
beaucoup plus rapides, en particulier si vous 
utilisez la commande Revert To Saved ou si vous 
ouvrez des sessions configurées de façon 
similaire.

Dans les versions précédentes de Pro Tools, tous 
les DSP étaient complètement déchargés, ou 
“purgés”, à la fermeture d'une session et il fallait 
les recharger complètement à l'ouverture de la 
session suivante. Désormais, tant que Pro Tools 
s'exécute, les DSP ne seront complètement 
purgés que si vous ouvrez une session avec une 
fréquence d'échantillonnage ou des paramètres 
Playback Engine différents.

Cependant, lorsque vous utilisez un cache DSP, 
il se peut que la fenêtre System Usage n'affiche 
pas les ressources DSP exactes utilisées au cours 
de la session. Pour afficher l'utilisation exacte 
des ressources DSP, vous pouvez soit désactiver 
la mise en mémoire cache DSP, soit purger le 
cache DSP.

Pour activer (ou désactiver) le cache DSP :

1  Ouvrez la fenêtre System Usage (Windows > 
System Usage).

2  Ouvrez le menu contextuel du cache DSP et 
sélectionnez (ou désélectionnez) Use DSP Cache.

Si vous enregistrez la session après l'avoir 
ouverte avec tous les plug-in désactivés, 
vous ne pourrez pas utiliser les commandes 
Revert to Saved ou Open Most Recent pour 
réactiver tous les plug-in de la session.

Pour ouvrir une session récente, utilisez la 
combinaison de touches Ctrl+Maj+O 
(Windows) ou Pomme+Maj+O (Mac).

Fenêtre System Usage, menu contextuel du cache DSP
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Pour purger le cache DSP :

1  Ouvrez la fenêtre System Usage (Windows > 
System Usage).

2  Ouvrez le menu contextuel du cache DSP et 
sélectionnez (ou désélectionnez) Purge Cache. Le 
contenu de la fenêtre System Usage est actualisé.

Gestion des fenêtres 
améliorée

Disposition des fenêtres

Pro Tools fournit des commandes permettant de 
disposer en mosaïque ou en cascade la totalité 
des fenêtres ouvertes. Ces commandes 
n'affectent pas les fenêtres flottantes (telles les 
fenêtres de plug-in, de sortie et de départ), ni les 
fenêtres de transport.

Pour redisposer les fenêtres :

Sélectionnez l'une des options suivantes dans 
le menu Window > Arrange : 

Tile Dispose toutes les fenêtres ouvertes sous 
forme de mosaïque à l'écran.

Tile Horizontal Dispose toutes les fenêtres 
ouvertes sous forme de mosaïque horizontale à 
l'écran. Cette option n'est pas disponible si un 
trop grand nombre de fenêtres est ouvert.

Tile Vertical Dispose toutes les fenêtres ouvertes 
côte à côte sous forme de mosaïque verticale à 
l'écran. Cette option n'est pas disponible si un 
trop grand nombre de fenêtres est ouvert.

Cascade Dispose toutes les fenêtres ouvertes 
sous forme de cascade à l'écran.

Configurations des fenêtres

Déjà présentes dans la version Pro Tools 7.3, les 
configurations de fenêtre fournissent des outils 
puissants pour gérer la configuration des 
fenêtres de vos sessions Pro Tools. Les 
configurations de fenêtres incluent désormais la 
fenêtre de l'éditeur MIDI ciblée et la fenêtre de 
l'éditeur Score dans les options Window Layout 
et Window Display Settings. La fenêtre de 
l'éditeur MIDI ciblée et l'éditeur Score sont 
également visibles lorsque vous filtrez la liste des 
configurations de fenêtres.

Palette de couleurs améliorée
La palette de couleurs permet de sélectionner 
des couleurs pour les pistes, les régions, les 
groupes et les marqueurs. Elle vous permet 
également d'appliquer des couleurs aux voies 
dans les fenêtres Mix et Edit, et de régler la 
saturation et la luminosité des couleurs des 
voies.

Pour plus d'informations sur les fenêtres de 
l'éditeur MIDI, voir chapitre 6, “Fenêtres de 
l'éditeur MIDI”. Pour plus d'informations 
sur la fenêtre de l'éditeur Score, voir 
chapitre 7, “Fenêtre de l'éditeur Score”.

Fenêtre de la palette de couleurs

Option Apply to Selected

Bouton Hold

Par défaut
AucuneOption Apply to Channel Strip

Saturation

Dernière couleur affectée

Brightness
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Nouvelles commandes de la palette de 
couleurs

Apply To Channel Strip Lorsque l'option Apply To 
Channel Strip est activée, vous pouvez régler le 
curseur Saturation pour modifier la saturation 
des couleurs de toutes les voies. 

Saturation Lorsque l'option Apply To Channel 
Strip est activée, vous pouvez régler le curseur 
Saturation pour modifier la saturation de la 
couleur des voies. 

Brightness Cette commande vous permet de 
régler la luminosité des voies.

Paramètre inférieur de taille 
du buffer matériel
Dans la boîte de dialogue Playback Engine, 
Pro Tools HD permet désormais de régler les 
paramètres H/W Buffer Size jusqu'à 64 
échantillons, afin d'offrir la latence d'écoute la 
plus basse possible. Le paramètre de taille de 
buffer 64 échantillons n'est cependant 
disponible que lorsque le paramètre Number of 
Voices est défini sur 48 Voices (1 DSP) ou 96 voices 
(2 DSP). Le paramètre H/W Buffer Size le plus bas 
disponible sera 64, 128 ou 256 Samples, en 
fonction du paramètre Number of Voices.

Augmentation de la taille 
limite des fichiers
Pro Tools 8.0 prend en charge des tailles de 
fichier allant jusqu'à 3,4 Go (la taille de fichier 
limite était 2 Go auparavant). Cela vous permet 
d'effectuer des enregistrements plus longs dans 
un seul fichier.

Augmentation de la résolution 
de forme d'onde
Pro Tools 8.0 permet le calcul des aperçus de 
forme d'onde 16 bits (8 bits dans les versions 
précédentes). Cela permet une meilleure 
résolution verticale de la forme d'onde lorsque 
vous effectuez un zoom avant dessus pour la 
modifier. Cela est particulièrement flagrant 
pour les enregistrements de signaux de faible 
niveau.

Lorsque vous ouvrez une session Pro Tools 
8.0 qui référence des fichiers supérieurs à 2 
Go dans une version précédente de 
Pro Tools sur Mac, les régions qui font 
référence à ces fichiers apparaissent hors 
ligne. Si vous prévoyez de transférer votre 
session Pro Tools 8.0 vers une version 
précédente de Pro Tools, pensez à bien 
modifier les régions qui font référence à des 
fichiers supérieurs à 2 Go et regroupez-les 
afin que la session ne référence plus que des 
fichiers inférieurs à 2 Go. Vous pourrez 
ensuite ouvrir la session dans une version 
précédente de Pro Tools avec toutes les 
régions en ligne.
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Décalages des signaux 
d'horloge MIDI Beat Clock
Pro Tools peut transmettre le signal d'horloge 
MIDI pour synchroniser les périphériques MIDI 
recevant les signaux MIDI Beat Clock (telles les 
boîtes à rythme) avec le tempo de la session 
Pro Tools. Certains plug-in d'instrument 
prennent également en charge le signal 
d'horloge MIDI Beat Clock pour la 
synchronisation sur le tempo Pro Tools.

Pro Tools 8.0 vous permet désormais de définir 
un décalage pour le signal MIDI Beat Clock port 
par port entre votre interface MIDI et vos 
périphériques MIDI externes. Cela vous permet 
d'ajuster la synchronisation pour chaque 
périphérique, lorsque certains périphériques 
jouent en retard en raison de latences fixes 
différentes. Lorsque cela est approprié, saisissez 
des valeurs de décalage négatives dans les 
échantillons pour chaque port afin de 
synchroniser correctement les signaux audio de 
vos périphériques MIDI avec la lecture 
Pro Tools. 

Transmission de l'horloge MIDI Beat 
Clock

Pour transmettre l'horloge MIDI Beat Clock :

1  Sélectionnez Setup > MIDI > MIDI Beat Clock.

2  Dans la zone de dialogue MIDI Beat Clock, 
sélectionnez l'option Enable MIDI Beat Clock.

3  Sélectionnez les périphériques chargés de la 
réception de l'horloge MIDI Beat Clock. Si votre 
interface MIDI ne prend pas en charge la 
transmission de MIDI Beat Clock vers des ports 
séparés, seule l'interface apparaît en tant que 
destination.

4  Saisissez les valeurs correctes de décalage 
négatif (par exemple, échantillons –200) pour 
chaque port activé pour la transmission MIDI 
Beat Clock (voir “Mesure de la latence de 
l'horloge MIDI”, page 19).

5  Cliquez sur OK.

Boîte de dialogue MIDI Beat Clock
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Mesure de la latence de l'horloge MIDI

Pour déterminer le décalage d'horloge MIDI 
approprié sur un périphérique externe :

1  Vérifiez que votre ordinateur et le 
périphérique MIDI externe sont correctement 
connectés et configurés pour le MIDI et que la 
sortie audio est correctement connectée aux 
entrées audio de votre interface audio Pro Tools.

2  Vérifiez que votre périphérique MIDI externe 
est configuré pour recevoir le signal d'horloge 
MIDI Beat Clock, et que sa configuration lui 
permet de jouer un modèle rythmique simple 
sur le tempo.

3  Créez une session Pro Tools.

4  Dans la boîte de dialogue MIDI Beat Clock, 
vérifiez que l'option MIDI Beat Clock est activée et 
que le périphérique est sélectionné.

5  Définissez le format Bars|Beats pour l'échelle 
temporelle principale.

6  Créez une piste audio et sélectionnez les 
canaux d'entrée audio pour votre périphérique 
MIDI externe.

7  Préparez la piste audio à l'enregistrement et 
lancez l'enregistrement. Le signal d'horloge 
MIDI Beat Clock est envoyé au périphérique 
MIDI externe, qui commence la lecture du 
modèle.

8  Arrêtez l'enregistrement après quelques 
mesures.

9  Activez les modes Grid et Show Grid.

10  Avec le sélecteur, placez le curseur d'édition 
sur la grille de mesures avant un transitoire 
prononcé dans la forme d'onde sur le tempo. 

11  Activez la tabulation vers les transitoires et 
appuyez sur la touche Tab tout en maintenant la 
touche Maj enfoncée pour passer au transitoire.

12  Définissez l'échelle temporelle principale sur 
Samples. La longueur de la sélection d'édition 
(en échantillons) correspond 
approximativement à la latence MIDI Beat 
Clock de ce périphérique. Pour plus 
d'informations, reportez-vous à la section 
figure 2, page 20.

13  Dans la boîte de dialogue MIDI Beat Clock, 
saisissez la valeur Sample Offset sous forme de 
nombre négatif.

Etant donné que le format MIDI ne permet 
pas une précision à l'échantillon près, vous 
voudrez peut-être effectuer plusieurs 
mesures à différents emplacements de la 
grille et en calculer la moyenne, afin 
d'obtenir la meilleure valeur de décalage 
MIDI Beat Clock.

Décalage d'échantillon MIDI Beat Clock

Une fois que vous avez mesuré la latence de 
vos périphériques activés pour l'horloge 
MIDI, pensez à noter ces valeurs au cas où 
vous auriez besoin d'indiquer de nouveau la 
valeur MIDI Beat Clock Sample Offset dans 
d'autres sessions.
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Figure 2.  Mesure du décalage de l'horloge MIDI dans les échantillons

Décalage 
approximatif de 
l'échantillon
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chapitre 3

Modification des préférences de Pro Tools

Préférences d'affichage

Section Basics

Les préférences suivantes ont été supprimées.

• Recompute Invalid Overviews (Pro Tools 
recalcule toujours les aperçus de forme 
d'onde incorrects ou manquants)

• Draw Grids in Edit Window (cette option est 
désormais disponible avec le sélecteur Grid 
Value de la fenêtre Edit)

• Draw Waveforms Rectified (cette option a été 
déplacée dans View > Waveforms > Rectified)

Section Color Coding

La préférence suivante est une nouveauté :

MIDI Note Color Shows Velocity : Lorsque cette 
option est activée, les notes MIDI s'affichent 
dans la fenêtre Edit et dans les fenêtres de 
l'éditeur MIDI dans différentes nuances de la 
couleur de piste définie dans la vue des notes 
MIDI. Les notes à vélocité élevée sont plus 
sombres et les notes à vélocité faible sont plus 
claires.

Préférences de 
fonctionnement
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Section Transport

La préférence suivante est une nouveauté :

Latch Forward/Rewind : lorsque cette option est 
sélectionnée, l'avance rapide ou le retour arrière 
se verrouillent jusqu'à ce que vous commenciez 
ou arrêtiez la lecture. Lorsque cette option est 
désactivée, l'avance rapide ou le retour arrière 
s'arrêtent lorsque vous lâchez le bouton de la 
souris, après avoir cliqué sur l'un des deux 
boutons dans la fenêtre Transport (ou lorsque 
vous cessez d'appuyer sur le bouton sur la 
surface de contrôle).

Section Record

La préférence suivante est une nouveauté :

Automatically Create New Playlists When Loop 
Recording : avec cette option, les autres prises 
enregistrées en boucle sont copiées vers des 
nouvelles playlists sur la piste. Ceci est 
particulièrement utile pour préparer des pistes 
composites dans la vue des playlists après 
l'enregistrement en boucle de plusieurs prises.

Section Misc (Miscellaneous)

La préférence suivante est une nouveauté :

Show Quick Start Dialog When Pro Tools Starts : 

lorsque cette option est sélectionnée, Pro Tools 
affiche la boîte de dialogue Session Quick Start 
au lancement. 

Préférences d'édition

Liste des prises “Matching Start Time”

La liste des prises Matching Start Time suivantes 
ont été supprimées et sont désormais accessibles 
via la boîte de dialogue Matching Criteria :

• “Includes Take Region Names That Match 
Track Names”

• “Includes Take Regions Lengths That 
Match”

Pour plus d'informations sur les options de 
critères de recherche, reportez-vous à 
“Critères d'équivalence”, page 57.
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Préférences MIDI

Les préférences MIDI suivantes ont été 
supprimées et sont désormais disponibles dans 
la fenêtre Edit et les fenêtres de l'éditeur MIDI et 
de l'éditeur Score :

• “Default Note On Velocity”

• “Play MIDI Notes When Editing”

Section Basics

Les préférences suivantes sont des nouveautés :

Remove Range Selection After Opening the 
MIDI/Score Editor : lorsqu'elle est sélectionnée, 
la sélection d'édition actuelle est réduite sous 
forme d'un point d'insertion lorsque vous 
ouvrez une fenêtre de l'éditeur MIDI ou une 
fenêtre de l'éditeur Score.

“Double-clicking a Region Opens…”

Cette option permet de spécifier l'action à 
effectuer lorsque vous cliquez deux fois dans 
une région MIDI à l'aide de la main sur les pistes 
MIDI et les pistes d'instrument de la fenêtre Edit. 

Editeur MIDI : ouvre la région MIDI dans une 
fenêtre de l'éditeur MIDI.

Score Editor : ouvre la région MIDI dans une 
fenêtre de l'éditeur Score.

MIDI Event List : ouvre la région MIDI dans la 
liste des événements MIDI.

Name Dialog : ouvre la boîte de dialogue Name 
pour la région MIDI.

Affichage de l'éditeur MIDI/Score

La préférence suivante est une nouveauté :

Additional Empty Bars in the Score Editor : 
vous permet de spécifier le nombre par défaut de 
mesures vides qui apparaissent dans la fenêtre 
de l'éditeur Score à la suite de la dernière région 
MIDI de la session.

Préférences de 
synchronisation
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Section Synchronization

La préférence suivante a été supprimée :

Stable LTC Source La sélection de cette option 
supprime le délai d'attente d'une seconde avant 
la tentative de synchronisation de Pro Tools sur 
un timecode LTC entrant.

Les préférences suivantes sont des nouveautés :

Delay Before Locking to Longitudinal Time Code 

Définit le délai (en images) avant la tentative de 
synchronisation de Pro Tools sur un timecode 
LTC entrant. Activez cette option lorsque la 
synchronisation de Pro Tools s'effectue sur une 
source de timecode stable (par exemple, un 
magnétophone à bande non linéaire ou un 
générateur LTC) et non sur un magnétophone à 
bande linéaire.

Delay Before Locking to Serial Time Code (Pro Tools 
HD uniquement) : définit le délai d'attente (en 
images) de Pro Tools avant les tentatives de 
verrouillage sur les machines envoyant des 
messages de verrouillage servo. Ce paramètre 
permet aux mécanismes de servo d'atteindre un 
niveau de verrouillage stable.

Section Satellite Link

Les préférences suivantes sont des nouveautés :

Transmit Solos : grâce à cette option, le statut 
solo des pistes d'un système Pro Tools relié est 
transmis à tous les autres systèmes Pro Tools 
reliés. Sur les autres systèmes reliés configurés 
pour recevoir le statut solo, les pistes suivent le 
comportement de lecture en solo comme si les 
solos se trouvaient sur le système local. 
Cependant, si l'option Solo Independent of Linked 
State est activée, la fonction Transmit Solos 
s'applique aux systèmes connectés 
indépendamment de s'ils sont liés ou non.

Receive Solos : un système Pro Tools relié reçoit 
les solos de tous les autres systèmes Pro Tools 
reliés, qui sont paramétrés pour transmettre le 
statut solo à leurs pistes. Les pistes du système de 
destination suivent le comportement de lecture 
en solo, comme si les solos se trouvaient sur le 
système local. Cependant, si l'option Solo 
Independent of Linked State est activée, la 
fonction Receive Solos s'applique aux systèmes 
connectés indépendamment de s'ils sont liés ou 
non.

Solo Independent of Linked State : le système 
Pro Tools envoie le statut solo de ses pistes aux 
autres systèmes satellites connectés, même si 
ceux-ci ne sont pas reliés. Cette fonction permet 
le contrôle du statut solo entre les systèmes 
même si la commande de transport n'est pas 
activée. 

DAE Errors Stop All Linked Systems : si une erreur 
DAE se produit sur un système Pro Tools relié, le 
transport est arrêté sur tous les systèmes reliés. 
Lorsque cette option n'est pas sélectionnée, les 
systèmes reliés ne s'arrêtent pas lorsqu'une 
erreur DAE se produit sur l'un des systèmes. 

Transmit Play Selections : grâce à cette option, la 
sélection de la fenêtre Edit d'un système 
Pro Tools relié est envoyée à tous les autres 
systèmes Pro Tools reliés. Sur les autres systèmes 
reliés paramétrés pour recevoir des sélections de 
lecture, la sélection est reflétée dans la fenêtre 
Edit.

Receive Play Selections : un système Pro Tools 
relié reçoit les sélections de la fenêtre Edit de 
tous les autres systèmes Pro Tools reliés, qui sont 
paramétrés pour transmettre les sélections de 
lecture.
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chapitre 4

Améliorations et nouveautés d'édition

Vue Universe
Dans Pro Tools 8.0, la fenêtre Universe a été 
remplacée par la vue Universe dans la partie 
supérieure de la fenêtre Edit. La vue Universe 
facilite et accélère la navigation dans votre 
session Pro Tools.

La vue Universe affiche une vue d'ensemble de 
l'intégralité de la session (voir figure 1, page 25). 
Cette vue représente les données audio et MIDI 
sur toutes les pistes qui ne sont pas masquées (y 
compris les pistes inactives, ou qui contiennent 
des régions hors ligne). L'ordre d'affichage des 
éléments dans la vue Universe correspond à 
l'ordre de la piste dans la fenêtre Edit.

Figure 1.  Vue Universe en haut de la fenêtre Edit

Vue Universe
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Dans la vue Universe, les régions audio, MIDI et 
vidéo sur les pistes sont représentées par des 
lignes horizontales de la même couleur que les 
régions sur les pistes. Chaque piste audio est 
représentée à la même hauteur, quel que soit le 
nombre de canaux. De plus, les pistes affichant 
des lignes d'automation, de contrôleur ou de 
playlist sont représentées avec une hauteur 
croissante pour chaque ligne affichée.

Les pistes d'entrée auxiliaire, les pistes de fader 
principal et les pistes de VCA principal ne 
contenant pas de régions audio ou MIDI, elles 
s'affichent sous forme de zone vides dans la vue 
Universe.

Pour afficher (ou masquer) la vue Universe dans la 
fenêtre Edit, effectuez une des opérations 
suivantes :

Sélectionnez ou désélectionnez View > Other 
Displays > Universe.

Cliquez deux fois sur la barre de séparation 
située au-dessus de la règle temporelle 
principale. 

Dans le menu contextuel de la fenêtre Edit, 
sélectionnez ou désélectionnez Universe.

Clqiuez sur le bouton d'affichage/de 
masquage de la vue Universe.

Zone encadrée dans la vue Universe

La zone encadrée dans la vue Universe 
représente ce qui est visible dans le panneau des 
pistes de la fenêtre Edit. Si vous modifiez ce qui 
apparaît dans la fenêtre Edit (par un zoom, un 
défilement horizontal ou vertical, en 
masquant/affichant des pistes ou en changeant 
leur hauteur), la zone encadrée de la vue 
Universe est repositionnée et redimensionnée 
en conséquence. Pendant la lecture, si vous 
faites défiler la fenêtre Edit, la zone encadrée de 
la vue Universe défile également.

Si toutes les pistes sont visibles dans la fenêtre 
Edit et que la session est en zoom arrière 
complet avec toutes les régions visibles, c'est 
toute la fenêtre Univers qui est encadrée.

Sélection de la vue Universe à partir du menu 
contextuel de la fenêtre Edit

Bouton d'affichage de masquage de la vue Universe

La zone encadrée représente la partie de la session qui 
est affichée dans le panneau des pistes de la 
fenêtre Edit.

Cadre du panneau des pistes dans la fenêtre Edit



Chapitre 4 : Améliorations et nouveautés d'édition 27

Navigation dans la vue Universe

En cliquant dans la vue Universe, vous pouvez 
faire défiler horizontalement et/ou 
verticalement les données affichées dans la 
fenêtre Edit. Cela est une méthode pratique 
pour déplacer la sélection sur la session dans la 
fenêtre Edit.

Pour naviguer dans la session par le biais de la vue 
Universe :

1  Assurez-vous que la vue Universe est affichée 
(View > Other Displays > Universe).

2  Cliquez dans la vue Universe pour déplacer la 
zone encadrée. La fenêtre Edit se met à jour en 
conséquence.

Changement de taille de la vue 
Universe

Vous pouvez redimensionner la vue Universe 
pour l'ajuster au nombre total de pistes de la 
session, ou agrandir la fenêtre Edit.

Pour redimensionner en hauteur la vue Universe :

1  Cliquez dans la zone située entre la partie 
inférieure de la fenêtre Universe et la partie 
supérieure des règles temporelles. Le curseur 
change de forme pour signaler que la vue 
Universe peut être redimensionnée.

2  Faites glisser le curseur vers le haut pour 
diminuer la hauteur de la vue Universe, ou faites 
glisseur le curseur vers le bas pour l'augmenter.

Défilement de la vue Universe

Si la session contient plus d'une seule piste 
visible dans la vue Universe, vous pouvez faire 
défiler les pistes vers le haut ou vers le bas.

Pour faire défiler la vue Universe vers le haut ou 
le bas :

Cliquez sur les touches de défilement vers le 
haut ou le bas situées à droite de la vue Universe.

Changement de taille de la vue Universe

Défilement de la vue Universe

Flèches de 
défilement 
vers le haut 
ou vers le bas
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Video Universe

La fenêtre Video Universe est désormais 
directement accessible à partir du menu 
Window de Pro Tools. Elle vous permet de 
visualiser des régions vidéos, de les sélectionner 
sur la piste vidéo principale, de naviguer et de 
zoomer. La fenêtre Video Universe affiche 
l'image vidéo centrale de chaque région vidéo 
dans la piste vidéo principale. Les images vidéo 
sont classées de façon séquentielle en fonction 
de l'ordre dans la timeline. La bande de couleur 
sous chaque image représente le code couleur de 
la région.

Pour afficher la fenêtre Video Universe :

1  Assurez-vous que le bouton Video Online de la 
piste vidéo principale est en ligne (bleu).

2  Cliquez sur Window > Video Universe.

Nouvelles vues Waveform
Pro Tools 8.0 fournit plusieurs options 
d'affichage Waveform. Comme dans les versions 
précédentes, vous pouvez afficher les formes 
d'ondes normalement en vue Peak (en tant que 
formes positives et négatives de part et d'autre 
de la ligne de passage à zéro) ou en vue rectifiée. 
Le calcul des vues Power est disponible, que 
l'affichage des formes d'onde soit normal ou 
rectifié. En outre, vous pouvez choisir d'afficher 
les formes d'onde avec ou sans contours.

Pour définir la vue Waveform :

1  Sélectionnez View > Waveforms, puis choisissez 
Peak ou Power.

2  Sélectionnez View > Waveforms, puis 
sélectionnez ou désélectionnez Rectified.

3  Sélectionnez View > Waveforms, puis 
sélectionnez ou désélectionnez Outlines.

Peak lorsque cette option est sélectionnée, la 
forme d'onde est calculée en fonction du niveau 
de crête échantillon par échantillon. La vue Peak 
est la méthode de calcul standard de l'aperçu de 
la forme d'onde dans Pro Tools. Cette vue peut 
être utilisée pour les vues normales ou rectifiées. 
La vue Peak affiche clairement les écrêtages dans 
la forme d'onde.

Power lorsque cette option est sélectionnée, la 
forme d'onde est calculée en fonction de la 
moyenne quadratique. La vue Power peut être 
utilisée pour les vues normales ou rectifiées. 
La vue Power permet de mieux visualiser les 
caractéristiques des données audio dans la forme 
d'onde, lorsque vous effectuez un zoom arrière 
et passez à un niveau d'affichage supérieur à 
celui de l'échantillon. Pour les applications de 
mastering en particulier, cette vue permet de 
mieux rendre compte des caractéristiques 
acoustiques des données Audio que la vue Peak.

En cas de zoom à l'échelle de l'échantillon, 
Pro Tools affiche toujours la vue Peak.

Vue Waveform normale de type Peak avec contours

Vue de forme d'onde Power normale avec contours
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Rectified Lorsque vous sélectionnez cette 
option, les formes d'ondes audio apparaissent de 
telle sorte que leurs excursions positive et 
négative (c'est-à-dire les parties situées au-dessus 
et en dessous de la ligne centrale) sont 
additionnées et présentées sous forme d'un 
signal positif unique. Cette vue vous permet 
d'afficher une forme d'onde plus détaillée pour 
les vues à hauteur de piste normale ou réduite. 
Elle sert notamment à modifier les données 
d'automation de volume, puisqu'elle représente 
le niveau des formes d'ondes à partir du bas de la 
piste. L'option Rectified Waveform peut être 
activée dans les vues Peak ou Power.

Outlines Lorsque cette option est sélectionnée, 
les formes d'onde audio s'affichent avec des 
contours. Les formes d'onde avec contours 
offrent une définition plus visuelle, en 
particulier si celles-ci sont visualisées à une 
certaine distance. Vous pouvez désactiver les 
contours lorsque vous devez effectuer une 
modification précise et détaillée dans la vue de 
forme d'onde Peak. Les contours ne sont pas 
affichés lorsque vous effectuez un zoom à 
l'échelle de l'échantillon.

Lors d'un enregistrement, c'est toujours la 
vue Peak qui est affichée. La vue Waveform 
de type Power est calculée et affichée 
uniquement après l'arrêt de 
l'enregistrement.

Le vue Power n'est pas disponible en mode 
Destructive Punch ou en cas de zoom à 
l'échelle de l'échantillon.

Vue Waveform rectifiée de type Peak avec contours

Vue Waveform rectifiée de type Power avec contours

Vue Waveform normale de type Peak sans contours

Vue Waveform normale de type Power sans contours

Vue Waveform rectifiée de type Peak sans contours

Vue Waveform rectifiée de type Power sans contours
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Vue de l'éditeur MIDI
Pro Tools 8.0 propose des fenêtres d'éditeur 
MIDI permettant une édition MIDI 
approfondie. Les fenêtres de l'éditeur MIDI 
permettent d'afficher les données MIDI et les 
données d'automation pour les pistes d'entrée 
auxiliaire, d'instrument et MIDI. Vous pouvez 
ouvrir simultanément autant de fenêtres de 
l'éditeur MIDI que vous le souhaitez. Chacune 
d'entre elles fournit une représentation unique 
des données MIDI dans votre session Pro Tools. 
A l'instar des fenêtres Plug-in, Output et Send, il 
est possible de “cibler” une fenêtre de l'éditeur 
MIDI.

Editeur MIDI dans la fenêtre Edit

Vous pouvez choisir d'afficher (ou de masquer) 
un volet de l'éditeur MIDI en bas de la fenêtre 
Edit (au-dessous du volet Tracks). 

Pour afficher (ou masquer) la vue MIDI Editor dans 
la fenêtre Edit, effectuez l'une des opérations 
suivantes :

Sélectionnez (ou désélectionnez) View > Other 
Displays > MIDI Editor.

Cliquez sur l'icône permettant 
d'afficher/masquer l'éditeur MIDI qui se trouve 
dans l'angle inférieur gauche du volet Tracks, 
dans la fenêtre Edit.

Cliquez deux fois sur le séparateur situé sous le 
volet Tracks de la fenêtre Edit.

Dans le menu Edit Window, sélectionnez (ou 
désélectionnez) MIDI Editor.

Pour des informations détaillées sur les 
fenêtres de l'éditeur MIDI, voir chapitre 6, 
“Fenêtres de l'éditeur MIDI”.

Figure 2.  Vue MIDI Editor en bas de la fenêtre Edit
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Barres d'outils 
personnalisables
Dans Pro Tools 8.0, vous pouvez personnaliser 
les barres d'outils de la fenêtre Edit, ou des 
fenêtres de l'éditeur MIDI ou Score en 
redisposant les fenêtres et commandes 
disponibles, et en les rendant visibles ou 
invisibles.

Affichage et masquage des commandes de la 
fenêtre Edit

Pour afficher ou masquer les commandes dans la 
fenêtre Edit :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le menu Toolbar de la fenêtre 
Edit (dans l'angle supérieur droit de la 
fenêtre).

• Cliquez avec le bouton droit de la souris 
dans la barre d'outils.

2  Dans le menu, sélectionnez ou désélectionnez 
une ou plusieurs options parmi les suivantes, 
selon la fenêtre que vous configurez :

Commandes de zoom Lorsque cette option est 
sélectionnée, les commandes de zoom 
s'affichent dans la barre d'outils de la 
fenêtre Edit.

Transport Lorsque cette option est sélectionnée, 
les commandes de transport s'affichent dans la 
barre d'outils de la fenêtre Edit.

Commandes MIDI Lorsque cette option est 
sélectionnée, les commandes MIDI s'affichent 
dans la barre d'outils de la fenêtre Edit.

Synchronisation Lorsque cette option est 
sélectionnée, les commandes de 
synchronisation s'affichent dans la barre d'outils 
de la fenêtre Edit.

Minimal Lorsque cette option est sélectionnée, 
l'affichage des commandes de zoom, de 
transport, MIDI et de synchronisation est 
désactivé dans la barre d'outils de la fenêtre Edit.

All Lorsque cette option est sélectionnée, 
l'affichage des commandes de zoom, de 
transport, MIDI et de synchronisation est activé 
dans la barre d'outils de la fenêtre Edit.

Menu Toolbar de la fenêtre Edit
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Expanded Transport Lorsque cette option est 
sélectionnée, les commandes de transport 
étendu s'affichent dans la barre d'outils de la 
fenêtre Edit, si vous avez également sélectionné 
l'option Transport.

Liste des pistes Lorsque cette option est 
sélectionnée, la liste des pistes s'affiche sur la 
gauche de la fenêtre Edit.

Region List Lorsque cette option est 
sélectionnée, la liste des régions s'affiche sur la 
gauche de la fenêtre Edit.

Universe Lorsque cette option est sélectionnée, 
la vue Universe s'affiche à proximité du haut de 
la fenêtre Edit.

Editeur MIDI Lorsque cette option est 
sélectionnée, la vue MIDI Editor s'affiche en bas 
de la fenêtre Edit.

Redisposition des commandes et des 
affichages

Pour redisposer les commandes et affichages dans 
la barre d'outils de la fenêtre Edit, ou des fenêtres 
de l'éditeur MIDI ou Score :

Cliquez en maintenant enfoncée la touche 
Ctrl (Windows) ou Pomme (Mac) sur les 
commandes ou affichages à déplacer, puis 
faites-les glisser à l'emplacement de votre choix 
sur la barre d'outils.

Par exemple, si vous voulez disposer les 
indicateurs des compteurs et de la sélection 
d'édition à droite des commandes de transport 
sur la barre d'outils, cliquez dessus tout en 
maintenant enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac), et déplacez-les sur la droite 
des commandes de transport.

Nouvelle apparence de l'outil 
Smart
Le bouton de l'outil Smart a une nouvelle 
apparence dans Pro Tools 8.0 et il se trouve à un 
nouvel emplacement. Il est désormais 
également associé au groupe des outils de 
trimming, du sélecteur et de la main.

Déplacement des indicateurs des compteurs et de la 
sélection d'édition

Bouton de l'outil Smart
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Focus clavier sur les 
commandes
Le bouton de focus clavier sur les commandes de 
la fenêtre Edit se trouve désormais dans l'angle 
supérieur droit du volet des pistes de la fenêtre 
Edit. Le focus clavier sur les commandes est 
également accessible à partir des fenêtres de 
l'éditeur MIDI. Le focus clavier sur les 
commandes ne peut être activé que sur une 
seule fenêtre à la fois.

Chords
La règle Chords vous permet d'ajouter des 
symboles d'accord aux sessions Pro Tools dans la 
fenêtre Edit et dans les fenêtres de l'éditeur MIDI 
et de l'éditeur Score. Les symboles d'accords de 
Pro Tools sont simplement des marqueurs 
affichant les symboles et les diagrammes 
d'accords (tablatures). Les symboles d'accord 
n'ont aucun effet sur les données MIDI.

Règle d'accords

Dans la fenêtre Edit et dans les fenêtres de 
l'éditeur MIDI, la règle d'accords vous permet 
d'ajouter, de modifier, de déplacer et de 
supprimer des symboles d'accord. Les symboles 
d'accord permettent d'indiquer les changements 
de tonalité utilisés dans une session Pro Tools. 

Pour afficher la règle d'accords, effectuez l'une des 
opérations suivantes :

Sélectionnez View > Rulers > Chords.

– ou –

A partir du sélecteur de la vue des règles de la 
fenêtre Edit ou d'une fenêtre de l'éditeur MIDI, 
sélectionnez Chords.

Pour ajouter un symbole d'accord :

1  Positionnez le curseur à l'emplacement de la 
timeline où vous souhaitez ajouter un symbole 
d'accord.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton plus (+) de la règle 
Chords.

– ou –

• Tout en appuyant sur Ctrl (Mac) ou sur la 
touche de démarrage (Windows), déplacez 
le curseur dans la règle d'accord (le curseur 
devient une main associée au signe plus (+) 
et cliquez à l'emplacement où vous 
souhaitez placer le symbole d'accord.

Fenêtre Edit avec focus clavier sur les commandes 
activé

Pour plus d'informations sur les symboles 
d'accord dans l'éditeur Score, voir 
“Diagrammes et symboles d'accords”, 
page 113.

Focus clavier sur 
les commandes activé

Règle de symboles d'accord

Règle d'accords
Ajouter un symbole d'accord

Marqueurs de symbole d'accord
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3  Dans la boîte de dialogue Chord Change, 
indiquez un nom pour la racine de l'accord et 
sélectionnez la qualité, la basse et le diagramme 
de l'accord choisi (les diagrammes d'accord sont 
affichés uniquement dans l'éditeur Score).

4  Cliquez sur OK.

Pour modifier un symbole d'accord :

1  Cliquez deux fois sur le marqueur de signature 
d'accord dans la règle Chord Symbol.

2  Dans la boîte de dialogue Chord Change, 
effectuez les modifications souhaitées.

3  Cliquez sur OK.

Pour déplacer un symbole d'accord :

Cliquez sur le marqueur du symbole d'accord 
et faites-le glisser vers un nouvel emplacement.

Pour supprimer un symbole d'accord, effectuez 
l'une des opérations suivantes :

Cliquez sur le marqueur de symbole d'accord 
en maintenant enfoncée la touche Option (Mac) 
ou Alt (Windows) dans la règle Chords.

– ou –

Dans la règle Chords, sélectionnez les 
symboles d'accord à supprimer, puis cliquez sur 
Edit > Clear ou appuyez sur la touche Suppr.

Boîte de dialogue Chord Change

La boîte de dialogue Chord Change vous permet 
de définir le symbole d'accord et le diagramme 
d'accord (tablature) à placer dans la règle Chords 
et sur le score dans l'éditeur Score. La boîte de 
dialogue Chord Change s'affiche chaque fois 
que vous ajoutez ou modifiez un marqueur 
d'accord.

Chord Sélectionnez un nom pour la racine de 
l'accord (ré par exemple).

Qualité de l'accord Sélectionnez la qualité de 
l'accord à partir du sélecteur (majeur ou 
mineur).

Bass Sélectionnez la basse de l'accord (par 
exemple, un si bémol pour un sol dièse dans la 
première inversion).

Boîte de dialogue Chord Change

Sélecteur 
Sélecteur de qualité 

Sélecteur de 

Diagrammes d'accord

la note bassed'accord
de l'accord
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Diagramme d'accord Sélectionnez le diagramme 
d'accord pour la tablature. Les diagrammes 
d'accord ne s'affichent que dans l'éditeur Score.

Indicateurs de la fenêtre Edit
L'apparence des indicateurs d'état en ligne des 
données de la timeline, d'état en ligne des 
données de session et de compensation 
automatique des retards a changé.

Indicateur d'état en ligne des données de la 
timeline

L'indicateur de l’état en ligne des données de la 
timeline est vert quand tous les fichiers utilisés 
dans les playlists des pistes sont disponibles 
pour la lecture. Si les fichiers sont hors ligne, en 
cours de traitement ou non disponibles pour la 
lecture, l'indicateur est rouge.

Indicateur d'état en ligne des données de la 
session

L'indicateur d’état en ligne des données de la 
session est vert quand tous les fichiers audio et 
fichiers de fondu référencés par la session en 
cours sont disponibles pour la lecture. Si les 
fichiers sont hors ligne, en cours de traitement 
ou non disponibles pour la lecture, l'indicateur 
est rouge.

Indicateur d'état de la compensation de retard

(Pro Tools HD uniquement)

Cet indicateur s'affiche lorque la fonction Delay 
Compensation est activée (Options > Delay 
Compensation). Lorsque la fonction Delay 
Compensation est désactivée, cet indicateur n'est 
pas visible.

Nouvelle option de la fenêtre 
Edit
L'option suivante de la fenêtre Edit est nouvelle 
dans Pro Tools 8.0.

Bouton Timeline Insertion/Play Start Marker 
Follows Playback

Pour afficher ou masquer les symboles et les 
diagrammes d'accord dans l'éditeur Score, 
sélectionnez ou désélectionnez l'option 
correspondante dans la boîte de dialogue 
Score Setup.

Indicateurs de la fenêtre Edit

Compensation de retard automatique

Etat en ligne des données

Etat en ligne des données
de la timeline

 de la session

Boutons de la fenêtre Edit

Timeline Insertion/Play Start 
Marker Follows Playback 
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Pro Tools 8.0 fournit un nouveau bouton 
intitulé Timeline Insertion/Play Start Marker 
Follows Playback dans la fenêtre Edit. Celui-ci 
vous permet d'activer ou de désactiver l'option 
Timeline Insertion/Play Start Marker Follows 
Playback et de voir en un clin d'œil si l'option est 
activée ou non. Dans la version précédente, 
cette option était uniquement disponible dans 
les préférences de fonctionnement.

Commandes d'édition MIDI de 
la fenêtre Edit 
Pro Tools propose quelques options permettant 
de déterminer le fonctionnement de l'édition 
MIDI. Ces options sont disponibles dans la 
fenêtre Edit, les fenêtre de l'éditeur MIDI et la 
fenêtre de l'éditeur Score. Toutefois, ces options 
sont uniquement disponibles si au moins une 
piste MIDI ou d'instrument est présente dans 
votre session Pro Tools.

Play MIDI Notes When Editing

Lorsque l'option Play MIDI Notes When Editing 
est activée, elle déclenche un son lorsque vous 
éditez des notes MIDI. 

Default Note Duration

Le sélecteur Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement. La fenêtre Edit, ainsi que les 
fenêtres de l'éditeur MIDI et Score peuvent 
toutes disposer de paramètres Default Note 
Duration différents.

Default Note On Velocity

Le paramètre Default Note On Velocity permet 
de définir la valeur de vélocité de la note par 
défaut pour les notes insérées manuellement. 
La fenêtre Edit, les fenêtres de l'éditeur MIDI et 
la fenêtre de l'éditeur Score peuvent toutes 
disposer de paramètres Default Note On 
Velocity différents.

Nouveaux boutons de zoom 
de la fenêtre Edit

Boutons de zoom avant/arrière horizontal et 
vertical

Outre les commandes de zoom de la barre 
d'outils, Pro Tools 8.0 comprend des boutons de 
zoom vertical et horizontal dans l'angle inférieur 
droit de la fenêtre Edit. 

Pour activer ou désactiver l'option Timeline 
Insertion/Play Start Marker Follows 
Playback, appuyez sur Démarrer+N 
(Windows) ou sur Ctrl+N (Mac).

Commandes d'édition MIDI dans la fenêtre Edit

Play MIDI Notes When Editing

Default Note Duration

Default Note On Velocity

Boutons de zoom 

Boutons de zoom avant/arrière horizontal

arrière/avant 
vertical
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Boutons de zoom vertical Effectue un zoom 
proportionnel sur les hauteurs de pistes dans la 
fenêtre Edit.

Boutons de zoom horizontal Effectue un zoom sur 
la timeline de la même façon que les 
commandes de zoom horizontal de la fenêtre 
Edit.

Boutons de zoom avant et arrière pour les 
éléments audio et MIDI

Pro Tools 8.0 fournit également des boutons de 
zoom avant et arrière audio et MIDI, dans l'angle 
supérieur droit de la fenêtre Edit. Ces 
commandes fonctionnent de façon identique à 
celle des commandes de zoom audio et MIDI de 
la barre d'outils, et vous permettent d'effectuer 
un zoom avant ou arrière verticalement sur des 
formes d'onde audio et des notes MIDI 
respectivement. Cliquez sur la partie supérieure 
du bouton pour effectuer un zoom vers l'avant 
et sur la partie inférieure pour effectuer un zoom 
vers l'arrière.

Suppression du silence 
jusqu'à –96 dB
Dans Pro Tools 8.0, la fonctionnalité Strip 
Silence vous permet désormais de régler le 
curseur Strip Threshold jusqu'à –96 dB (la limite 
minimum était auparavant –48 dB). Cet 
élargissement de la gamme dynamique est 
particulièrement utile lorsque vous travaillez sur 
des enregistrements dont les signaux sont de 
faible intensité (enregistrements du son 
ambiant, par exemple) ou des enregistrements à 
large gamme dynamique (telle que la musique 
symphonique).

Snap To Grid
Dans les versions précédentes, les quatre modes 
d'édition de Pro Tools (Shuffle, Slip, Spot et 
Grid) s'excluaient mutuellement. Désormais, 
Pro Tools 8.0 vous permet d'activer l'option 
Snap To Grid lorsque vous êtes en mode Shuffle, 
Slip ou Spot. Lorsqu'un de ces modes est activé 
avec l'option Snap To Grid, le déplacement du 
curseur d'édition et les sélections d'édition sont 
restreints à la grille, et les éditions de région 
dépendent également de l'autre mode d'édition 
sélectionné. 

Le zoom vertical MIDI affecte uniquement 
les pistes de la vue Regions.

Boutons de zoom 

Boutons de zoom 

avant/arrière audio

avant/arrière MIDI 

Fenêtre Strip Silence
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Par exemple, lorsque l'option Snap to Grid est 
activée en mode Shuffle, vous pouvez effectuer 
une sélection dans la région en fonction de la 
grille, puis couper la sélection. Les régions 
situées à droite de la sélection se déplacent alors 
vers la gauche.

Pour activer l'option Snap to Grid dans un autre 
mode d'édition :

Maintenez la touche Maj enfoncée et cliquez 
sur le bouton du mode Grid.

Pour activer le mode Shuffle, Slip ou Spot lorsque 
vous êtes en mode Grid :

Maintenez la touche Maj enfoncée et cliquez 
sur le bouton Shuffle, Slip ou Spot.

Nouveaux raccourcis clavier 
de zoom

Pour effectuer un zoom horizontal afin d'afficher la 
sélection entière sans affecter le zoom vertical ou 
le défilement, effectuez l'une des opérations 
suivantes:

Appuyez sur Alt+Démarrer+A (Windows) ou 
Option+Ctrl+A (Mac).

– ou –

Appuyez sur les touches Ctrl+Démarrer+[ 
(Windows) ou Pomme+Ctrl+[ (Mac).

Pour effectuer un zoom avant horizontal sur une 
sélection sans affecter le zoom vertical ou le 
défilement, effectuez l'une des opérations 
suivantes :

Appuyez sur Alt+Démarrer+F (Windows) ou 
Option+Ctrl+F (Mac).

– ou –

Appuyez sur les touches Ctrl+Démarrer+] 
(Windows) ou Pomme+Ctrl+] (Mac).

Pour effectuer un zoom vertical audio afin d'afficher 
la hauteur de la forme d'onde par défaut :

Appuyez sur Ctrl+Alt+Start+[ (Windows) ou 
Pomme+Option+Ctrl+[ (Mac).

Pour effectuer un zoom vertical MIDI afin d'afficher 
toutes les notes (de la plus basse à la plus haute) 
sur les pistes MIDI et les pistes d'instrument :

Appuyez sur les touches Ctrl+Démarrer+Maj+[ 
(Windows) ou Pomme+Ctrl+Maj+[ (Mac).

Mode Shuffle avec option Snap to Grid activée

Pour activer l'option Snap to Grid dans un 
autre mode d'édition, appuyez sur Maj+F4.

Pour activer le mode Shuffle avec l'option 
Snap to Grid, appuyez sur F1+F4. Pour 
activer le mode Slip avec l'option Snap to 
Grid, appuyez sur F2+F4. Pour activer le 
mode Spot avec l'option Snap to Grid, 
appuyez sur F3+F4.
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Commandes et améliorations 
principales de la sélection 
d'édition

Restauration de la dernière sélection

Il est possible de perdre la sélection lorsque 
celle-ci est en cours d'édition. Si vous perdez la 
sélection d'édition (ou de timeline) actuelle et 
que vous souhaitez la restaurer, utilisez la 
commande Restore Last Selection. 

Pour restaurer la dernière sélection :

Sélectionnez Edit > Restore Last Selection.

Déplacement d'une insertion vers le 
début ou la fin d'une sélection

Lorsque le Transport est arrêté, vous pouvez 
utiliser les flèches vers le haut ou vers le bas de 
votre clavier QWERTY pour déplacer le curseur 
vers le début ou la fin de la sélection d'édition 
(ou de timeline) et réduire la sélection.

Pour déplacer une insertion vers le début de la 
sélection :

Appuyez sur la flèche vers le bas.

Pour déplacer une insertion vers la fin de la 
sélection :

Appuyez sur la flèche vers le haut.

Raccourcis clavier supplémentaires 
pour la modification de la sélection 
d'édition

Pro Tools inclut plusieurs raccourcis clavier pour 
déplacer, étendre ou réduire une sélection 
d'édition (ou de timeline).

Pour déplacer la sélection vers l'avant, de la 
longueur de la sélection :

Appuyez sur Ctrl+Alt+Start+' (apostrophe) 
(Windows) ou Pomme+Option+Ctrl+' 
(apostrophe) (Mac).

Pour déplacer la sélection vers l'arrière, de la 
longueur de la sélection :

Appuyez sur Ctrl+Alt+Démarrer+L (Windows) 
ou Pomme+Ctrl+Option+L (Mac).

Pour doubler la longueur de la sélection d'édition :

Appuyez sur Ctrl+Alt+Démarrer+Maj+' 
(apostrophe) (Windows) ou 
Pomme+Ctrl+Option+Maj+' (apostrophe) 
(Mac).

Pour diminuer de moitié la longueur d'une 
sélection :

Appuyez sur Ctrl+Alt+Démarrer+Maj+L 
(Windows) ou Pomme+Ctrl+Option+Maj+L 
(Mac).

Annulation du changement de zoom

Lorsque le changement de zoom est activé, vous 
pouvez l'annuler et rester au même niveau de 
zoom.

Pour annuler le changement de zoom :

Appuyez sur les touches Alt+Maj+E 
(Windows) ou Option+Maj+E (Mac).

Pour restaurer la sélection précédente, vous 
pouvez également appuyez sur Ctrl+Alt+Z 
(Windows) ou Pomme+Option+Z (Mac).
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Commandes du clavier New 
Record Enable, Input Enable, 
Solo et Mute
Pro Tools fournit des raccourcis clavier pour les 
fonctions d'activation de l'enregistrement, 
d'activation des entrées, la lecture en solo et la 
coupure du son sur les pistes contenant le 
curseur d'édition ou une sélection d'édition. 
L'utilisation des commandes clavier au cours 
d'une session vous permet d'activer ou de 
désactiver rapidement n'importe laquelle de ces 
options, sans avoir à utiliser la souris. 

Pour préparer à l'enregistrement des pistes 
contenant le curseur d'édition ou une sélection 
d'édition :

Appuyez sur Maj+R pour activer ou désactiver 
la préparation à l'enregistrement.

Pour préparer à la saisie des pistes contenant le 
curseur d'édition ou une sélection d'édition :

Appuyez sur Maj+I pour activer ou désactiver 
la préparation à la saisie.

Pour effectuer une lecture solo des pistes 
contenant le curseur d'édition ou une sélection 
d'édition :

Appuyez sur Maj+S pour activer ou désactiver 
la lecture solo.

Pour couper le son des pistes contenant le curseur 
d'édition ou une sélection d'édition :

Appuyez sur Maj+M pour activer ou désactiver 
la coupure du son.

Verrouillage des régions
Dans de nombreux cas, il est nécessaire de 
“verrouiller” des régions ou des groupes de 
régions sur un emplacement temporel 
spécifique afin d'éviter qu'ils ne soient pas 
déplacés involontairement. Vous pouvez 
également les protéger d'une modification 
involontaire. Pro Tools fournit deux types de 
verrouillage des régions : le verrouillage de 
l'édition et le verrouillage de l'emplacement 
temporel.

Verrouillage de l'édition des 
régions

Si vous souhaitez protéger une région ou un 
groupe de régions d'une modification 
involontaire, vous avez la possibilité de les 
verrouiller. Les régions pour lesquelles le 
verrouillage de l'édition est activé ne peuvent 
pas être modifiées (coupe, suppression, 
séparation, rognage) ni être déplacées vers un 
autre emplacement temporel. Les régions pour 
lesquelles le verrouillage de l'édition est activé 
peuvent être copiées, puis collées vers une piste 
ou un emplacement temporel, mais l'édition de 
la copie sera également verrouillée.

La commande de verrouillage de l'édition 
est identique à la commande de verrouillage 
des régions (Lock Regions) des versions 
précédentes de Pro Tools.
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Pour verrouiller (ou déverrouiller) l'édition d'une 
région :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions pour lesquelles 
verrouiller (ou déverrouiller) l'édition. 
Les régions peuvent se trouver sur des pistes 
différentes.

2  Sélectionnez Region > Edit Lock/Unlock.

Lorsque l'édition est verrouillée, une petite 
icône apparaît dans la région. Cette dernière ne 
peut alors être ni déplacée, ni supprimée, ni 
modifiée. Si vous tentez d'effectuer des 
modifications sur une région verrouillée, 
Pro Tools vous en avertit (reportez-vous à la 
section “Modification de régions dont l'édition a 
été verrouillée”, page 42)

En mode Shuffle, les régions pour lesquelles 
l'édition a été verrouillée, ainsi que toutes les 
régions situées après la région verrouillée, ne 
sont pas déplacées lorsque d'autres régions 
voisines sont déplacées.

Pour les pistes Elastic Audio basées sur des 
références temporelles, les régions pour 
lesquelles l'édition a été verrouillée se 
conforment au changement de tempo, mais 
aucun autre traitement Elastic Audio (la 
quantification ou la distorsion manuelle par 
exemple) ne peut être effectué.

Verrouillage de l'emplacement 
temporel des régions

Vous pouvez verrouiller les régions à un 
emplacement précis de la piste (une mesure, une 
image SMPTE ou un échantillon) afin qu'elle ne 
soit pas déplacée par inadvertance. Les régions 
verrouillées sur un emplacement temporel ne 
peuvent pas être déplacées Néanmoins, les 
modifications n'ayant pas d'impact sur 
l'emplacement temporel de la région peuvent 
être effectuées (séparation, rognage, traitement 
AudioSuite ou déplacement de la région vers 
une autre piste par exemple). Les régions 
verrouillées sur un emplacement temporel 
peuvent également être supprimées. Lorsque 
vous séparez une région de ce type, toutes les 
nouvelles régions seront également verrouillées 
sur un emplacement temporel.

Pour verrouiller (ou déverrouiller) l'emplacement 
temporel d'une région :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions pour lesquelles 
verrouiller (ou déverrouiller) l'emplacement 
temporel. Les régions peuvent se trouver sur des 
pistes différentes.

2  Sélectionnez Region > Time Lock/Unlock.

Appuyez sur Ctrl+L (Windows) ou 
Pomme+L (Mac) pour verrouiller ou 
déverrouiller l'édition de la région 
sélectionnée.

Région verrouillée pour l'édition

Icône de verrouillage de l'édition
Appuyez sur Maj+T pour verrouiller ou 
déverrouiller l'emplacement temporel de la 
région sélectionnée.
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Lorsqu'une région est verrouillée sur un 
emplacement temporel, une icône de 
verrouillage s'affiche dans la région ; la région 
ne peut pas être déplacée, mais vous pouvez la 
modifier ou même la supprimer.

En mode Shuffle, les régions pour lesquelles 
l'emplacement temporel a été verrouillé, ainsi 
que toutes les régions situées après la région 
verrouillée, ne sont pas déplacées lorsque 
d'autres régions voisines sont déplacées.

Pour les pistes Elastic Audio basées sur des 
références temporelles, les régions verrouillées 
sur un emplacement temporel se conforment au 
changement de tempo, mais aucun autre 
traitement Elastic Audio (la quantification ou la 
distorsion manuelle par exemple) ne peut être 
effectué.

Modification de régions dont 
l'édition a été verrouillée

Si vous tentez de modifier une région pour 
laquelle le verrouillage de l'édition a été activé, 
Pro Tools vous en avertit et vous invite à 
annuler ou autoriser la modification (Cancel ou 
Allow). Si vous autorisez une édition mais que 
celle-ci ne modifie pas la région, le verrouillage 
reste activé.

Vue Regions pour les pistes 
MIDI et les pistes 
d'instrument
Dans Pro Tools 8.0, les pistes MIDI et 
d'instrument s'affichent par défaut dans la vue 
Regions. Cela permet de faciliter la modification 
et la redisposition des régions MIDI dans la 
fenêtre Edit. Pour effectuer une édition MIDI 
détaillée, cliquez deux fois sur la région MIDI de 
votre choix pour l'ouvrir dans une fenêtre de 
l'éditeur MIDI. 

Transposition de la hauteur du 
son basée sur les régions 
Elastic Audio
(Polyphonique, rythmique et X-Form 
uniquement)

Outre les fonctions de compression/extension 
temporelle audio Pro Tools Elastic Audio, vous 
pouvez également modifier la hauteur de 
régions audio complètes en demi-tons et cents 
dans un intervalle + ou – 2 octaves. 

Vous pouvez appliquer la transposition des 
hauteurs aux régions Elastic Audio à l'aide de la 
fenêtre Elastic Properties ou Transpose.

Région verrouillée sur un emplacement temporel

Icône de verrouillage de l'emplacement temporel

Pour plus d'informations sur les fenêtres de 
l'éditeur MIDI, voir chapitre 6, “Fenêtres de 
l'éditeur MIDI”

L'algorithme monophonique ne prend pas 
en charge la transposition de hauteurs 
Elastic Audio.
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Pout transposer la hauteur d'une région audio dans 
la fenêtre Elastic Properties :

1  Vérifiez que la ou les régions à transposer se 
trouvent sur des pistes Elastic Audio (algorithme 
polyphonique, rythmique ou X-Form).

2  A l'aide de l'outil d'accrochage de temps ou du 
sélecteur, sélectionnez les régions audio que 
vous voulez transposer. Seules les régions 
entièrement sélectionnées seront affectées.

3  Effectuez l'une des opérations suivantes pour 
ouvrir la fenêtre Elastic Properties : 

• Sélectionnez Region > Elastic Properties.

– ou –

• Cliquez avec le bouton droit de la souris sur 
la région sélectionnée et choisissez Elastic 
Properties.

4  Réglez les paramètres Pitch Shift sur le niveau 
souhaité en demi-tons et cents.

Pout transposer la hauteur d'une région audio dans 
la fenêtre Transpose :

1  Vérifiez que la ou les régions à transposer sont 
placées sur des pistes Elastic Audio.

2  A l'aide de l'outil d'accrochage de temps ou du 
sélecteur, sélectionnez les régions audio que 
vous voulez transposer. Seules les régions 
entièrement sélectionnées seront affectées.

3  Choisissez Event > Event Operations > Transpose.

4  Effectuez l'une des opérations suivantes :

• Réglez les paramètres Transpose By sur le 
niveau souhaité en demi-tons et cents.

• Réglez les paramètres Transpose From et To 
sur le niveau souhaité en demi-tons et 
cents.

5  Cliquez sur Apply.

Appuyez sur Alt+5 (Windows) ou Option+5 
(Mac) sur la pavé numérique pour ouvrir la 
fenêtre Elastic Properties.

Fenêtre Elastic Properties

Event Operations, Transpose

Les paramètres Transpose All Notes To et 
Transpose In Key s'appliquent uniquement 
aux notes MIDI. Lorsque vous avez 
sélectionné seulement des régions audio, ces 
options ne sont pas disponibles.
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Transposition de la hauteur du son et 
vitesse variable

Lorsque l'algorithme de vitesse variable 
(Varispeed) est utilisé, la transposition de la 
hauteur du son et la compression/expansion 
temporelle sont toujours liées. Si vous appliquez 
la transposition de la hauteur du son à une 
région audio à l'aide de l'algorithme 
polyphonique ou rythmique, les données de 
cette transposition sont stockées dans les 
métadonnées de la région. Par conséquent, si 
vous passez ensuite à l'algorithme Varispeed, 
modifiez le facteur TCE, puis retournez à 
l'algorithme Elastic Audio d'origine ; la région 
revient à sa valeur de décalage de hauteur 
initiale tout en conservant la quantité de 
compression/expansion appliquée par 
l'algorithme Varispeed.

Suppression du décalage de la 
hauteur d'une région

Si vous avez appliqué un décalage de hauteur à 
une région, vous pouvez supprimer ce décalage 
et rétablir la valeur de décalage d'origine de la 
région. Cela est particulièrement utile lorsque 
vous n'êtes pas satisfait du résultat obtenu et que 
vous souhaitez rétablir l'état initial de la région.

Pour supprimer le décalage de la hauteur d'une 
région :

1  Sélectionnez la région dont vous voulez 
supprimer le décalage de hauteur.

2  Effectuez l'une des opérations suivantes :

• Choisissez Region > Remove Pitch Shift.

– ou –

• A l'aide de l'un des outils d'édition, cliquez 
avec le bouton droit de la souris sur la 
région et sélectionnez Remove Pitch Shift.

Amélioration de la qualité audio 
avec Elastic Audio

Dans Pro Tools 8.0, Digidesign a apporté de 
nouvelles améliorations à la qualité sonore des 
algorithmes Polyphonique, Monophonique et 
Rythmique utilisés pour le traitement Elastic 
Audio. 

Amélioration de la fonction 
Quantize Event Operation
La commande Quantize s'applique toujours à 
l'emplacement d'origine de l'événement (Elastic 
Audio et MIDI). Cela vous permet d'appliquer de 
nouveaux paramètres Quantize sans devoir 
appliquer d'abord la fonction Restore 
Performance ou annuler la commande Quantize 
appliquée précédemment.

La fonction Pitch Shift peut être appliquée 
uniquement aux régions, et non aux groupes 
de régions. Pour supprimer le décalage de la 
hauteur d'un groupe de régions, vous devez 
annuler d'abord le groupement des régions, 
appliquer la commande Remove Pitch Shift 
aux régions sous-jacentes, puis regrouper ces 
régions à nouveau.

Lorsque vous ouvrez dans Pro Tools 8.0 des 
sessions Pro Tools 7.4.x utilisant Elastic 
Audio, une partie du traitement Elastic 
Audio risque de subir de légères 
modifications liées aux nouveaux 
algorithmes améliorés. Veillez à bien 
écouter la session dans Pro Tools 8.0 avec 
les nouveaux algorithmes de traitement 
Elastic Audio et effectuez toutes les 
modifications nécessaires (par exemple, le 
réglage du paramètre Decay Rate lorsque 
vous utilisez le plug-in rythmique Elastic 
Audio).
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Améliorations des fichiers 
d'appareils d'enregistrement 
portables
Deux améliorations ont été apportées à 
Pro Tools 8.0 pour la gestion des métadonnées 
associées aux fichiers importés à partir 
d'appareils d'enregistrement portables. 

Métadonnées de la date de tournage 

De nombreux appareils d'enregistrement 
portables ne renseignent pas automatiquement 
le champ Shoot Date ; la date de création du 
fichier est alors indiquée comme référence pour 
indiquer la date de production. Désormais, 
lorsque Pro Tools importe un fichier issu d'un 
appareil d'enregistrement portable, il vérifie que 
le champ Shoot Date est bien renseigné. Si 
celui-ci est vide, Pro Tools copie la date de 
création du fichier source d'origine dans le 
champ Shoot Date des nouveaux fichiers 
importés.

Modification des métadonnées du nom 
de canal 

Le champ Channel Name de DigiBase affiche le 
nom du canal, suivi du numéro de canal entre 
parenthèses. Il est désormais possible de 
modifier le nom de canal des fichiers BWF 
mono. Lorsque vous modifiez le nom du canal, 
tout ce qui est saisi à l'intérieur des parenthèses 
sera ignoré. Le numéro du canal est cependant 
toujours conservé.
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chapitre 5

Préparation de pistes composites

Pro Tools 8.0 fournit des outils de préparation des 
pistes composites pour les pistes audio. 
Ce processus décrit l'assemblage de différentes 
sélections issues de prises de remplacement, ou 
playlists, afin d'élaborer la meilleure version 
possible d'une performance à partir de plusieurs 
passes d'enregistrement. A l'aide de la vue 
Playlists d'une piste audio, vous pouvez 
sélectionner les meilleures parties des playlists 
de remplacement d'une piste, afin de les copier 
dans la playlist principale. Cela vous permet de 
créer rapidement et en toute simplicité la prise 
parfaite, à partir de plusieurs playlists de 
remplacement.

Exemple pratique de 
préparation de pistes 
composites
Cet exemple présente certaines des tâches 
standard entrant dans la préparation des pistes 
composites : 

• Configuration d'une session pour cet 
exemple.

• Enregistrement en boucle de plusieurs 
prises sur une piste audio.

• Audition et sélection de la meilleure prise.

• Copie de la meilleure prise dans la playlist 
principale.

Configuration d'une session :

1  Ouvrez une session Pro Tools existante ou 
créez une nouvelle session.

2  Sélectionnez Setup > Preferences, puis cliquez 
sur l'onglet Operation.

3  Sur la page Operation, dans la section Record, 
sélectionnez l'option Automatically Create New 
Playlists When Loop Recording.

4  Cliquez sur OK.

Activation de l'option Automatically Create New 
Playlists When Loop Recording dans les préférences de 
fonctionnement
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Enregistrement en boucle de plusieurs pistes :

1  Créez une nouvelle piste audio (stéréo ou 
mono) ou utilisez une piste existante.

2  Vérifiez que la source que vous voulez 
enregistrer est correctement connectée et 
acheminée vers l'entrée de piste.

3  Dans le sélecteur Track View, sélectionnez 
Playlists. 

4  Pour écouter jusqu'au début de la boucle, 
activez le préroll et définissez sa durée.

5  Activez l'option Loop Recording en procédant 
de l'une des façons suivantes :

• Sélectionnez Options > Loop Playback.

– ou –

• Cliquez avec le bouton droit de la souris sur 
le bouton Play dans la fenêtre Transport et 
sélectionnez Loop.

6  Vérifiez que vous avez bien sélectionné Options 
> Link Timeline and Edit Selection.

7  A l'aide du sélecteur, sélectionnez la plage de 
boucle dans la piste. 

8  Préparez en enregistrement la piste audio en 
cliquant sur son bouton Record Enable.

9  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

10  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

11  Une fois terminé, cliquez sur le bouton 
d'arrêt pour arrêter l'enregistrement.

12  Si vous ne voulez pas effectuer d'autre passe 
d'enregistrement en boucle, désactivez 
l'enregistrement sur la piste audio.

Une fois que vous avez arrêté l'enregistrement 
en boucle, remarquez que toutes les prises 
d'enregistrement en boucle sont visibles dans les 
lignes de la playlist sous la playlist principale 
(y compris la totalité de la région du fichier 
audio et l'intégralité des passes d'enregistrement 
en boucle).

Vue Playlists affichant plusieurs playlists de 
remplacement

Si vous avez désactivé l'option 
Automatically Create New Playlists When 
Loop Recording avant de commencer 
l'enregistrement en boucle, cliquez avec le 
bouton droit de la souris sur la région dans 
la playlist principale et sélectionnez 
Matches > Expand Alternates to New 
Playlists.
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Pour masquer la région du fichier contenant toutes 
les prises et n'afficher que les prises ayant les 
mêmes temps de début et de fin comme sélection 
d'édition, procédez de l'une des façons suivantes :

Cliquez avec le bouton droit de la souris sur la 
ligne de la playlist et sélectionnez Hide.

– ou –

En conservant intacte la sélection d'édition 
utilisée pour l'enregistrement en boucle, cliquez 
avec le bouton droit de la souris sur le nom de la 
piste ou sur un des noms de ligne de la playlist et 
sélectionnez Filter Lanes > Show Only Lanes With > 
Regions Within the Edit Selection.

Pour écouter les playlists de remplacement :

1  Activez l'option Loop Playback en procédant 
comme suit :

• Sélectionnez Options > Loop Playback.

– ou –

• Cliquez avec le bouton droit de la souris sur 
le bouton Record dans la fenêtre Transport 
et sélectionnez Loop.

2  Sans modifier la sélection de timeline et avec 
les mêmes paramètres de pré-roll/post-roll 
activés, commencez la lecture. La lecture de la 
playlist principale est lancée.

3  Cliquez sur le bouton Solo de la ligne de 
playlist de remplacement que vous voulez 
écouter. Répétez cette étape pour chaque ligne 
de playlist que vous voulez écouter. L'écoute 
d'une ligne de playlist en solo n'affecte que la 
playlist de la piste, le son des autres pistes de la 
session n'est pas coupé.

Copie de la meilleure prise dans la playlist 
principale :

1  Une fois que vous avez identifié la meilleure 
prise, effectuez toutes les modifications 
nécessaires dans la sélection d'édition, le cas 
échéant. Il s'agit de la sélection qui sera copiée 
dans la playlist principale.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Copy Selection To > Main 
Playlist.

• Cliquez avec le bouton droit de la souris sur 
la sélection et choisissez Copy Selection to 
Main Playlist.

• Cliquez sur le bouton Copy Selection to 
Main Playlist de la ligne de playlist.Affichages des lignes filtrées de la playlist
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Vue Playlists Track
La vue Playlists Track vous permet d'afficher la 
playlist principale de la piste, ainsi que les 
playlists de remplacement associées à la piste. 
Les playlists de remplacement sont affichées 
directement sous la piste dans les lignes de 
playlist.

Vous pouvez modifier des playlists de 
remplacement en vue Playlist de la même façon 
que pour la playlist principale dans la vue 
Waveform. Dans la vue Playlists, les 
modifications appliquées à des plages de 

sélection s'appliquent à toutes les playlists de 
remplacement affichées. Les playlists de 
remplacement qui ne sont pas visibles ne sont 
pas affectées.

Pour afficher les lignes de playlist d'une piste :

Dans le sélecteur Track View, sélectionnez 
Playlists.

\

Si la piste ne contient pas de playlists de 
remplacement en plus de la playlist principale, 
une seule ligne de playlist vide s'affiche sous la 
playlist principale. Vous pouvez faire glisser et 
déplacer du contenu audio vers cette ligne à 
partir de la liste des régions, des navigateurs 
DigiBase ou d'autres pistes audio afin de créer 
une playlist de remplacement pour la piste, 
outre la playlist principale.

Copie de la sélection d'édition d'une playlist de 
remplacement dans la playlist principale

Appuyez sur Ctrl+Alt+Démarrer+V 
(Windows) ou sur Pomme+Option+Ctrl+V 
(Mac) pour copier la sélection dans la 
playlist principale.

Bouton Copy Selection to Main Playlist

Avant de commencer le processus de 
préparation de pistes composites, dupliquez 
la playlist principale de la piste afin d'en 
garder une copie de sauvegarde intacte 
comme playlist de remplacement.

Les groupes de régions ne sont pas pris en 
charge dans la vue Playlists Track.

Sélection de la vue Playlists Track

Vous pouvez aussi maintenir enfoncées les 
touches Ctrl+Alt (Windows) ou 
Pomme+Ctrl (Mac) en cliquant sur le 
sélecteur Playlist pour passer en vue 
Playlists.
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Si la piste contient au moins une playlist de 
remplacement en plus de la playlist principale, 
celle-ci s'affiche dans les lignes situées sous la 
playlist principale. Dans tous les cas, la ligne de 
playlist du bas reste toujours vide et peut être 
utilisée pour ajouter des régions en vue de créer 
de nouvelles playlists de remplacement.

Ecoute des playlists de remplacement

Seule la playlist principale est lue sur le chemin 
de sortie audio de la piste. Pour pouvoir écouter 
une playlist de remplacement, vous devez 
mettre en solo la ligne de playlist. Le chemin de 
sortie audio de la piste lit alors la ligne mise en 
solo au lieu de la playlist principale.

Pour écouter une playlist de remplacement :

1  Cliquez sur le bouton Solo de la ligne de 
playlist que vous voulez écouter. L'écoute d'une 
ligne de playlist en solo n'affecte que la playlist 
de la piste, le son des autres pistes de la session 
n'est pas coupé.

2  Lancez la lecture de Pro Tools.

Dépôt de contenu audio de la liste des régions en vue 
de créer une playlist de remplacement

Piste avec playlists de remplacement en vue Playlists 
Track

Mise en solo d'une playlist de remplacement

Appuyez sur Maj+S pour mettre en solo une 
ligne de playlist contenant le curseur 
d'édition. Si plus d'une ligne de playlist 
contient le curseur d'édition, la ligne la plus 
haute dans la liste est mise en solo.

Pour déplacer le curseur d'édition vers le 
haut ou vers le bas dans les lignes de 
playlist, cliquez sur Démarrer+P et 
Démarrer+; (Windows) ou Ctrl+P et Ctrl+; 
(Mac).
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Copie de playlists de remplacement 
dans la playlist principale

Une fois que vous avez trouvé dans une playlist 
de remplacement une sélection à utiliser dans la 
playlist principale, copiez et collez la sélection 
dans la playlist principale. En procédant ainsi, 
vous pouvez élaborer la meilleure combinaison 
de sélections à partir des playlists de 
remplacement. 

Outre les commandes manuelles de copie et 
collage dans la playlist principale, Pro Tools 
fournit plusieurs commandes permettant de 
copier et coller votre sélection dans la playlist 
principale :

Copy Selection To Main Playlist copie et colle la 
sélection dans la playlist principale. Les 
contenus déjà présents au même emplacement 
dans la playlist principale seront remplacés.

Copy Selection to New Playlist crée une nouvelle 
playlist principale vide et effectue un copier-
coller de la sélection dans la nouvelle playlist 
principale.

Copy Selection to Duplicate Playlist Duplique la 
playlist principale actuelle et effectue un copier-
coller de la sélection dans la playlist principale 
dupliquée. La playlist principale précédente est 
déplacée vers une nouvelle ligne Playlist.

Pour copier la sélection d'édition d'une playlist de 
remplacement dans la playlist principale :

1  En mode Playlists, effectuez une sélection dans 
une playlist de remplacement.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Copy Selection to 
Main Playlist dans les commandes Playlist 
Lane.

• Sélectionnez Edit > Copy Selection to Main 
Playlist.

• Cliquez avec le bouton droit de la souris sur 
la sélection et choisissez Copy Selection to 
Main Playlist.

Sélection dans une playlist de remplacement 

Appuyez sur Ctrl+Alt+Démarrer+V 
(Windows) ou sur Pomme+Option+Ctrl+V 
(Mac) pour copier la sélection dans la 
playlist principale.

Bouton Copy Selection to Main Playlist
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La sélection de la playlist de remplacement est 
copiée au même emplacement temporel dans la 
playlist principale.

Pour copier une sélection d'une playlist de 
remplacement dans une nouvelle playlist 
principale :

1  En mode Playlists, effectuez une sélection dans 
une playlist de remplacement.

2  Sélectionnez Edit > Copy Selection To New 
Playlist.

Pour copier une sélection d'une playlist de 
remplacement dans une copie de la playlist 
principale :

1  En mode Playlists, effectuez une sélection dans 
une playlist de remplacement.

2  Sélectionnez Edit > Copy Selection to Duplicate 
Playlist.

Déplacement de régions dans des 
lignes de playlists 

Vous pouvez faire glisser des régions et les 
déposer sur une ligne de playlist sur n'importe 
quelle piste dotée d'une largeur de canal 
identique. Par exemple, il n'est pas possible de 
faire déplacer une région stéréo sur une ligne de 
playlist mono, et inversement. De même, vous 
pouvez déplacer des régions d'une ligne de 
playlist sur n'importe quelle autre piste de 
largeur de canal identique.

Sélection copiée dans la playlist principale

Sélection copiée dans une nouvelle playlist principale

Sélection copiée dans une copie de la playlist principale
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Edition dans les lignes de playlist

Vous pouvez modifier des régions dans les lignes 
de playlist de la même façon que dans la playlist 
principale. Vous pouvez même déplacer des 
régions entre différentes lignes de playlist (y 
compris la playlist principale), entre différentes 
pistes et à différents points de l'échelle 
temporelle. Cependant, vous ne pourrez 
entendre vos modifications sur les lignes de 
playlist que si la ligne que vous avez modifié est 
mise en solo (voir “Ecoute des playlists de 
remplacement”, page 51).

Modification de l'ordre des lignes de 
playlist

Vous pouvez modifier l'ordre des lignes de 
playlist de la même façon que l'ordre des pistes.

Pour modifier l'ordre des lignes de playlist :

Cliquez sur le nom d'une playlist de 
remplacement et faites-la glisser à 
l'emplacement de votre choix.

Redimensionnement des lignes de 
playlist

Vous pouvez redimensionner les lignes de 
playlist de la même façon que vous 
redimensionnez les pistes. 

Pour redimensionner la piste et toutes les lignes de 
playlist en même temps, procédez de l'une des 
façons suivantes :

Cliquez sur la ligne qui sépare les lignes et 
faites-la glisser vers le haut ou vers le bas. 
La piste et toutes les lignes de playlist sont 
redimensionnées proportionnellement.

– ou –

Cliquez avec le bouton droit de la souris sur 
l'échelle verticale située entre la zone de playlist 
et les commandes Playlist Lane, puis 
sélectionnez la taille de ligne de votre choix. 
La piste et toutes les lignes de playlist sont 
redimensionnées proportionnellement.

Modification de l'ordre des lignes de playlist

Pour redimensionner la hauteur d'une piste, 
playlist ou ligne contenant une sélection 
d'édition ou dans laquelle le curseur 
d'édition se trouve actuellement, maintenez 
enfoncée la touche Démarrer (Windows) ou 
Ctrl (Mac) pendant que vous cliquez sur la 
touche fléchée Haut/Bas.
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Pour redimensionner une seule ligne de playlist, 
effectuez l'une des opérations suivantes :

Cliquez sur la ligne qui sépare les lignes en 
maintenant la touche Ctrl enfoncée, puis 
faites-la glisser vers le haut ou vers le bas. 
La ligne du haut est redimensionnée en 
fonction.

– ou –

Cliquez avec le bouton droit de la souris en 
maintenant la touche Ctrl enfoncée sur l'échelle 
verticale située entre la zone de playlist et les 
commandes Playlist Lane, puis sélectionnez la 
taille de ligne de votre choix.

Attribution d'un nouveau nom aux 
playlists de remplacement

Vous pouvez renommer les playlists de 
remplacement de la même façon que vous 
renommez les pistes. 

Pour renommer une playlist de remplacement :

1  Cliquez deux fois sur le nom de la playlist de 
remplacement.

2  Dans la boîte de dialogue Name qui s'ouvre, 
saisissez le nom de votre choix.

3  Cliquez sur OK.

Playlists de remplacement dans la liste 
des pistes

Lorsqu'une piste audio est définie en mode 
Playlists, toutes les playlists qui lui sont 
associées s'affichent sous le nom de la piste dans 
la liste des pistes. Les noms des playlists de 
remplacement associées s'affichent avec un 
retrait pour distinguer les lignes de playlist des 
pistes. Dans la liste des pistes, vous pouvez 
afficher ou masquer les playlists de 
remplacement. Vous pouvez également accéder 
au menu contextuel des playlists de 
remplacement, qui vous permet d'appliquer les 
commandes Show ou Hide, Scroll Into View, 
Rename, Delete et Filter Lanes.

Redimensionnement d'une ligne de playlist

Sélection d'une taille prédéterminée pour une ligne de 
playlist

Liste des pistes affichant les lignes de playlist pour les 
pistes Audio 1 et R Guitar FX

Piste audio

Lignes de playlist
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Filtrage des lignes

Il est possible de filtrer les lignes afin de les 
afficher ou de masquer suivant différents 
critères.

Pour filtrer les lignes de playlist :

1  Cliquez avec le bouton droit de la souris sur le 
nom de la piste ou le nom de la playlist.

2  Dans le menu contextuel, sélectionnez l'une 
des options suivantes :

• Show All Lanes 

• Show Only Lanes With > Regions Within The Edit 
Selection 

• Show Only Lanes With > Regions Outside The 
Edit Selection 

• Show Only Lanes With > “Regions Rated >= 
1–5” 

• Hide All Lanes 

• Hide Only Lanes With > Regions Within The Edit 
Selection 

• Hide Only Lanes With > Regions Outside The 
Edit Selection 

• Hide Only Lanes With > “Regions Rated >= 
1–5” 

Les lignes de playlist sont affichées et masquées 
en fonction de l'option choisie.

Classement des régions
Vous pouvez classer différentes régions sur une 
échelle de 1 à 5, où 5 représente la note la plus 
élevée (ou la meilleure) et 1 est la note la plus 
basse (région la pire). Le classement des régions 
permet d'identifier plus facilement les prises 
(régions) qui vous plaisent le plus lors de la 
composition de playlists. Vous pouvez afficher 
ou masquer le classement des régions pour 
simplifier la préparation des pistes composites 
ou l'édition standard. Vous pouvez également 
afficher ou masquer les lignes de playlist en 
fonction du classement des régions dans la 
playlist (voir “Filtrage des lignes”, page 56).

Pour attribuer une note à une région :

1  Sélectionnez la région.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Region > Rating et sélectionnez 
une note entre 1 et 5. 

– ou –

• Cliquez avec le bouton droit de la souris sur 
la région, choisissez Rate, puis sélectionnez 
une note entre 1 et 5. 

Pour afficher le classement des régions :

Sélectionnez View > Region > Rating.

Pour masquer le classement des régions :

Désélectionnez View > Region > Rating.

Pour noter une région en cours de lecture et 
d'enregistrement, appuyez sur les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Pomme+Option+Ctrl (Mac), puis saisissez 
une note de classement (entre 1 et 5) à l'aide 
du pavé numérique.
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Régions de remplacement 
équivalentes
Pro Tools vous permet de remplacer des régions 
de la playlist principale par des régions 
équivalentes issues d'autres playlists associées à 
la même piste, d'autres pistes ou de la liste des 
régions. Les régions de remplacement 
équivalentes sont des régions qui répondent à 
certains critères. Il s'agit par exemple des régions 
dont le marqueur de temps de l'utilisateur est 
identique. 

Il existe plusieurs façons de créer des régions de 
remplacement équivalentes dans in Pro Tools:

• Lors d'un enregistrement fractionné (audio ou 
MIDI), Pro Tools crée des régions équivalentes 
pour la région d'origine (le cas échéant) et la 
nouvelle région résultant de l'enregistrement 
fractionné. 

• Lors d'un enregistrement en boucle (audio ou 
MIDI), Pro Tools crée plusieurs régions 
équivalentes pour chaque passe 
d'enregistrement. 

• Lorsque vous dupliquez des playlists (audio 
ou MIDI), des régions de remplacement 
équivalentes sont créées entre les playlists.

• Lorsque vous importez un signal audio 
multicanal d'un appareil d'enregistrement 
portable, des régions de remplacement 
équivalentes sont créées entre les canaux.

Pro Tools fournit également différentes 
méthodes pour l'accès et l'écoute de plusieurs 
régions de remplacement équivalentes :

• Utilisez le menu contextuel Region pour 
sélectionnez les régions de remplacement 
équivalentes en fonction de certains critères.

• Utilisez le menu déroulant Alternate Takes 
pour sélectionner les régions de 
remplacement équivalentes.

• Utilisez la commande Expand Alternates to 
New Tracks pour copier les régions de 
remplacement équivalentes sur de nouvelles 
pistes.

• Utilisez la commande Expand Alternates to 
New Playlists pour copier les régions de 
remplacement équivalentes sur de nouvelles 
playlists de remplacement de la même piste. 
Vous pouvez ensuite passer en vue Playlists 
pour afficher les playlists équivalentes.

Critères d'équivalence

La fenêtre Matching Criteria vous permet de 
sélectionner les critères des régions de 
remplacement équivalentes. Cela vous permet 
de restreindre la liste des régions équivalentes 
disponibles dans le menu déroulant Alternate 
Takes et dans le sous-menu Matches du menu 
contextuel Region.

Classement affiché dans les régions

Les critères d'équivalence affectent les 
régions MIDI et audio.
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Pour configurer les options de critères 
d'équivalence pour les régions de remplacement 
équivalentes :

1  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
le sélecteur ou la main, puis sélectionnez 
Matches > Match Criteria.

– ou –

• A l'aide du sélecteur, maintenez la touche 
Ctrl (Windows) ou Pomme (Mac) enfoncée 
et cliquez précisément début de la plage 
d'enregistrement en boucle ou fractionné, 
puis sélectionnez Match Criteria.

2  Dans la fenêtre Matching Criteria, 
sélectionnez une combinaison des options 
Alternates Match suivantes :

• Track ID

• Track Name

• Region Rating

3  Choisissez l'une des options In Addition To 
suivantes :

• All

• Region Start

• Region Start and End

• Within Selection

• Aucune

4  Laissez la fenêtre Matching Criteria ouverte 
pour modifier les paramètres nécessaires au fur 
et à de la préparation des pistes composites. 
Fermez la fenêtre Matching Criteria lorsque vous 
avez terminé.

Options Alternates Match

Vous pouvez sélectionner les combinaisons de 
votre choix d'options Alternates Match 
suivantes :

Track ID Toute région enregistrée sur la même 
piste est considérée équivalente. Utilisez cette 
option pour sélectionner des prises de 
remplacement issues d'un enregistrement en 
boucle ou fractionné.

Track Name Toute région dont le nom racine est 
identique à celui de la piste et de la playlist est 
considérée équivalente. Par exemple, les pistes 
identiques d'une piste nommée “Gtr.L” 
indiquent les régions “Gtr.L_01” et 
“Gtr.L_02-01”, mais pas “Guit.L_01”. 

Region Rating Toute région dont la note de 
classement est identique est considérée 
équivalente. Activez cette option si vous avez 
appliqué un classement aux régions (voir 
“Classement des régions”, page 56). 

Options d'équivalence In Addition To

Les options d'équivalence In Addition To 
s'excluent mutuellement.

All Toute région incluant l'emplacement 
temporel du curseur d'édition ou toute région 
comprise partiellement ou entièrement dans la 
plage temporelle de la sélection d'édition.

Region Start Toute région dont le début coïncide 
avec l'emplacement temporel du curseur 
d'édition ou de la sélection d'édition.

Region Start and End Toute région dont le début 
et la fin sont identiques à ceux de la sélection 
d'édition.

Selection Range Toute région comprise 
entièrement à l'intérieur de la sélection 
d'édition.

Aucune En dehors des critères sélectionnés par 
les biais des options Alternates Match, aucun 
autre critère n'est utilisé pour filtrer les régions 
de remplacement équivalentes.

Les paramètres Matching Criteria sont 
enregistrés avec votre session Pro Tools.
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Sélection de prises de 
remplacement sur les pistes
Chaque région résultant d'une passe 
d'enregistrement fractionné ou en boucle 
possède un temps de début identique (le 
marqueur de temps de l'utilisateur). Vous pouvez 
sélectionner et écouter d'autres prises à partir du 
sous-menu contextuel Matches ou du menu 
contextuel Alternate Takes, et ce même durant 
la lecture.

Pour sélectionner une prise de remplacement :

1  Le cas échéant, configurez la fenêtre Matching 
Criteria (voir “Critères d'équivalence”, page 57).

2  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
la région à l'aide du sélecteur ou de la main, 
et sélectionnez une autre prise équivalente 
dans le menu contextuel Matches.

• Si la prise se trouvant sur la piste est 
sélectionnée, maintenez enfoncée la 
touche Ctrl (Windows) ou Pomme (Mac) et 
cliquez n'importe où dans la prise avec le 
sélecteur afin de sélectionner une prise 
différente dans le menu contextuel qui 
s'affiche.

• Maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) et cliquez 
avec le sélecteur sur le début de la plage 
d'enregistrement en boucle ou fractionné. 
Sélectionnez ensuite une prise différente 
dans le menu contextuel qui s'affiche.

La région de remplacement équivalente 
sélectionnée (prise) remplace la région dans la 
playlist principale et vient s'insérer précisément 
à l'emplacement correct.

Une façon de vous assurer que les futures prises 
utilisent le même marqueur de temps utilisateur 
(et apparaissent ainsi comme régions de 
remplacement équivalentes) consiste à 
sauvegarder les sélections d'enregistrement en 
boucle ou fractionné sous forme de mémoire 
d'emplacement. Si, par la suite, vous devez 
enregistrer d'autres prises, il vous suffit de 
rappeler la mémoire d'emplacement 
correspondante. 

Pour modifier le marqueur de temps utilisateur 
d'autres régions afin qu'elles soient disponibles 
comme régions équivalentes pour un 
emplacement spécifique, utilisez la commande 
Time Stamp du menu Region List. 

Sous-menu contextuel Matches

Menu contextuel Alternate Takes
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Pistes identiques et pistes multiples

Si vous avez effectué des enregistrements en 
boucle sur plusieurs pistes et que chacune 
contient plusieurs prises avec des marqueurs de 
temps utilisateur identiques, vous pouvez 
modifier les pistes simultanément.

Pour modifier les prises de plusieurs pistes :

1  Configurez la fenêtre Matching Criteria (voir 
“Critères d'équivalence”, page 57), de sorte que 
les options suivantes soient activées :

• Track Name 

– et –

• Selection Range

2  A l'aide du sélecteur, sélectionnez la région de 
la prise de chaque piste audio à remplacer.

3  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
la sélection d'édition et sélectionnez une 
autre prise de remplacement équivalente 
dans le sous-menu Matches.

– ou –

• Cliquez sur la sélection d'édition en 
maintenant enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) et 
sélectionnez une prise différente à partir du 
menu contextuel Alternates.

La prise sélectionnée remplace la prise 
précédente et se positionne à l'endroit précis sur 
chaque piste.

Automatically Create New 
Playlists When Loop 
Recording
Au cours de l'enregistrement en boucle, 
Pro Tools crée un fichier contenant toutes les 
passes d'enregistrement, dans lequel chaque 
passe d'enregistrement correspond à une région 
du fichier. Sur la piste, seule la dernière passe 
d'enregistrement figure sous forme de région 
dans la playlist principale. Toutes les autres 
régions (passes d'enregistrement) sont 
masquées, mais elles peuvent être rappelées 
comme régions d'emplacement équivalentes 
(prises).

Lorsqu'elle est activée, la nouvelle option 
Automatically Create New Playlists When Loop 
Recording de la boîte de dialogue des préférences 
de fonctionnement, copie automatiquement 
chaque région (prise) sur une nouvelle playlist 
dans la piste. Cela facilité l'utilisation de la vue 
Playlists pour l'coute et la sélection de prises de 
remplacement.

Pour créer automatiquement des playlists lors d'un 
enregistrement en boucle :

1  Sélectionnez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Dans la section Recording, activez l'option 
Automatically Create New Playlists When Loop 
Recording.

3  Cliquez sur OK.
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Développement des prises de 
remplacement aux nouvelles 
playlists ou pistes
Pro Tools vous permet de copier des prises et des 
canaux de remplacement sur les nouvelles 
playlists ou pistes. Cela est particulièrement 
utile pour l'écoute, l'édition et le mixage de 
plusieurs prises ou canaux de remplacement. 
Les prises de remplacement sont créées au cours 
de l'enregistrement fractionné ou en boucle. 
Les canaux de remplacement sont inclus avec 
les fichiers importés dans Pro Tools à partir 
d'enregistreurs portables.

Développement des prises de 
remplacement aux nouvelles 
playlists

Le développement des prises de remplacement 
aux nouvelles playlists facilite la préparation des 
pistes composites. Une fois que vous avez 
étendu les prises de remplacement aux 
nouvelles playlists d'une piste, vous pouvez les 
écouter et les modifier dans la vue Playlists afin 
d'assembler les meilleures prises dans la playlist 
principale.

Pour développer des prises de remplacement sur de 
nouvelles playlists :

1  Identifiez la région de la playlist principale qui 
contient les régions de remplacement 
équivalentes (prises). 

2  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
la région, puis sélectionnez Matches > 
Expand Alternates To New Playlists.

• Si la région est sélectionnée, maintenez la 
touche Ctrl (Windows) ou Pomme (Mac) 
enfoncée, puis cliquez à l'aide du sélecteur 
dans la région sélectionnée et choisissez 
Matches > Expand Alternates To New Playlists.

• Si la région n'est pas sélectionnée, 
maintenez la touche Ctrl (Windows) ou 
Pomme (Mac) enfoncée, puis, à l'aide du 
sélecteur, cliquez précisément au début de 
la plage d'enregistrement en boucle ou 
fractionné et choisissez Matches > Expand 
Alternates To New Playlists.

Toutes les régions de remplacement 
équivalentes sont copiées sur les nouvelles 
playlists de la piste. Pour afficher toutes les 
playlists de la piste, passez en vue Playlists. Dans 
une vue de piste, vous pouvez également 
sélectionner toute playlist de remplacement 
disponible comme playlist principale, depuis le 
sélecteur Playlist.

Développement des prises de 
remplacement aux nouvelles 
pistes

Le développement des prises de remplacement 
sur les nouvelles pistes facilite l'écoute, l'édition 
et le mixage des prises de remplacement, 
chacune situées sur des pistes distinctes.

Pour développer des prises de remplacement sur de 
nouvelles pistes :

1  Identifiez la région de la playlist principale qui 
contient les régions de remplacement 
équivalentes (prises). 

2  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
la région, puis sélectionnez Matches > 
Expand Alternates To New Tracks.
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• Si la région est sélectionnée, maintenez la 
touche Ctrl (Windows) ou Pomme (Mac) 
enfoncée, puis cliquez à l'aide du sélecteur 
dans la région sélectionnée et choisissez 
Matches > Expand Alternates To New Tracks.

• Si la région n'est pas sélectionnée, 
maintenez la touche Ctrl (Windows) ou 
Pomme (Mac) enfoncée, puis cliquez 
précisément, à l'aide du sélecteur, au début 
de la plage d'enregistrement en boucle ou 
fractionné et choisissez Matches > Expand 
Alternates To New Tracks.

3  Sélectionnez ensuite l'une des options 
suivantes dans le sous-menu Expand Alternates 
To New Tracks :

By Track Name Attribue aux nouvelles pistes leur 
nom en fonction du nom de la piste source.

By Region Name Attribue à chaque nouvelle piste 
le nom d'origine de la région correspondante 
qui s'affiche dans la liste Matches.

By Track and Region Name Attribue à chaque 
nouvelle piste le nom de la piste source, mais 
indique le nom d'origine de la région 
correspondante entre parenthèses.

Toutes les régions de remplacement 
équivalentes sont copiées vers de nouvelles 
pistes.

Développement des canaux 
de remplacement aux 
nouvelles playlists ou pistes
Lorsque vous travaillez sur une région mono 
appartenant à un enregistrement multicanaux 
importé d'un enregistreur portable, vous pouvez 
développer cette région (ou une fraction de cette 
région) sur de nouvelles playlists reflétant les 
canaux de remplacement correspondants tout 
en conservant les modifications et les fondus. 

Développement des canaux aux 
nouvelles playlists

Pour développer des canaux de remplacement aux 
nouvelles playlists :

1  Dans la timeline, effectuez l'une des 
opérations suivantes :

• Pour développer uniquement une partie 
des régions de la piste, créez une sélection 
comprenant ou chevauchant le nombre de 
régions souhaité, puis cliquez sur la 
sélection à l'aide du bouton droit de la 
souris (Windows ou Mac) ou en 
maintenant la touche Ctrl enfoncée (Mac).

– ou –

• Pour développer toutes les régions d'une 
piste, cliquez sur le nom de la piste à l'aide 
du bouton droit de la souris (Windows ou 
Mac) ou en maintenant la touche Ctrl 
enfoncée (Mac).
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2  Dans le menu contextuel qui s'affiche, 
sélectionnez la commande Expand to New 
Playlists, puis choisissez la méthode de 
développement des canaux de remplacement de 
la sélection sur les nouvelles pistes :

• By Channel Name

• By Channel Number

• By Channel Name and Number

• By Time Code Only

Si des canaux de remplacement sont 
disponibles, Pro Tools les développe sur de 
nouvelles playlists (y compris le canal représenté 
dans la piste d'origine) en fonction de l'option 
sélectionnée.

Développement de canaux aux 
nouvelles pistes

Pour développer des canaux de remplacement sur 
de nouvelles pistes :

1  Dans la timeline, effectuez l'une des 
opérations suivantes :

• Pour développer uniquement une partie 
des régions de la piste, créez une sélection 
comprenant ou chevauchant le nombre de 
régions souhaité, puis cliquez sur la 
sélection à l'aide du bouton droit de la 
souris (Windows ou Mac) ou en 
maintenant la touche Ctrl enfoncée (Mac).

– ou –

• Pour développer toutes les régions d'une 
piste, cliquez sur le nom de la piste à l'aide 
du bouton droit de la souris (Windows ou 
Mac) ou en maintenant la touche Ctrl 
enfoncée (Mac).

2  Dans le menu contextuel qui s'affiche, 
sélectionnez la commande Expand to New 
Tracks, puis choisissez la méthode de 
développement des canaux de remplacement de 
la sélection sur les nouvelles pistes :

• By Channel Name

• By Channel Number

• By Channel Name and Number

• By Time Code Only

Si des canaux de remplacement sont 
disponibles, Pro Tools les développe sur de 
nouvelles pistes (y compris le canal représenté 
dans la piste d'origine) en fonction des 
paramètres sélectionnés.

Développement des canaux 
par timecode uniquement
La nouvelle commande Expand To New Tracks By 
Time Code Only vous permet de développer la 
totalité d'une piste ou seulement des régions 
sélectionnées, sur la même piste ou sur de 
nouvelles pistes distinctes, affichant ainsi toutes 
les autres régions enregistrées au même 
emplacement de timecode, indépendamment 
du nom ou du numéro de canal. Cela est 
particulièrement utile lorsque vous développez 
des pistes témoins modifiées sur la source audio 
d'origine enregistrée pendant la 
synchronisation sur le time code, mais où les 
noms et numéros de canaux n'ont pas été 
enregistrés dans les fichiers audio. 

Pour plus d'informations concernant le 
fonctionnement de ces différentes options 
lors du développement sur de nouvelles 
pistes, reportez-vous au manuel Field 
Recorder Workflow Guide.

Il n'est pas possible de renommer des 
fichiers codés avec des métadonnées XML. 
L'extension des fichiers sera toujours .A1 et 
.A2 (même pour les fichiers stéréo). 
En outre, il n'est pas possible de renommer 
les fichiers avec un suffixe .L/.R. 
Par conséquent, Pro Tools ne reconnaît pas 
toujours ces canaux comme paire stéréo.
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Exemple pratique : utilisation d'une 
piste témoin

Dans les vidéos de concert en live, la capture 
vidéo est effectuée à part et le contenu audio est 
enregistré dans Pro Tools. Le monteur vidéo 
utilisera une piste audio témoin montée avec la 
vidéo dans son logiciel de montage vidéo (Avid 
Media Composer, par exemple). La piste témoin 
après montage est renvoyée dans Pro Tools, 
mais doit être développée pour être conformée 
aux pistes source d'origine en vue du mixage et 
du mastering.

1  L'audio multipiste est enregistré dans 
Pro Tools pendant la poursuite du time code. Un 
mixage mono ou stéréo est enregistré 
simultanément comme piste témoin pour le 
monteur.

2  Les pistes témoins d'images et audio sont 
montées dans une application de montage vidéo 
(Avid Media Composer par exemple). 

3  Les pistes audio montées sont exportées 
depuis le logiciel de montage vidéo sous forme 
de séquence AAF (ou OMF) et incluent les 
marges d'au moins deux images. 

4  La séquence AAF (ou OMF) est importée dans 
Pro Tools sous forme de nouvelle session.

5  Les fichiers source audio d'origine et la piste 
témoin non modifiée sont également importés 
dans la session.

6  La piste témoin d'origine non modifiée est 
reliée à la session (voir “Rétablissement des liens 
vers la piste témoin d'origine avant montage”, 
page 64).

7  Le monteur Pro Tools clique avec le bouton 
droit de la souris sur la piste témoin et 
sélectionne Expand to New Tracks > By Time Code 
Only. Les pistes source d'origine sont développées 
à de nouvelles pistes avec les fondus et les 
modifications qui correspondent à la piste 
témoin.

Rétablissement des liens vers la piste témoin 
d'origine avant montage

Une fois que vous avez importé la séquence AAF 
(ou OMF) et les fichiers audio source d'origine 
dans la session, il est recommandé de rétablir les 
liens entre la piste témoin montée et l'audio 
source d'origine non modifié.

Pour rétablir les liens vers la piste témoin d'origine 
non modifiée :

1  Ouvrez le navigateur de projets de la session et 
ouvrez le dossier Audio Files. 

2  Dans le navigateur, cliquez avec le bouton 
droit de la souris sur le fichier audio de la piste 
témoin modifiée et choisissez Relink Selected.

3  Dans le volet supérieur de la fenêtre Relink, 
naviguez jusqu'au fichier audio de la piste 
témoin non modifiée que vous avez enregistré 
dans Pro Tools. 

4  Dans le volet Select Files To Relink, 
sélectionnez le fichier de piste témoin modifiée.

5  Faites glisser le fichier audio de la piste témoin 
d'origine non modifiée dans le volet Candidates. 
Si une boîte de dialogue indiquant qu'au moins 
un fichier est plus court que le fichier média 
dont vous essayez de rétablir les liens, cliquez 
surYes pour le sélectionner quand même.

Si le fichier d'origine non modifié n'est pas 
disponible, vous pouvez rétablir les liens 
vers le fichier audio source de votre choix, à 
condition que son timecode de début et de 
fin soit identique à ceux de la piste témoin.
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6  Cochez la case située sur la gauche du fichier 
dans le volet Candidates pour faire apparaître 
l'icône Link. 

7  Cliquez sur Commit Links en haut de la fenêtre 
Relink, puis fermez la fenêtre Relink.

8  Vous pouvez désormais cliquez avec le bouton 
droit de la souris sur le nom du témoin et 
sélectionner Expand To New Tracks > By Time Code 
Only. Toutes les pistes développées sont 
synchrones avec la piste témoin.
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chapitre 6

Fenêtres de l'éditeur MIDI

Pro Tools 8.0 est doté des fenêtres de l'éditeur MIDI qui permettent une édition MIDI approfondie.

Figure 1.  Fenêtre de l'éditeur MIDI
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Pistes MIDI et d'instrument 
superposées

Les fenêtres de l'éditeur MIDI s'affichent et vous 
permettent de modifier des données MIDI 
(notes, vélocités et données de contrôleur 
continu) pour une ou plusieurs pistes MIDI ou 
d'instrument. Lorsque plusieurs pistes sont 
affichées dans la fenêtre de l'éditeur MIDI, les 
notes MIDI de ces différentes pistes sont 
superposées. Les fenêtres de l'éditeur MIDI 
peuvent également afficher les pistes d'entrée 
auxiliaire.

Lignes d'automation et du contrôleur

La vélocité, d'autres données de contrôleur 
continu (pistes MIDI et d'instrument) et les 
données d'automation (pistes d'entrée auxiliaire 
et d'instrument uniquement), peuvent être 
éditées en même temps que les notes MIDI. Elles 
apparaissent dans les lignes du contrôleur sous le 
volet Notes. Les vélocités des notes MIDI de 
différentes pistes sont égalements superposées 
dans la ligne Velocity. Toutefois, pour toutes les 
autres données d'automation et du contrôleur, 
des lignes supplémentaires s'affichent pour 
chaque type d'automation et de contrôleur pour 
chaque piste. 

Par exemple, si deux pistes d'instrument sont 
affichées dans la fenêtre de l'éditeur MIDI, les 
notes MIDI de chaque piste sont superposées 
dans le volet Notes et les vélocités de chaque 
piste sont superposées dans la ligne Velocity. 
Vous pouvez toutefois voir deux lignes de 
contrôleur Mod Wheel, une pour chaque piste, 
et deux lignes Volume, une pour chaque piste 
également.

Ouverture d'une fenêtre de l'éditeur 
MIDI

Pour ouvrir une fenêtre de l'éditeur MIDI, effectuez 
l'une des opérations suivantes :

Choisissez Window > MIDI Editor.

Dans la fenêtre Edit, cliquez avec le bouton 
droit de la souris sur une région MIDI de la piste, 
ou sur le nom de la piste dans les commandes de 
la piste ou la liste des pistes, puis choisissez Open 
In MIDI Editor.

Dans la fenêtre de l'éditeur Score, cliquez avec 
le bouton droit de la souris n'importe où sur le 
score ou sur un nom de piste dans la liste des 
pistes, puis choisissez Open In MIDI Editor.

Pour ouvrir des fenêtres supplémentaires de 
l'éditeur MIDI, effectuez l'une des opérations 
suivantes :

Désélectionnez le bouton Target dans la 
fenêtre de l'éditeur MIDI ouverte et ouvrez une 
autre fenêtre de l'éditeur MIDI.

– ou –

Cliquez avec le bouton droit de la souris dans 
la fenêtre de l'éditeur MIDI ouverte et 
sélectionnez Open in New MIDI Editor.

Appuyez sur Démarrer+"=" (Windows) ou 
Ctrl+"=" (Mac) pour ouvrir une fenêtre de 
l'éditeur MIDI.

Si le paramètre “Double Clicking a MIDI 
Region Opens” dans les préférences MIDI 
Pro Tools est défini sur l'option MIDI 
Editor, vous pouvez cliquer deux fois sur une 
région MIDI pour l'ouvrir dans un éditeur 
MIDI.
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Pour ramener une fenêtre de l'éditeur MIDI ouverte 
au premier plan :

Choisissez Window > MIDI Editors, puis 
sélectionnez la fenêtre de l'éditeur MIDI de votre 
choix.

Barre d'outils de la fenêtre de 
l'éditeur MIDI
La barre d'outils de la fenêtre de l'éditeur MIDI 
est identique à la barre d'outils de la fenêtre Edit. 
Toutes les fenêtres de l'éditeur MIDI et la fenêtre 
Edit peuvent être configurées indépendamment 
les unes des autres. Par exemple, le format 
d'affichage peut être défini sur Notation dans 
l'une des fenêtres de l'éditeur MIDI mais pas 
dans l'autre, ou vous pouvez définir le format 
d'affichage de la fenêtre de l'éditeur MIDI en 
mode Grid, et celui de la fenêtre Edit en mode 
Slip. Vous pouvez également personnaliser la 
barre d'outils des fenêtres de l'éditeur MIDI.

Boutons Solo et Mute

Les boutons Solo et Mute d'une fenêtre de 
l'éditeur MIDI ont une incidence sur les pistes de 
toutes les fenêtres. Ils vous permettent d'écouter 
uniquement les pistes affichées dans la fenêtre 
de l'éditeur MIDI actuelle sans le reste du 
mixage, ou uniquement le mixage sans les pistes 
affichées dans la fenêtre de l'éditeur MIDI.

Solo

Le bouton Solo permet d'écouter en solo toutes 
les pistes actuellement affichées dans la fenêtre 
de l'éditeur MIDI.

Mute

Le bouton Mute permet de couper le son de 
toutes les pistes actuellement affichées dans la 
fenêtre de l'éditeur MIDI.

Combinaison des statuts Mute et Solo

Les boutons Solo et Mute sont des commandes 
générales qui ont une incidence sur toutes les 
pistes affichées dans une fenêtre de l'éditeur 
MIDI. Si, dans la fenêtre Edit, vous mettez en 
solo ou coupez le son de pistes qui sont 
également affichées dans la fenêtre de l'éditeur 
MIDI, l'apparence des boutons Solo et Mute 
change pour indiquer des statuts combinés. 
Des statuts Mute et Solo mixtes se produisent 
lorsqu'une ou plusieurs pistes affichées dans la 
fenêtre de l'éditeur MIDI, mais pas toutes, sont 
mises en solo ou coupées.

Pour parcourir toutes les fenêtres de l'éditeur 
MIDI ouvertes, appuyez plusieurs fois sur 
Démarrer+"=" (Windows) ou Ctrl+"=" 
(Mac) jusqu'à ce que la fenêtre de votre 
choix soit au premier plan.
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Vue Notation

Le bouton de vue Notation permet d'afficher les 
notes MIDI dans la fenêtre de l'éditeur MIDI 
sous forme de notation musicale. En vue 
Notation, les pistes MIDI et d'instrument ne 
sont pas superposées, mais affichées sous forme 
de portées, comme dans la fenêtre de l'éditeur 
Score.

Modes d'édition

Les modes d'édition dans les fenêtres de l'éditeur 
MIDI fonctionnent exactement de la même 
façon pour les données MIDI que dans la fenêtre 
Edit. Les paramètres du mode d'édition sont 
propres à chaque fenêtre de l'éditeur MIDI et 
sont également définis indépendamment de la 
fenêtre Edit.

Outils d'édition

Les outils d'édition des fenêtres de l'éditeur MIDI 
peuvent être affichés comme un outil unique 
avec un menu déroulant permettant de 
sélectionner d'autres outils, ou sous forme d'une 
rangée d'icônes d'outil d'édition complète, 
développée comme dans la fenêtre Edit. 
Les outils d'édition dans les fenêtres de l'éditeur 
MIDI fonctionnent exactement de la même 
façon pour les données MIDI que dans la fenêtre 
Edit. Les paramètres des outils d'édition peuvent 
être définis indépendamment dans chaque 
fenêtre de l'éditeur MIDI et sont indépendants 
de la sélection d'outils dans la fenêtre Edit et 
l'éditeur Score.

Pour afficher la vue développée des outils d'édition 
dans une fenêtre de l'éditeur MIDI, effectuez l'une 
des opérations suivantes :

Cliquez sur le menu de la barre d'outils de la 
fenêtre de l'éditeur MIDI et sélectionnez 
Expanded Edit Tools.

– ou –

Cliquez sur la barre d'outils avec le bouton 
droit de la souris et sélectionnez Expanded Edit 
Tools.

Désélectionnez Expanded Edit Tools pour 
restaurer l'affichage d'une seule icône d'outil 
d'édition avec le menu déroulant Edit Tool.

Vue Notation activée dans une fenêtre de l'éditeur MIDI

En vue Notation, vous pouvez accéder à 
l'option Notation Display Track Settings 
dans une fenêtre de l'éditeur MIDI. 
Sélectionnez l'option Notation Display 
Track Settings dans le menu Track List ou 
cliquez avec le bouton droit de la souris 
dans le volet Notes et sélectionnez l'option 
Notation Display Track Settings dans le 
menu contextuel. Pour plus d'informations, 
reportez-vous à la section “Option Notation 
Display Track Settings”, page 103.
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Commandes d'édition MIDI

Les commandes d'édition MIDI fonctionnent 
exactement de la même façon dans les fenêtres 
de l'éditeur MIDI sur dans la fenêtre Edit.

Track Edit Selector

Si plusieurs pistes MIDI ou d'instrument sont 
affichées dans la fenêtre de l'éditeur MIDI, le 
sélecteur Track Edit permet de sélectionner la 
piste qui peut être modifiée à l'aide du crayon. 
Vous ne pouvez insérer manuellement des notes 
MIDI que dans ce type de pistes. Vous pouvez 
également activer les pistes à modifier à l'aide du 
crayon dans la liste des pistes (reportez-vous à la 
section “Insertion manuelle de notes MIDI”, 
page 82).

Default Note Duration

Le sélecteur Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Default Note On Velocity

Le paramètre Default Note On Velocity permet 
de définir la valeur de vélocité de la note par 
défaut pour les notes insérées manuellement.

Play MIDI Notes When Editing

Lorsqu'elle est activée, cette option déclenche 
un son lorsque vous insérez des notes MIDI à 
l'aide du crayon, que vous cliquez dessus à l'aide 
d'un outil d'accrochage, que vous créez une 
tabulation vers elles ou que vous les sélectionnez 
à l'aide du sélecteur de notes. 

Link Timeline and Edit Selection

Lorsque ce bouton est activé, les selections de 
timeline et d'édition sont liées. Lorsqu'il est 
désactivé, vous pouvez effectuer des sélections 
de timeline et d'édition de manière 
indépendante.

Mirrored MIDI Editing

Cette option permet d'éditer des régions MIDI et 
d'appliquer vos modifications à chaque copie de 
la même région MIDI. Cela s'avère très utile lors 
de l'édition de régions MIDI en boucle.

Commandes d'édition MIDI

Les paramètres globaux Play MIDI Notes 
When Editing, Link Timeline and Edit 
Selection et Mirrored MIDI Editing sont 
disponibles dans la fenêtre Edit, les fenêtres 
de l'éditeur MIDI et la fenêtre de l'éditeur 
Score.

Liaison de la

Default Note Duration

Lecture de notes MIDI en 
Vélocité de note par défaut

Mirrored MIDI Editing

Sélecteur d'édition des pistes

sélection de time-

cours d'édition

line et d'édition

Lorsque le mode Mirrored MIDI Editing est 
désactivé et que vous éditez des notes de 
régions en boucle dans la vue Notes, 
l'édition a pour effet d'aplanir la boucle. 
De la même manière, l'édition de groupes 
de régions a pour effet de séparer les groupes 
de régions.
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Affichage de l’emplacement du 
curseur

L'affichage de l'emplacement du curseur dans les 
fenêtres de l'éditeur MIDI fonctionne 
exactement de la même façon dans les fenêtres 
de l'éditeur MIDI que dans la fenêtre Edit. 

Affichage de la sélection d'édition

L'affichage de la sélection d'édition dans les 
fenêtres de l'éditeur MIDI fonctionne 
exactement de la même façon pour les données 
MIDI dans les fenêtres de l'éditeur MIDI que 
dans la fenêtre Edit. Vous pouvez rendre visible 
ou masquer l'affichage de la sélection dans la 
barre d'outils en sélectionnant ou en 
désélectionnant cette option dans le menu de la 
fenêtre de l'éditeur MIDI.

Sélecteurs Grid et Nudge

Lorsque l'option Expanded Grid/Nudge Display est 
activée dans le menu de la fenêtre de l'éditeur 
MIDI, les sélecteurs Grid et Nudge des fenêtres 
de l'éditeur MIDI fonctionnent exactement de la 
même façon pour les données MIDI dans les 
fenêtres de l'éditeur MIDI que dans la fenêtre 
Edit. 

Lorsque l'option Expanded Grid/Nudge Display est 
désactivée dans le menu de la fenêtre de l'éditeur 
MIDI, vous pouvez basculer entre l'affichage 
Grid et l'affichage Nudge à l'aide du sélecteur 
d'affichage Grid/Nudge.

Target

En générale, le bouton Target des fenêtres de 
l'éditeur MIDI fonctionne de la même façon que 
le bouton Target des fenêtres Plug-in, Output et 
Send. De plus, le bouton Target dans une fenêtre 
de l'éditeur MIDI synchronise son affichage 
d'emplacement de timeline avec l'affichage de 
l'emplacement de timeline dans la fenêtre Edit. 
Toute modification de la sélection d'édition 
dans la fenêtre Edit est répercutée dans la fenêtre 
de l'éditeur MIDI ciblée. Une seule fenêtre de 
l'éditeur MIDI peut être ciblée à la fois. 
La fenêtre de l'éditeur MIDI ciblée peut 
également être stockée dans une configuration 
de fenêtre. 

Une ou plusieurs fenêtres de l'éditeur MIDI non 
ciblées peuvent rester ouvertes et disponibles en 
même temps, tout comme les fenêtres Plug-in 
non ciblées. Le fait de cibler une fenêtre de 
l'éditeur MIDI non ciblée désactive la cible de 
toutes les autres fenêtres de l'éditeur MIDI 
ciblées.

La fenêtre la plus en avant, qu'elle soit ciblée ou 
non, répond aux commandes du menu Edit et 
reçoit un focus clavier sur les commandes et une 
priorité de la surface de contrôle.

A part si le focus des groupes est activé (ou en 
l'absence de focus actif), elle répond également 
aux commandes du menu Edit.

Sélecteur d'affichage Grid/Nudge, en train de 
sélectionner l'affichage Nudge
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Pour activer ou désactiver l'option Target pour une 
fenêtre de l'éditeur MIDI :

Cliquez sur le bouton Target de la fenêtre de 
l'éditeur MIDI afin qu'elle soit mise en 
surbrillance (ciblée) ou non (non ciblée).

Menu de la fenêtre de l'éditeur 
MIDI

Le menu de la fenêtre de l'éditeur MIDI donne 
accès aux options d'affichages de la fenêtre de 
l'éditeur MIDI et aux options de défilement.

Options MIDI Editor Window Display

Expanded Edit Tools

Lorsqu'elle est sélectionnée, l'option Expanded 
Edit Tools permet d'afficher tous les outils 
d'édition dans la barre d'outils de la fenêtre de 
l'éditeur MIDI. 

Si cette option n'est pas sélectionnée, seule 
l'icône de l'outil d'édition sélectionné est 
affichée. Tous les autres outils d'édition peuvent 
être sélectionnés à partir du menu déroulant des 
outils d'édition.

Expanded Grid/Nudge Display

Lorsqu'elle est sélectionnée, cette option affiche 
le sélecteur Nudge en plus du sélecteur Grid 
dans la barre d'outils de la fenêtre de l'éditeur 
MIDI.

Fenêtre de l'éditeur MIDI ciblée

Fenêtre de l'éditeur MIDI non ciblée

Cible activée

Cible désactivée

Barre d'outils d'édition développée affichée dans une 
fenêtre de l'éditeur MIDI

Menu déroulant des outils d'édition

Sélecteurs Grid et Nudge
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Selection Display

Lorsque cette option est sélectionnée, l'affichage 
de sélection d'édition apparaît dans la barre 
d'outils de la fenêtre de l'éditeur MIDI.

Liste des pistes

Lorsqu'elle est sélectionnée, cette option affiche 
la liste des plages dans la fenêtre de l'éditeur 
MIDI.

Scrolling

Le sous-menu Scrolling permet de sélectionner 
les options de défilement pour la fenêtre de 
l'éditeur MIDI indépendamment des autres 
fenêtres de l'éditeur MIDI et de la fenêtre Edit. 
Les options de défilement incluent :

No Scrolling la fenêtre de l'éditeur MIDI ne défile 
ni pendant ni après la lecture. le curseur de 
lecture se déplace dans la fenêtre de l'éditeur 
MIDI, indiquant la position du point de lecture.

After Playback le curseur de lecture se déplace 
dans la fenêtre de l'éditeur MIDI, indiquant la 
position du point de lecture. La fenêtre de 
l'éditeur MIDI défile jusqu'au dernier point lu 
après l'arrêt de la lecture.

Page le curseur de lecture se déplace dans la 
fenêtre de l'éditeur MIDI, indiquant la position 
du point de lecture. Lorsque le bord droit de la 
fenêtre d'édition MIDI est atteint, l'ensemble de 
son contenu défile et le curseur de lecture 
reprend son déplacement depuis le bord gauche 
de la fenêtre.

Continuous (Pro Tools HD et Pro Tools LE avec 
Complete Production Toolkit ou DV Toolkit 2 
uniquement) la fenêtre de l'éditeur MIDI défile en 
continu au-delà du curseur de lecture, qui reste 
au centre de la fenêtre. Avec cette option, la 
lecture repose toujours sur la sélection de la 
timeline (contrairement à ce qui se produit avec 
l'option Center Playhead Scrolling).

Center Playhead (Pro Tools HD uniquement) 
la fenêtre de l'éditeur MIDI défile en continu 
au-delà de la tête de lecture ), matérialisée par une 
ligne bleue située au centre de la fenêtre (rouge 
pendant l'enregistrement).

Follow Edit Window lorsque cette option est 
sélectionnée, la fenêtre de l'éditeur MIDI utilise 
l'option de défilement sélectionnée pour la 
fenêtre Edit (Options > Edit Window Scrolling).

Barre d'outils personnalisable

Vous pouvez personnaliser la barre d'outils dans 
les fenêtres de l'éditeur MIDI en réorganisant les 
commandes et affichages disponibles et en 
activant ou en désactivant leur visibilité, de la 
même façon que dans la fenêtre Edit ou dans la 
fenêtre de l'éditeur Score.

Options d'affichage de la barre d'outils

Pour modifier les options d'affichage la barre 
d'outils d'une fenêtre de l'éditeur MIDI :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la barre d'outils de 
la fenêtre de l'éditeur MIDI.

– ou –

• Cliquez avec le bouton droit de la souris 
dans la barre d'outils.

Affichage de sélection



Chapitre 6 : Fenêtres de l'éditeur MIDI 75

2  Dans le menu contextuel qui s'affiche, 
sélectionnez ou désélectionnez l'une des options 
suivantes :

• Expanded Edit Tools

• Expanded Grid/Nudge Display

• Selection Display

Redisposition des commandes et des 
affichages

Vous pouvez redisposer les commandes et les 
affichages dans la barre d'outils de la fenêtre de 
l'éditeur MIDI de la même façon que dans la 
fenêtre Edit ou la fenêtre de l'éditeur Score.

Pour redisposer les commandes et affichages de la 
barre d'outils de la fenêtre de l'éditeur MIDI :

Cliquez tout en maintenant enfoncée la 
touche Ctrl (Windows) ou Pomme (Mac) sur les 
commandes ou affichages à déplacer, puis faites-
les glisser à l'emplacement de votre choix sur la 
barre d'outils.

Commandes de zoom

Boutons de zoom avant/arrière horizontal et 
vertical

Outre les commandes de zoom de la barre 
d'outils, Pro Tools comprend des boutons de 
zoom vertical et horizontal dans l'angle inférieur 
droit des fenêtres de l'éditeur MIDI. 

Boutons de zoom vertical Effectue un zoom 
proportionnel sur les hauteurs de ligne pour les 
lignes Automation et Controller.

Boutons de zoom horizontal Effectue un zoom sur 
la timeline de la même façon que les 
commandes de zoom horizontal de la barre 
d'outils de la fenêtre de l'éditeur MIDI.

Boutons de zoom avant/arrière MIDI 

Pro Tools fournit également des boutons de 
zoom avant et arrière MIDI, dans l'angle 
supérieur droit des fenêtres de l'éditeur MIDI. 
Ces boutons fonctionnent de la même façon 
que les commandes de zoom MIDI de la barre 
d'outils et vous permettent d'effectuer un zoom 
avant ou arrière verticalement sur des notes 
MIDI.

Boutons de zoom 

Boutons de zoom avant/arrière horizontal

arrière/avant 
vertical

Boutons de zoom 
avant/arrière MIDI 
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Liste des pistes
La liste des pistes des fenêtres de l'éditeur MIDI 
vous permettent d'afficher ou de masquer les 
pistes MIDI, d'instrument et d'entrée auxiliaire 
dans la fenêtre de l'éditeur MIDI. Les paramètres 
de la liste des pistes sont uniques pour chaque 
fenêtre de l'éditeur MIDI. Cependant, l'ordre des 
pistes dans la liste des pistes est global. Le tri ou 
la modification de l'ordre des pistes affecte la 
liste des pistes dans chaque fenêtre.

Colonnes de la liste des pistes

Les fenêtres de l'éditeur MIDI comportent quatre 
colonnes consacrées à la liste des pistes : 

Afficher/Masquer indique quelles pistes sont 
affichées ou masquées dans la fenêtre de 
l'éditeur MIDI.

Track Color: affiche la couleur de chaque piste 
par type ou par piste.

Name affiche le nom de chaque piste.

Pencil vous permet d'activer une piste pour la 
saisie manuelle des notes MIDI à l'aide du 
crayon.

Menu Track List

Le menu Track List vous permet d'afficher ou de 
masquer les pistes MIDI, d'instrument et 
d'entrée auxiliaire dans la fenêtre de l'éditeur 
MIDI (voir “Affichage et masquage des pistes”, 
page 76). 

Le menu Track List vous permet également de 
trier les pistes dans la liste des pistes en fonction 
de leur nom, type, groupe d'édition, groupe de 
mixage ou voix (voir “Tri des pistes dans la liste 
des pistes”, page 77).

Affichage et masquage des pistes

Pour afficher les pistes MIDI, d'instrument et 
d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

Cliquez sur l'icône Afficher/Masquer pour les 
pistes de la liste des pistes que vous voulez 
afficher dans la fenêtre de l'éditeur MIDI.

Pour afficher toutes les pistes MIDI, d'instrument et 
d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

Dans le menu Track List, choisissez Show All 
Tracks.

Pour afficher uniquement les pistes MIDI, 
d'instrument et d'entrée auxiliaire sélectionnées 
dans une fenêtre de l'éditeur MIDI :

1  Dans la liste des pistes, sélectionnez les pistes 
MIDI, d'instrument et d'entrée auxiliaire à 
afficher dans la fenêtre de l'éditeur MIDI.

2  Dans le menu Track List, choisissez Show Only 
Selected Tracks.

Pour afficher toutes les pistes d'un même type 
(MIDI, instrument ou entrée auxiliaire) dans une 
fenêtre de l'éditeur MIDI :

Dans le menu Track List, choisissez Show Only, 
puis sélectionnez le type de piste souhaité.

Liste des pistes

Menu Track List

Nom de la piste
Icône du type de piste

Code couleur de la piste
Track Show/Hide

Activation à l'aide du crayon



Chapitre 6 : Fenêtres de l'éditeur MIDI 77

Pour afficher les pistes MIDI, d'instrument et 
d'entrée auxiliaire dans une fenêtre de l'éditeur 
MIDI :

Cliquez sur l'icône Afficher/Masquer pour les 
pistes de la liste des pistes que vous voulez 
masquer dans la fenêtre de l'éditeur MIDI.

Pour masquer toutes les pistes MIDI, d'instrument 
et d'entrée auxiliaire (sauf une) dans une fenêtre de 
l'éditeur MIDI :

Dans le menu Track List, choisissez Hide All 
Tracks. 

Toutes les pistes de la liste des pistes sont 
masquées à part la première piste MIDI ou 
d'instrument. Au moins une piste MIDI ou 
d'instrument doit être visible dans les fenêtres 
de l'éditeur MIDI.

Pour afficher les pistes MIDI, d'instrument et 
d'entrée auxiliaire sélectionnées dans une fenêtre 
de l'éditeur MIDI :

1  Dans la liste des pistes, sélectionnez les pistes 
MIDI, d'instrument et d'entrée auxiliaire à 
masquer.

2  Dans le menu Track List, choisissez Hide 
Selected Tracks.

Pour masquer toutes les pistes d'un même type 
(MIDI, instrument ou entrée auxiliaire) :

Dans le menu Track List, choisissez Hide Only, 
puis sélectionnez le type de piste souhaité.

Tri des pistes dans la liste des pistes

Vous pouvez effectuer un tri de l'ordre des pistes 
en fonction des critères suivants :

Name Trie l'ordre des pistes de la liste des pistes 
en fonction du nom de piste.

Type Trie l'ordre des pistes de la liste des pistes en 
fonction du type de piste.

Edit Group Trie l'ordre des pistes de la liste des 
pistes en fonction des groupes d'édition.

Mix Group Trie l'ordre des pistes de la liste des 
pistes en fonction des groupes de mixage.

Voice Trie l'ordre des pistes de la liste des pistes 
en fonction des allocations de voix.

Menu contextuel Track List

Outre les commandes de gestion des pistes 
habituelles, le menu contextuel Track List a des 
commandes en commun avec les menus de la 
liste des pistes et du volet des notes.

Pour accéder au menu contextuel Track List de 
l'éditeur MIDI :

Cliquez avec le bouton droit de la souris sur 
un nom de piste dans la liste des pistes.

Options du menu contextuel Track List

Les options suivantes sont disponibles en 
fonction du type de piste (entrée auxiliaire, 
instrument ou MIDI).

Hide Masque la piste sélectionnée.

Hide and Make Inactive Masque la piste 
sélectionnée et la rend inactive.

Make Inactive Rend la piste sélectionnée 
inactive.

Export MIDI Exporte la piste sélectionnée en tant 
que fichier MIDI.

New Ouvre la boîte de dialogue New Track.

Rename Renomme la piste sélectionnée.

Duplicate Duplique la piste sélectionnée.

Split into Mono Divise la piste d'instrument ou 
d'entrée auxiliaire stéréo sélectionnée en deux 
pistes mono.
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Delete Supprime la piste sélectionnée.

Propriétés MIDI en temps réel Ouvre la fenêtre 
MIDI Real-Time Properties pour la piste 
sélectionnée.

Open in New MIDI Editor Ouvre les pistes 
affichées dans la fenêtre actuelle de l'éditeur 
MIDI dans une nouvelle fenêtre de l'éditeur 
MIDI. La nouvelle fenêtre de l'éditeur MIDI sera 
non ciblée.

Open in Score Editor Ouvre les pistes affichées 
dans la fenêtre de l'éditeur Score.

Open in MIDI Event List Ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Option Notation Display Track Settings Ouvre la 
fenêtre Notation Display Track Settings.

Liste de groupes
La liste des groupes dans les fenêtres de l'éditeur 
MIDI fonctionne de la même façon que dans la 
fenêtre Edit. Vous pouvez créer, modifier et 
supprimer des groupes d'édition à l'aide de la 
liste des groupes de n'importe quelle fenêtre de 
l'éditeur MIDI. La liste des groupes est liée entre 
la fenêtre Edit et toutes les fenêtres de l'éditeur 
MIDI.

Règles temporelles et de chef 
d'orchestre
Les règles temporelles et de chef d'orchestre de 
l'éditeur MIDI fonctionnent exactement de la 
même façon que dans la fenêtre Edit. 
Cependant, la fenêtre Edit et chaque fenêtre de 
l'éditeur MIDI peuvent présenter une vue 
unique de la timeline en fonction de la visibilité 
des règles temporelles et de chef d'orchestre et 
en termes de niveau de zoom et d'emplacement 
temporel. 

Lorsque la fonction Scrolling est activée, seule la 
fenêtre de premier plan est mise à jour au cours 
de la lecture. Toutes les autres fenêtres 
conservent leur dernière vue de timeline. 

En outre, la fenêtre Edit et chaque fenêtre de 
l'éditeur MIDI peuvent afficher différentes 
combinaisons de règle temporelle et de règle de 
chef d'orchestre, indépendamment l'une de 
l'autre.

Pour plus d'informations sur le 
regroupement des pistes dans Pro Tools 8.0, 
reportez-vous au Guide de référence 
Pro Tools (Help > Pro Tools 
Reference Guide).
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Vue des notes superposées
Le volet Notes des fenêtres de l'éditeur MIDI 
vous permet d'afficher et de modifier les notes 
MIDI superposées de différentes pistes MIDI et 
d'instrument, afin de vous permettre de 
modifier facilement des arrangements 
multipistes dans une seule constellation de 
notes codées par des couleurs. Le volet Notes 
vous permet de modifier des notes MIDI de la 

même façon que dans la vue Notes sur les pistes 
MIDI et d'instrument de la fenêtre Edit, à la 
différence que vous pouvez modifier des notes 
MIDI sur plusieurs pistes MIDI et d'instrument 
simultanément.

Vous pouvez également afficher et modifier 
des notes MIDI dans la vue Notation du volet 
Notes (voir “Vue Notation”, page 84).

Figure 2.  Fenêtre de l'éditeur MIDI, volet Notes avec cinq pistes d'instrument superposées
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Codage couleur des notes MIDI

Il est possible d'appliquer un codage couleur aux notes MIDI selon la piste, le type de piste ou la 
vitesse.

Color Coding by Track

Lorsque l'option Color Coding by Track est activée, les notes MIDI de la même piste sont de la même 
couleur, mais les notes d'autres pistes sont représentées par des couleurs différentes. Le codage couleur 
correspondant pour les notes MIDI s'affiche dans la colonne Color de la liste des pistes, pour chaque 
piste. Pour plus d'informations, reportez-vous à la section figure 3, page 80.

Pour appliquer un codage couleur aux notes MIDI en fonction de la piste :

Activez le bouton Color Code MIDI Notes By Track.

Color Coding by Velocity

Lorsque l'option Color Coding by Velocity est activée, les notes MIDI sont toutes de la même couleur 
rouge (teinte) sur toutes les pistes affichées et elles présentent des saturations de couleur différentes 
(du rouge clair au rouge foncé) qui varient en fonction de la vitesse de la note. Plus la vélocité est 
faible, plus la note s'affiche dans un ton clair et plus la note est rapide, plus elle est foncée. Pour plus 
d'informations, reportez-vous à la section figure 4, page 81.

Figure 3.  Fenêtre de l'éditeur MIDI, codage couleur des notes selon la piste

Option Color Code MIDI Notes by Track activée
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Pour appliquer un codage couleur aux notes MIDI en fonction de la vélocité :

Activez le bouton Color Code MIDI Notes By Velocity.

No Color Coding

Lorsque vous n'avez activé ni l'option Color Coding by Track ni Color Coding by Velocity, les notes 
sont dessinées dans l'éditeur MIDI de la même couleur que dans la fenêtre Edit, en utilisant les mêmes 
options de codage couleur que celles définies dans les paramètres Track Color Coding des préférences 
d'affichage.

Figure 4.  Fenêtre de l'éditeur MIDI, codage couleur des notes selon la vélocité

Option Color Code MIDI Notes By Velocity activée

Figure 5.  Fenêtre de l'éditeur MIDI, sans codage couleur

Option No Color Coding activée
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Edition des notes MIDI

Vous pouvez modifier n'importe quelle note 
affichée dans le volet Notes. L'édition des notes 
MIDI dans le volet Notes fonctionne comme 
dans la vue Notes pour les pistes MIDI et 
d'instrument dans la fenêtre Edit, à la différence 
que les notes de différentes pistes sont 
superposées. 

Insertion manuelle de notes MIDI

A l'aide du crayon, vous pouvez insérer 
manuellement des notes MIDI sur toutes les 
pistes modifiables à l'aide du crayon affichées 
dans le volet Notes. Si une seule piste est affichée 
dans la fenêtre de l'éditeur MIDI, cette piste est 
automatiquement modifiable à l'aide du crayon. 
Si plusieurs pistes superposées sont affichées 
dans le volet Notes, les notes MIDI seront 
insérées uniquement sur les pistes modifiables à 
l'aide du crayon.

Pour insérer des notes MIDI sur une piste spécifique 
du volet Notes :

1  Effectuez l'une des opérations suivantes :

• Sélectionnez la piste que vous voulez 
rendre modifiable à l'aide du crayon dans le 
sélecteur d'édition de piste de la barre 
d'outils.

– ou –

• Cliquez sur la colonne Pencil de la liste des 
pistes pour rendre modifiable à l'aide du 
crayon la piste de votre choix.

2  A l'aide du crayon, cliquez à l'emplacement 
temporel et de hauteur souhaité pour insérer 
une note MIDI sur la piste modifiable à l'aide du 
crayon, avec la vélocité de note par défaut et la 
durée Default Note Duration sélectionnée.

Sélection d'une piste pour l'édition

Seules les pistes actuellement affichées dans 
la fenêtre de l'éditeur MIDI sont disponibles 
dans le menu contextuel du sélecteur 
d'édition de pistes.

Piste “Blad Pad Midi” modifiable à l'aide de l'outil 
Crayon

Insertion d'une note MIDI sur la piste “Inst 3” 

2 pistes MIDI et 1 piste d'instrument affichée

piste modifiable à l'aide du crayon
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Menu contextuel du volet Notes

Le menu contextuel du volet Notes fournit 
plusieurs commandes utiles pour l'édition, 
l'exportation et l'affichage des données MIDI.

Pour accéder au menu contextuel de l'éditeur MIDI :

Clique avec le bouton droit de la souris dans le 
volet Notes.

Options du menu contextuel du volet 
Notes

Tools

Le sous-menu Tools vous permet de sélectionner 
des outils d'édition appropriés pour l'éditeur 
Score.

Zoomer Sélectionne l'outil de zoom.

Trimmer Sélectionne l'outil de trimming.

Selector Sélectionne le sélecteur.

Grabber Sélectionne l'outil Main.

Scrubber Sélectionne l'outil de scrubbing.

Pencil Sélectionne le crayon.

Smart Sélectionne l'outil Smart.

Outils de zoom Vous permet de choisir entre le 
mode normal et Single Zoom.

Outils Crayon Vous permet de sélectionner l'outil 
Crayon de votre choix.

Insert

Le sous-menu Insert vous permet d'insérer des 
changements de tonalité, changements de 
métrique et des symboles d'accords à 
l'emplacement du curseur d'édition.

Key Insère un changement de tonalité.

Meter Insère un changement de métrique.

Chord Insère un symbole d'accord.

Cut

La commande Cut coupe la sélection d'édition 
active.

Copy

La commande Copy copie la sélection d'édition 
active.

Paste

La commande Paste colle le contenu du presse-
papiers dans la sélection d'édition ou à 
l'emplacement du curseur d'édition actuel. 
Toute note MIDI figurant déjà au même 
emplacement est remplacée.

Merge

La commande Merge colle le contenu du presse-
papiers dans la sélection d'édition ou à 
l'emplacement du curseur d'édition actuel et 
fusionne les données collées avec les notes MIDI 
déjà présentes au même emplacement.

Pour rendre modifiables à l'aide du crayon 
plusieurs pistes contiguës, cliquez en 
maintenant la touche Maj enfoncée sur la 
colonne Pencil de la plage de pistes de votre 
choix. Pour rendre modifiables à l'aide du 
crayon plusieurs pistes discontinues, cliquez 
dans la colonne Pencil de chaque piste 
sélectionnée tout en maintenant la touche 
Ctrl (Windows) ou la touche Pomme (Mac). 
Pour rendre toutes les pistes modifiables à 
l'aide du crayon, maintenez la touche Alt 
(Windows) ou Option (Mac) enfoncée. Les 
notes insérées manuellement sont écrites sur 
toutes les pistes modifiables à l'aide du 
crayon.
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Clear

La commande Clear efface (supprime) la 
sélection d'édition active.

Separate

La commande Separate vous permet de séparer 
les notes MIDI à l'emplacement du curseur 
d'édition.

Consolidate

La commande Consolidate vous permet de 
regrouper plusieurs notes MIDI consécutives 
sélectionnées à la même hauteur.

Mute Notes

La commande Mute Notes (ou Unmute Notes) 
vous permet de couper le son (ou de rétablir le 
son) de notes MIDI sélectionnées.

Propriétés MIDI en temps réel

Lorsque vous sélectionnez l'option MIDI Real-
Time Properties, la fenêtre MIDI Real-Time 
Properties s'ouvre.

Event Operations

Le sous-menu Event Operations vous permet de 
sélectionner l'une des fenêtres Event Operations 
(par exemple, Quantize ou Change Velocity).

Open In New MIDI Editor

Lorsque vous sélectionnez l'option Open In New 
MIDI Editor, toutes les pistes affichées s'ouvrent 
dans une nouvelle fenêtre d'éditeur MIDI.

Open In Score Editor

L'option Open In Score Editor ouvre les pistes 
affichées dans la fenêtre de l'éditeur Score.

Open in MIDI Event List

L'option Open In MIDI Event List ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Display Notation

Lorsque vous sélectionnez l'option Display 
Notation, l'éditeur MIDI passe en vue Notation. 
Si vous désélectionnez cette option, l'éditeur 
MIDI revient à la vue Notes.

Vue Notation
Le volet Notes de l'éditeur MIDI peut aussi 
afficher les notes MIDI sous forme de notation 
musicale standard. En vue Notation, chaque 
piste MIDI et d'instrument s'affiche 
indépendamment, avec une piste par portée 
(double portée, aigus, basse, alto ou ténor). Dans 
les fenêtres de l'éditeur MIDI, la notation est 
représentée sous forme de timeline continue et 
non sous forme de page, comme c'est le cas dans 
la fenêtre de l'éditeur Score. 

Pour activer la vue Notation, procédez comme suit :

 Activez le bouton de vue Notation dans la 
barre d'outils de la fenêtre de l'éditeur MIDI.

– ou –

Cliquez avec le bouton droit de la souris dans 
le volet Notes et sélectionnez Notation View.

Pour plus d'informations sur l'édition des 
notations, voir “Edition des notes”, 
page 107.

Vue Notation activée dans une fenêtre de l'éditeur MIDI
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L'édition en vue Notation dans une fenêtre de 
l'éditeur MIDI fonctionne de la même façon que 
dans la fenêtre de l'éditeur Score, mais avec 
l'avantage d'avoir accès aux lignes Velocity, 
Controller et Automation. 

Remarquez qu'en vue Notation, l'outil de 
trimming fonctionne de la même façon que 
l'outil Main lorsqu'il passe au-dessus d'une 
note et de la même façon que le sélecteur de 
notes lorsqu'il n'est pas au-dessus d'une 
note.

En vue Notation, le mode d'édition est 
défini automatiquement sur Grid et vous ne 
pouvez pas le modifier.

Figure 6.  Fenêtre de l'éditeur MIDI, volet Notes en vue Notation
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Double Bar

Le bouton Double Bar est uniquement 
disponible en vue Notation. Lorsqu'elle est 
activée, l'option Double Bar affiche la double 
barre de mesure finale dans la fenêtre de 
l'éditeur MIDI. La double barre est située à la fin 
de la dernière région ou du dernier événement 
MIDI de la session.

Lorsque l'option Double Bar est désactivée, un 
certain nombre de barres vides apparaît à la fin 
du dernier événement de la session. Le nombre 
de barres vides est déterminé par le paramètre 
Additional Empty Bars In The Score Editor dans la 
page des préférences MIDI (Setup > Preferences). 
Désactivez l'option Double Bar pour saisir 
manuellement des notes dans l'éditeur Score 
après la dernière région ou le dernier événement 
MIDI de la session.

Menu contextuel de la vue 
Notation

Lorsque vous êtes en vue Notation, le menu 
contextuel du volet Notes fournit des options 
légèrement différentes de celles de la vue des 
notes superposées. 

Les options suivantes sont disponibles dans les 
deux vues :

• Tools

• Insert

• Cut

• Copy

• Paste

• Clear

• Separate

• Consolidate

• Mute

• Propriétés MIDI en temps réel

• Event Operations

• Open In New MIDI Editor

• Open In Score Editor

• Open In MIDI Event List

• Display Notation

En vue Notation, l'option Notation Display Track 
Settings supplémentaire est disponible dans le 
menu contextuel. Sélectionnez cette option 
pour ouvrir la boîte de dialogue Notation 
Display Track Settings et configurer les 
paramètres d'affichage des pistes en vue 
Notation. Pour plus d'informations sur la boîte 
de dialogue Notation Display Track Settings, 
voir “Option Notation Display Track Settings”, 
page 103.

Double barre activée dans une fenêtre de l'éditeur MIDI

Double Bar
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Lignes de vélocité, du 
contrôleur et d'automation
Les fenêtres de l'éditeur MIDI vous permettent 
de modifier les vélocités, les données du 
contrôleur MIDI et l'automation pour toutes les 
pistes MIDI, d'instrument et d'entrée auxiliaire 
dans les lignes placées sous le volet Notes. 
Vous pouvez déplacer et redimensionner les 
lignes d'automation et du contrôleur de la 
même façon que dans la fenêtre Edit.

Lorsque vous affichez plusieurs pistes MIDI et 
d'instrument, les vélocités des notes placées sur 
des pistes distinctes sont superposées sur une 
seule ligne, comme les notes du volet Notes. 

Cependant, toutes les autres lignes de 
contrôleur sont groupées par automation et type 
de contrôleur et fournissent des lignes 
individuelles pour chaque piste affichée.

Pour afficher ou masquer des lignes sous le volet 
Notes :

Cliquez sur le bouton d'affichage/de 
masquage des lignes.

Pour ajouter des lignes :

Cliquez sur le bouton Add Lane.

Pour supprimer des lignes :

Cliquez sur le bouton Remove Lane.

Figure 7.  Lignes de vélocité, de contrôleur et d'automation pour deux pistes d'instrument stéréo

Afficher/Masquer

Ligne vélocité
(2 pistes superposées)

Supprimer la piste
Ajouter la piste

Lignes d'automation 
associées pour des 
pistes distinctes

Sélecteur de type 
de contrôleur/
d'automation

les lignes
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Commandes et améliorations 
supplémentaires pour 
l'édition MIDI
Pro Tools 8.0 comprend de nombreuses 
nouveautés et améliorations en matière 
d'édition MIDI. Ces commandes et 
améliorations fonctionnent à la fois dans les 
fenêtres de l'éditeur MIDI et dans la fenêtre Edit 
sur les pistes MIDI et d'instrument dans les vues 
Notes et Regions.

Séparation des notes MIDI

La commande Separate permet de séparer les 
notes MIDI au niveau de la position du curseur 
d'édition ou des limites de la sélection d'édition. 
En vue Notes dans la fenêtre Edit et dans les 
fenêtres de l'éditeur MIDI, la séparation de 
régions MIDI crée des notes MIDI, mais pas de 
régions MIDI. Toutefois, en vue Regions dans la 
fenêtre Edit, la séparation des régions MIDI crée 
uniquement des régions MIDI. De même, si la 
sélection d'édition inclut des pistes audio, la 
commande Separate sépare uniquement les 
régions des pistes MIDI et d'instrument, quels 
que soient les paramètres d'affichage de piste.

Pour séparer des notes MIDI au niveau de la 
position du curseur ou des limites de la sélection 
d'édition :

1  Effectuez une sélection d'édition ou placez le 
curseur d'édition à l'endroit où vous souhaitez 
séparer une ou plusieurs notes MIDI.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Separate > At Selection.

– ou –

• Cliquez avec le bouton droit de la souris 
dans le volet Notes et sélectionnez 
Separate.

Pour séparer les notes MIDI sur la grille :

1  Définissez la grille comme vous le souhaitez.

2  Effectuez une sélection d'édition ou définissez 
un rectangle de sélection qui inclut les notes 
MIDI que vous souhaitez séparer.

3  Choisissez Edit > Separate > On Grid.

4  Dans la boîte de dialogue Pre-Separate 
Amount, cliquez sur OK.

Outils de séparation et de consolidation des 
notes MIDI

En vue Notes dans la fenêtre Edit et les fenêtres 
de l'éditeur MIDI, le crayon et les outils 
d'accrochage peuvent être utilisés pour séparer 
et pour consolider les notes MIDI. Le curseur se 
met à jour pour afficher un "couteau" pour 
l'outil Separate et un "bandage" pour l'outil 
Consolidate.

Appuyez sur Control+E (Windows) ou 
Pomme+E (Mac) pour séparer les notes 
MIDI à l'emplacement de la sélection.
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Pour séparer une note MIDI avec l'outil de 
séparation :

A l'aide de l'outil d'accrochage ou du crayon, 
maintenez-enfoncées les touches Démarrer+Maj 
(Windows) ou Pomme+Maj (Mac) et cliquez sur 
la note MIDI à l'endroit où vous voulez effectuer 
la séparation.

Pour consolider des notes MIDI à l'aide de l'outil de 
consolidation :

A l'aide de l'outil d'accrochage ou du crayon, 
maintenez enfoncées les touches Démarrer+Maj 
(Windows) ou Pomme+Maj (Mac) et cliquez 
entre les notes MIDI séparées.

Consolidation des notes MIDI

La commande Consolidate permet de combiner 
au moins deux notes MIDI consécutives de la 
même hauteur en une seule note MIDI.

Pour consolider des notes MIDI :

1  Sélectionnez les notes MIDI à consolider.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Consolidate.

– ou –

• Cliquez avec le bouton droit de la souris sur 
les notes sélectionnées et sélectionnez 
Consolidate.

Note MIDI séparée en deux à l'aide de l'outil de 
séparation

Outil de séparation

Consolidation de notes MIDI en une seule note à l'aide 
de l'outil de consolidation

Outil de consolidation
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Coupures de notes MIDI

La commande Mute permet de couper le son de 
notes MIDI individuelles. Si des régions entières 
sont sélectionnées, la commande Mute vous 
invite à couper le son de régions ou de notes 
MIDI.

Pour couper le son d'une ou plusieurs notes MIDI :

1  Sélectionnez les notes MIDI auxquelles couper 
le son.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Mute Notes.

– ou –

• Cliquez avec le bouton droit de la souris sur 
les notes MIDI et sélectionnez Mute Notes.

Pour rétablir le son d'une ou plusieurs notes MIDI :

1  Sélectionnez les notes MIDI auxquelles rétablir 
le son.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Unmute Notes.

– ou –

• Cliquez avec le bouton droit de la souris sur 
les notes MIDI sélectionnées et 
sélectionnez Mute Notes.

Application du scrubbing et du mode 
Shuttle aux contenus MIDI 

Lorsque vous effectuez un scrubbing et 
appliquez le mode Shuttle à des notes MIDI, 
celles-ci sont lues. Une note MIDI sera audible 
tant que l'emplacement de scrub ou de shuttle 
est situé entre les limites Note On et Note Off de 
la note MIDI. Lorsque les fonctions de scrub ou 
de shuttle sont appliquées vers l'arrière, 
l'emplacement Note Off de la note MIDI 
déclenche la lecture de la note MIDI en utilisant 
le paramètre MIDI Note On Velocity.

Ecoute des modifications de vélocité

Lorsque vous modifiez les vélocités des notes 
MIDI à l'aide de l'outil Main, Pro Tools joue la 
note à la nouvelle vélocité. Vous pouvez ainsi 
entendre lorsque vous obtenez le paramètre de 
vélocité souhaité pour une note MIDI.

Tabulation et lecture de notes MIDI

Lors d'une tabulation vers des notes MIDI, 
chaque note MIDI est lue si le mode Play MIDI 
Notes While Editing est activé.

Sélecteur de notes

En vue Notes ou Velocity de pistes MIDI et 
d'instrument dans la fenêtre Edit ou dans une 
fenêtre de l'éditeur MIDI, le sélecteur effectue 
une sélection de plage temporelle qui inclut tous 
les types d'événements MIDI en plus des notes et 
vélocités MIDI (tels que les changements de 
programme et les données de contrôleur 
continu). Le sélecteur de notes peut être utilisé 
pour sélectionner uniquement les notes et 
vélocités MIDI dans une sélection de plage 
temporelle. 

Maintenez les touches Alt+Maj+3 
(Windows) ou Option+Maj+3 (Mac) pour 
consolider les notes MIDI adjacentes 
sélectionnées de la même hauteur.

Appuyez sur Control+M (Windows) ou 
Pomme+M (Mac) couper ou rétablir le son 
des notes MIDI sélectionnées.
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Pour sélectionner uniquement des notes et 
vélocités MIDI avec le sélecteur de notes :

1  Sélectionnez le sélecteur.

2  Sur des pistes MIDI ou d'instrument dans la 
fenêtre Edit en vue Notes ou Velocity ou dans 
une fenêtre de l'éditeur MIDI, cliquez en 
maintenant enfoncée la touche Alt (Windows) 
ou Option (Mac) sur la plage de temps qui 
contient les notes que vous voulez sélectionner, 
puis faites-la glisser.

Lorsque vous utilisez l'outil Smart et que vous 
appuyez sur Alt (Windows) ou Option (Mac), le 
sélecteur est disponible dans la partie supérieure 
de la piste et le sélecteur de notes dans la partie 
inférieure de la piste. 

En outre, l'outil Smart s'ouvre désormais par 
défaut sur le rectangle de sélection lorsqu'il n'est 
pas au-dessus d'une note.

Sélection de notes MIDI uniquement à l'aide du 
sélecteur de notes
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chapitre 7

Fenêtre de l'éditeur Score

La fenêtre de l'éditeur Score vous permet d'afficher, de modifier, de redisposer et d'imprimer du 
contenu MIDI de votre session, sous forme de notation musicale. Que vous réalisiez un 
enregistrement, une importation, un dessin (avec l'outil Crayon) ou une saisie à l'aide de la fonction 
Step Enter de contenu MIDI, l'éditeur Score transcrit les notes MIDI en temps réel. 

Figure 8.  Fenêtre de l'éditeur Score

Outils d'édition

Default Note Duration

Liste des pistes
Commandes de page Commandes de zoom

Sélecteur GridEmplacement du curseur Target

Lecture de notes MIDI en cours d'édition
Mirrored MIDI Editing

Double Bar

Vélocité de note par défaut

Menu de l'éditeur Score

Selection

Link Edit and Timeline Selection
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Ouverture de la fenêtre de l'éditeur 
Score

Pour ouvrir la fenêtre de l'éditeur Score :

Choisissez Window > Score Editor.

Pour ouvrir la fenêtre de l'éditeur Score avec une 
seule piste MIDI ou d'instrument visible :

1  Vérifiez qu'il n'y a aucune sélection d'édition.

2  Cliquez avec le bouton droit de la souris sur le 
nom d'une piste non sélectionnée de la fenêtre 
Edit ou Mix, ou dans la liste de pistes des 
fenêtres Edit, Mix ou de l'éditeur MIDI.

3  Dans le menu contextuel, choisissez Open In 
Score Editor.

Pour ouvrir la fenêtre de l'éditeur Score avec la 
sélection d'édition en cours affichée :

1  Dans la fenêtre Edit ou dans une fenêtre de 
l'éditeur MIDI, sélectionnez pour édition une ou 
plusieurs pistes qui incluent ce que vous voulez 
afficher dans la fenêtre de l'éditeur Score.

2  Cliquez avec le bouton droit de la souris sur la 
sélection d'édition, puis choisissez Open In Score 
Editor.

Outils d'édition

Les outils d'édition de la fenêtre de l'éditeur 
Score fonctionnent de la même façon que dans 
la fenêtre Edit, à quelques différences près au 
niveau de l'édition de la notation musicale.

Zoom

Le Zoom permet d'effectuer un zoom avant et 
arrière dans une zone particulière de la partition. 

Il comporte deux modes : 

Zoom normal La fonction Zoom reste 
sélectionnée même après le zoom effectué. 

Zoom simple L'outil d'édition précédemment 
sélectionné est automatiquement resélectionné 
une fois le zoom effectué.

Mode zoom normal

Pour effectuer un zoom autour d'un point particulier 
de la partition :

1  Cliquez dans le menu déroulant du Zoom et 
sélectionnez le mode Normal Zoom.

2  Cliquez une fois avec l'outil de zoom sur un 
point de la partition. Un zoom avant d'un 
niveau est effectué sur la partition, centré autour 
de la zone d'application du zoom.

3  Pour revenir au niveau de zoom précédent, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le Zoom.

Appuyez sur la combinaison de touches 
Alt+Démarrer+= (Windows) ou 
Option+Ctrl+= (Mac) pour afficher la 
fenêtre de l'éditeur Score.

Si le paramètre “Double Clicking a MIDI 
Region Opens” dans les préférences MIDI est 
défini sur l'option éditeur Score, vous pouvez 
cliquer deux fois sur une région MIDI pour 
l'ouvrir dans l'éditeur Score.

Appuyez sur la touche F5 pour sélectionner 
le Zoom et basculer entre les modes Zoom 
normal et Zoom simple.

Reportez-vous également à la section 
“Commandes de zoom”, page 102.
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Pour effectuer un zoom par sélection d'une zone 
spécifique de la partition :

1  Cliquez dans le menu déroulant du Zoom et 
sélectionnez le mode Normal Zoom.

2  Cliquez dans la partition et faites glisser le 
curseur pour définir la zone de sélection autour 
de la zone sur laquelle vous voulez effectuer un 
zoom.

La zone agrandie remplit toute la fenêtre Edit.

Mode zoom simple

Le mode Single Zoom (zoom simple) vous 
ramène à l'outil précédent lorsqu'un zoom a été 
effectué.

Par exemple, lorsque vous utilisez l'outil 
Crayon, si vous cliquez sur le mode Single 
Zoomer, chaque fois qu'un zoom aura été 
effectué Pro Tools reviendra automatiquement à 
l'outil Crayon.

Le mode Single Zoom est identifié par une flèche 
vers la droite dans l'icône du Zoom. Cette flèche 
est absente dans le mode de zoom normal.

Pour activer le mode Single Zoom :

Cliquez sur le menu déroulant du Zoom et 
sélectionnez le mode Single Zoom.

Trimmer

L'outil de trimming vous permet d'allonger ou 
de raccourcir la durée d'une note.

Note Selector

Le sélecteur de notes vous permet de 
sélectionner des notes sur une ou plusieurs 
portées dans la fenêtre de l'éditeur Score. Les 
notes sélectionnées sont surlignées en bleu. 
Vous pouvez supprimer, déplacer, transposer et 
traiter les notes sélectionnées (par le biais de la 
boîte de dialogue Event Operations). 

Grabber

Utilisez l'outil Main pour sélectionner une ou 
plusieurs notes. Vous pouvez également utiliser 
l'outil Main pour déplacer des notes 
individuellement, ou toutes les notes 
sélectionnées, à une hauteur ou un 
emplacement temporel différent(e).

Zoom par sélection à l'aide de l'outil de zoom

Appuyez sur la touche F6 pour sélectionner 
l'outil de trimming.

Appuyez sur la touche F7 pour sélectionner 
le sélecteur de notes.

Le sélecteur de notes effectue une sélection 
de gamme contenant uniquement les notes 
et les vélocités MIDI. Il n'inclut pas les 
autres données MIDI, comme les 
changements de programme ou les données 
de contrôleur continu. 

Appuyez sur la touche F8 pour sélectionner 
l'outil Main.
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Crayon

Utilisez les outils Crayon pour insérer, 
sélectionner, déplacer ou supprimer des notes. 
Les différents outils Crayon permettent de tracer 
la durée des notes, les répétitions de notes et les 
vélocités de façon différente, mais ils 
fonctionnent de la même façon que pour le 
tracé des notes sur les pistes dans la vue Notes de 
la fenêtre Edit ou dans une fenêtre de l'éditeur 
MIDI.

Pour sélectionner un outil Crayon :

Cliquez sur le menu contextuel de l'outil 
Crayon et sélectionnez l'outil Crayon de votre 
choix.

Les outils Crayon suivants sont disponibles dans 
l'éditeur Score :

Free Hand

Le crayon Free Hand vous permet de dessiner 
des notes individuelles de durées différentes. 

Les vélocités des notes sont déterminées par le 
paramètre Default Note Velocity (voir “Default 
Note On Velocity”, page 97). 

La durée minimum de la note est déterminée par 
la valeur Default Note Duration sélectionnée 
(voir “Default Note Duration”, page 97).

Line

Le crayon Ligne vous permet de dessiner 
plusieurs notes de hauteur et de durée 
identiques. 

Les vélocités des notes sont déterminées par le 
paramètre Default Note Velocity (voir “Default 
Note On Velocity”, page 97). 

La durée est déterminée par la valeur Default 
Note Duration sélectionnée (voir “Default Note 
Duration”, page 97). 

Le début de chaque note est déterminé par la 
valeur Grid sélectionnée (voir “Grid”, page 99).

Triangle

Le crayon Triangle vous permet de dessiner une 
série de notes MIDI sur une même hauteur, dont 
la vélocité oscille entre la valeur du paramètre 
Default Note Velocity défini et la valeur 127, 
formant ainsi des dents de scie. La durée de 
chaque note est déterminée par la valeur de la 
grille actuelle.

La durée est déterminée par la valeur Default 
Note Duration sélectionnée (voir “Default Note 
Duration”, page 97). 

Le début de chaque note est déterminé par la 
valeur Grid sélectionnée (voir “Grid”, page 99).

Square

Le crayon carré vous permet de dessiner une 
série de notes MIDI sur une même hauteur, dont 
la vélocité alterne entre la valeur du paramètre 
Default Note Velocity défini et la valeur 127, 
formant ainsi des carrés. La durée de chaque 
note est déterminée par la valeur de la grille 
actuelle.

La durée est déterminée par la valeur Default 
Note Duration sélectionnée (voir “Default Note 
Duration”, page 97). 

Le début de chaque note est déterminé par la 
valeur Grid sélectionnée (voir “Grid”, page 99).

Appuyez sur la touche F10 pour sélectionner 
l'outil Crayon actif. Appuyez sur la touche 
F10 plusieurs fois pour passer d'un outil 
Crayon à l'autre.
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Random

Le crayon carré vous permet de dessiner une 
série de notes MIDI sur une même hauteur, dont 
la vélocité varie aléatoirement dans une plage 
comprise entre la valeur du paramètre Default 
Note Velocity défini et la valeur 127, formant 
ainsi des carrés. La durée de chaque note est 
déterminée par la valeur de la grille actuelle.

La durée est déterminée par la valeur Default 
Note Duration sélectionnée (voir “Default Note 
Duration”, page 97). 

Le début de chaque note est déterminé par la 
valeur Grid sélectionnée (voir “Grid”, page 99).

Default Note Duration

Le sélecteur Default Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Pour définir la durée de note par défaut :

Dans le sélecteur Default Note Duration, 
sélectionnez la valeur de note désirée. 
Sélectionnez l'option Follow Grid si vous voulez 
que la valeur Default Note Duration utilise la 
valeur de grille sélectionnée.

Si vous voulez inclure les valeurs de notes 
pointées, sélectionnez également l'option 
Dotted.

Si vous voulez inclure les valeurs de triolets, 
sélectionnez également l'option Triplet.

Default Note On Velocity

Le paramètre Default Note On Velocity permet 
de définir la valeur de vélocité de la note par 
défaut pour les notes insérées manuellement.

Play MIDI Notes When Editing

Lorsque l'option Play MIDI Notes When Editing 
est activée, les notes MIDI sont audibles lorsque 
vous les insérez à l'aide du crayon ou que vous 
les faites glisser avec la main. 

Link Timeline and Edit Selection

Lorsque ce bouton est activé, les selections de 
timeline et d'édition sont liées. Lorsqu'il est 
désactivé, vous pouvez effectuer des sélections 
de timeline et d'édition de manière 
indépendante.

Sélection de la durée de note par défaut

Sélecteur Default Note Duration

Option Play MIDI Notes When Editing activée dans la 
fenêtre de l'éditeur Score

Bouton Link Timeline and Edit Selection activé dans la 
fenêtre de l'éditeur Score

Play MIDI Notes When Editing

Link Timeline and Edit Selection
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Mirrored MIDI Editing

Cette option permet d'éditer des régions MIDI et 
d'appliquer vos modifications à chaque copie de 
la même région MIDI. Cela s'avère très utile lors 
de l'édition de régions MIDI en boucle.

En mode Mirrored MIDI Editing, le bouton 
Mirrored MIDI Editing clignote une fois en 
rouge dès qu'une édition est appliquée à plus 
d'une région.

Pour activer l'édition MIDI en miroir, procédez 
comme suit :

Sélectionnez Options > Mirror MIDI Editing.

– ou –

Sélectionnez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit, la fenêtre de l'éditeur MIDI 
ou la fenêtre de l'éditeur Score.

Pour désactiver l'édition MIDI en miroir, procédez 
comme suit :

Désélectionnez Options > Mirror MIDI Editing.

– ou –

Désactivez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit, la fenêtre de l'éditeur MIDI 
ou la fenêtre de l'éditeur Score.

Double Bar

Lorsqu'elle est activée, l'option Double Bar 
affiche la double barre de mesure finale dans la 
fenêtre de l'éditeur Score. La double barre est 
située à la fin de la dernière région ou du dernier 
événement MIDI de la session. Activez l'option 
Double Bar lorsque vous êtes prêt à imprimer la 
partition.

Lorsque l'option Double Bar est désactivée, un 
certain nombre de barres vides apparaît à la fin 
de la dernière région MIDI de la session. Le 
nombre de barres vides est déterminé par le 
paramètre Additional Empty Bars In The Score Editor 
dans la page des préférences MIDI de Pro Tools 
(Setup > Preferences). Désactivez l'option Double 
Bar pour saisir manuellement des notes dans 
l'éditeur Score après la dernière région MIDI.

Emplacement du curseur

L'affichage de l'emplacement du curseur fournit 
des informations sur l'emplacement actuel du 
curseur en Temps|Mesures|Tics et sur la hauteur.

Bouton Mirrored MIDI Editing désactivé dans la fenêtre 
de l'éditeur Score

Lorsque le mode Mirrored MIDI Editing est 
désactivé et que vous éditez des notes de 
régions en boucle dans la vue Notes, 
l'édition a pour effet d'aplanir la boucle. 
De la même manière, l'édition de groupes 
de régions a pour effet de séparer les groupes 
de régions.

Mirrored MIDI Editing Double barre activée dans la fenêtre de l'éditeur Score

Indicateur d'emplacement du curseur dans la fenêtre 
de l'éditeur Score

Double Bar

Emplacement du curseur
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Grid

Le sélecteur Grid vous permet de définir la 
valeur de grille des notes MIDI insérées et 
affichées dans la fenêtre de l'éditeur Score. 

Pour définir la valeur de grille pour la fenêtre de 
l'éditeur Score :

Dans le menu déroulant Grid Value, 
sélectionnez la valeur de note désirée.

Si vous voulez inclure les valeurs de notes 
pointées, sélectionnez également l'option 
Dotted.

Si vous voulez inclure les valeurs de triolets, 
sélectionnez également l'option Triplet.

Insertion de notes sur la grille

Lorsque vous insérez des notes MIDI à l'aide du 
crayon (sous forme de ligne, triangle, carré ou 
aléatoire), la valeur de grille détermine 
l'emplacement de la note et la valeur Default 
Note Duration détermine la durée de la note 
(voir “Default Note Duration”, page 97). 

Par exemple, si Default Note est définie sur 
Noires et que la grille est définie sur Blanches, 
lorsque vous dessinez des notes à l'aide du 
crayon Ligne, une alternance de noires et de 
soupirs est créée.

Cependant, si la valeur de grille sélectionnée est 
plus courte que la valeur Default Note Duration, 
la valeur de grille détermine à la fois 
l'emplacement de la note et la durée des notes 
insérées à l'aide du crayon. Par exemple, si 
Default Note est définie sur les noires et que la 
grille est définie sur les croches, lorsque vous 
dessinez des notes à l'aide du crayon Ligne, une 
séquence de croches est créée.

Cible de la fenêtre de l'éditeur 
Score

Lorsque la cible est activée pour la fenêtre de 
l'éditeur Score, la navigation dans la fenêtre Edit 
entraîne automatiquement la navigation dans la 
fenêtre de l'éditeur Score. Par exemple, si dans la 
fenêtre Edit, vous accédez à la mesure 32, temps 
3 sur une piste MIDI, le même emplacement 
s'affiche lorsque vous ouvrez la fenêtre de 
l'éditeur Score.

Lorsque la cible est désactivée, l'éditeur Score 
n'est pas actualisé et n'affiche pas la sélection 
actuelle de la fenêtre Edit ou de l'emplacement 
du curseur d'édition.

Définition de la valeur de la grille

Insertion de notes sur la grille
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Menu de la fenêtre de l'éditeur 
Score

Le menu de la fenêtre de l'éditeur Score permet 
d'accéder aux options Expanded Edit Tools, 
Selection Display, Track List et Scrolling.

Expanded Edit Tools

Lorsqu'elle est sélectionnée, l'option Expanded 
Edit Tools permet d'afficher tous les outils 
d'édition appropriés dans la barre d'outils de la 
fenêtre de l'éditeur Score. 

Si cette option n'est pas sélectionnée, seule 
l'icône de l'outil d'édition sélectionné est 
affichée. Tous les autres outils d'édition peuvent 
être sélectionnés à partir du menu déroulant des 
outils d'édition.

Selection Display

Lorsque cette option est sélectionnée, l'affichage 
de sélection d'édition apparaît dans la barre 
d'outils de la fenêtre de l'éditeur MIDI.

Liste des pistes

Lorsqu'elle est sélectionnée, cette option affiche 
la liste des pistes dans la fenêtre de l'éditeur 
Score.

Scrolling

Le sous-menu Scrolling permet de sélectionner 
les options de défilement pour la fenêtre de 
l'éditeur Score indépendamment des autres 
fenêtres de l'éditeur MIDI et de la fenêtre Edit. 
Les options de défilement incluent :

No Scrolling la fenêtre de l'éditeur Score ne défile 
ni pendant ni après la lecture. Le curseur de 
lecture se déplace dans la fenêtre Edit, indiquant 
la position du point de lecture.

After Playback le curseur de lecture se déplace 
dans la fenêtre de l'éditeur Score, indiquant la 
position du point de lecture. La fenêtre de 
l'éditeur Score défile jusqu'au dernier point lu 
après l'arrêt de la lecture.

Page le curseur de lecture se déplace dans la 
fenêtre de l'éditeur Score, indiquant la position 
du point de lecture. Lorsque le bord droit de la 
page actuellement affichée dans la fenêtre de 
l'éditeur Score est atteint, son contenu défile à la 
page suivante et le curseur de lecture reprend 
son déplacement depuis le bord gauche de la 
fenêtre.

Follow Edit Window lorsque cette option est 
sélectionnée, la fenêtre de l'éditeur Score utilise 
l'option de défilement sélectionnée pour la 
fenêtre Edit (Options > Edit Window Scrolling).

Barre d'outils personnalisable

Vous pouvez personnaliser la barre d'outils dans 
les fenêtres de l'éditeur Score en réorganisant les 
commandes et affichages disponibles et en 
activant ou en désactivant leur visibilité, de la 
même façon que dans la fenêtre Edit ou dans la 
fenêtre de l'éditeur MIDI.

Dans les systèmes Pro Tools|HD, les 
options de défilement Continuous et Center 
Playhead ne sont pas disponibles dans la 
fenêtre de l'éditeur Score. Si la fenêtre de 
l'éditeur Score est définie sur l'option de 
défilement Follow Edit Window et que 
l'option de défilement de la fenêtre Edit est 
soit Continuous soit Center Playhead, le 
défilement dans la fenêtre de l'éditeur Score 
s'effectue par page.
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Options d'affichage de la barre d'outils

Pour modifier les options d'affichage la barre 
d'outils d'une fenêtre de l'éditeur Score :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le menu de la barre d'outils de 
la fenêtre de l'éditeur Score.

– ou –

• Cliquez avec le bouton droit de la souris 
dans la barre d'outils.

2  Dans le menu contextuel qui s'affiche, 
sélectionnez ou désélectionnez l'une des options 
suivantes :

• Expanded Edit Tools

• Selection Display

Redisposition des commandes et des 
affichages

Pour redisposer les commandes et affichages de la 
barre d'outils de la fenêtre de l'éditeur MIDI :

Cliquez tout en maintenant enfoncée la 
touche Ctrl (Windows) ou Pomme (Mac) sur les 
commandes ou affichages à déplacer, puis faites-
les glisser à l'emplacement de votre choix sur la 
barre d'outils.

Liste des pistes

La liste des pistes vous permet d'afficher et des 
masquer les pistes MIDI et d'instrument dans 
l'éditeur Score. Elle permet également d'accéder 
aux options Notation Display Track Settings et 
Score Setup (voir “Option Notation Display 
Track Settings”, page 103 et “Score Setup”, 
page 105).

Pour afficher ou masquer la liste des pistes dans la 
fenêtre de l'éditeur Score :

Dans le menu de la fenêtre de l'éditeur Score, 
sélectionnez ou désélectionnez Track List.

Affichage et masquage des pistes

Utilisez la liste des pistes pour afficher et 
masquer des pistes MIDI et d'instrument en tant 
que portées dans la partition.

Pour afficher les pistes MIDI et d'instrument dans 
l'éditeur Score :

Cliquez sur l'icône Afficher/Masquer pour les 
pistes de la liste des pistes que vous voulez 
afficher dans la partition.

Pour afficher toutes les pistes MIDI et d'instrument 
dans l'éditeur Score :

Dans le menu Track List, choisissez Show All 
Tracks.

Pour afficher uniquement les pistes MIDI et 
d'instrument sélectionnées dans l'éditeur Score :

1  Dans la liste des pistes, sélectionnez les pistes 
MIDI et d'instrument à afficher dans la 
partition.

2  Dans le menu Track List, choisissez Show Only 
Selected Tracks.

Partition partielle : Violin I et Violin II affichées ; toutes 
les autres pistes sont masquées
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Pour masquer les pistes MIDI et d'instrument dans 
l'éditeur Score :

Cliquez sur l'icône Afficher/Masquer pour les 
pistes de la liste des pistes que vous voulez 
masquer dans la partition.

Pour masquer toutes les pistes MIDI et 
d'instrument dans l'éditeur Score :

Dans le menu Track List, choisissez Hide All 
Tracks.

Pour masquer les pistes MIDI et d'instrument 
sélectionnées dans l'éditeur Score :

1  Dans la liste des pistes, sélectionnez les pistes 
MIDI et d'instrument à masquer dans la 
partition.

2  Dans le menu Track List, choisissez Hide 
Selected Tracks.

Commandes de page

La fenêtre de l'éditeur Score dispose de 
commandes permettant de passer à la page 
suivante ou précédente. Le numéro de la page en 
cours est affiché dans l'angle inférieur gauche de 
la fenêtre.

Pour afficher la page suivante d'une partition :

Cliquez sur le bouton Page Forward.

Pour afficher la page précédente d'une partition :

Cliquez sur le bouton Page Back.

Pour afficher une page spécifique d'une partition :

1  Cliquez sur Current Page Display.

2  Saisissez le numéro de page que vous voulez 
afficher.

3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac).

Commandes de zoom

Outre le Zoom, l'éditeur Score fournit des 
boutons de zoom avant et de zoom arrière situés 
dans l'angle inférieur droit de la fenêtre. 
Il fournit également un sélecteur de zoom vous 
permettant de choisir une taille de page ou un 
pourcentage de zoom prédéfinis. Lorsque vous 
utilisez ces commandes de zoom, l'éditeur Score 
zoome autour de la sélection d'édition actuelle.

Pour effectuer un zoom avant d'un niveau :

Cliquez sur le bouton de zoom avant.

Pour effectuer un zoom arrière d'un niveau :

Cliquez sur le bouton de zoom arrière. 
Commandes de page de l'éditeur Score

Page Forward
Page Back

Current Page Display

Commandes de zoom de l'éditeur Score

Zoom avant
Zoom arrière

Sélecteur de zoom
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Pour effectuer un zoom en appliquant un 
pourcentage prédéfini :

1  Cliquez sur le sélecteur de zoom.

2  Dans le menu contextuel Zoom, sélectionnez 
le pourcentage de zoom de votre choix.

Pour effectuer un zoom sur une taille de page :

1  Cliquez sur le sélecteur de zoom.

2  Dans le menu contextuel Zoom, sélectionnez 
la taille de page de votre choix.

Zoom sur des tailles de page

Le menu déroulant Zoom propose les tailles de 
page suivantes :

Fit Page Width Effectue un zoom de sorte que la 
largeur de la page soit ajustée à la taille de la 
fenêtre de l'éditeur Score.

Fit Page Height Effectue un zoom de sorte que la 
hauteur de la page soit ajustée à la taille de la 
fenêtre de l'éditeur Score.

Fit Page Effectue un zoom de sorte que la totalité 
de la page soit ajustée à la fenêtre de l'éditeur 
Score.

Fit 2 Pages Effectue un zoom de sorte que deux 
pages soient ajustées horizontalement à la 
fenêtre de l'éditeur Score.

Option Notation Display Track 
Settings
Les paramètres Notation Display Track Settings 
déterminent l'affichage de chaque piste MIDI et 
d'instrument dans l'éditeur Score. Vous pouvez y 
définir les options Clef, Display Quantization et 
indiquer si vous voulez que la piste soit affichée 
à “hauteur relative” ou comme instrument de 
transposition (par exemple, un saxo ténor en si 
bémol).

Sélectionnez un pourcentage de zoom dans le menu 
contextuel Zoom.

Option Notation Display Track Settings
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Pour configurer les paramètres Notation Display 
Track Settings :

1  Effectuez l'une des opérations suivantes :

• Dans le menu Track de l'éditeur Score, 
sélectionnez Notation Display Track Settings.

• Cliquez avec le bouton droit de la souris 
dans l'éditeur Score et sélectionnez Notation 
Display Track Settings.

• Cliquez deux fois sur une clef dans une 
portée.

2  Dans le menu déroulant Track, sélectionnez la 
piste MIDI ou d'instrument dont vous voulez 
modifier les paramètres Notation Display 
Settings.

3  Configurez les paramètres Notation Display 
Track Settings comme souhaité.

4  Répétez les étapes précédentes pour les autres 
pistes MIDI et d'instrument, le cas échéant.

Options Notation Display Track 
Settings

Track

Dans le menu contextuel Track, sélectionnez la 
piste à configurer.

Clef

Dans le menu déroulant Clef, sélectionnez la 
clef que vous souhaitez appliquer à la piste 
sélectionnée parmi les options suivantes :

• Grand Staff

• Treble Clef

• Bass Clef

• Alto Clef

• Tenor Clef

Affichage de la transposition

Dans le menu déroulant Key, sélectionnez la 
tonalité de transposition de la piste. Pour les 
instruments qui se transposent à partir d'une 
autre octave, vous pouvez également régler le 
curseur Octave. Par exemple, dans le cas d'une 
piste de clarinette basse, sélectionnez la tonalité 
si bémol et réglez le curseur d'octave sur +1. 
Ainsi, lorsque vous imprimez la partition de la 
clarinette basse, le musicien peut lire la partition 
et la hauteur relative sonne correctement une 
neuvième majeure en dessous de la partition.

Attributes

L'onglet Attributes vous permet de spécifier les 
paramètres de quantification d'affichage des 
notations pour la piste sélectionnée. Si la Clef est 
définie sur Grand Staff, vous pouvez également 
définir le point Split Point de division des notes 
entre la clef de sol et la clef de fa.

Follow Globals

Lorsque l'option Follow Globals est sélectionnée, 
les attributs de piste utilisent les paramètres 
d'attributs globaux (voir “Globals”, page 105). 
Cette option est activée par défaut pour toutes 
les pistes.

Fenêtre Notation Display Track Settings, onglet 
Attributes



Chapitre 7 : Fenêtre de l'éditeur Score 105

Display Quantization

Le paramètre Display Quantization vous permet de 
sélectionner une grille de quantification pour 
l'affichage des notes MIDI dans la notation 
musicale. Les notes MIDI dans Pro Tools 
conservent leur début et leur durée d'origine, 
mais ce paramètre affecte les valeurs de notes 
affichées. L'affichage de la notation est quantifié 
à la valeur de note la plus proche suivante.

Straighten Swing

Lorsque l'option Straighten Swing est activée, elle 
affiche les notes “swinguées” en notation 
régulière. Par exemple, une série de croches 
swinguées sera affichée sous forme de croches 
régulières.

Allow Note Overlap

Pro Tools n'affiche qu'une seule ligne rythmique 
par portée. Lorsque deux notes qui commencent 
à des moments différents se superposent, la 
première note est tronquée au moment où 
démarre la deuxième note. Si l'option Allow Note 
Overlap est activée, Pro Tools affiche toute la 
longueur des notes superposées à l'aide de notes 
liées.

Split Point

Lorsque la clef de la piste sélectionnée est définie 
sur Grand Staff, le paramètre Split Point 
sélectionné détermine à quelle hauteur les notes 
sont placées sur la portée inférieure ou 
supérieure de la double portée.

Automatic Lorsque cette option est sélectionnée, 
Pro Tools répartit les notes entre la portée du 
haut et la portée du bas de la double portée, 
selon des regroupements de notes logiques.

Fixed Cette option vous permet de spécifier une 
hauteur particulière à laquelle doit s'effectuer la 
répartition des notes entre la portée supérieure 
et inférieure de la double portée.

Globals

L'onglet Globals fournit les mêmes paramètres 
que l'onglet Attributes (voir “Attributes”, 
page 104). Vous pouvez sélectionner à quelles 
pistes appliquer ces paramètres dans l'onglet 
Globals de l'onglet Attributes de chaque piste.

Score Setup
La fenêtre Score Setup vous permet de définir la 
mise en page et l'espacement des portées. Vous 
pouvez y indiquer le titre et le compositeur de la 
partition. Vous pouvez également sélectionner 
les éléments de la partition que vous souhaitez 
afficher. Les modifications apportées à la fenêtre 
Score Setup sont instantanément répercutées 
dans l'éditeur Score.
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Pour ouvrir la fenêtre Score Setup, effectuez l'une 
des opérations suivantes :

Sélectionnez File > Score Setup.

Dans le menu Tracks de la fenêtre Score Editor, 
sélectionnez Score Setup.

Cliquez avec le bouton droit de la souris dans 
la fenêtre de l'éditeur Score et sélectionnez Score 
Setup.

Options de la fenêtre Score Setup

Information

Title Saisissez le titre de la partition. Celui-ci 
apparaîtra en haut de la première page.

Composer Saisissez le nom du compositeur de la 
partition qui s'affichera dans l'angle supérieur 
droit de la première page.

Display

Les options de la section Display vous 
permettent de définir les éléments à afficher 
dans la partition. Désélectionnez les éléments 
que vous ne voulez pas afficher dans la 
partition.

Title and Composer Sélectionnez cette option 
pour que le titre et le nom du compositeur 
s'affichent sur la partition.

Page Numbers Sélectionnez cette option pour 
que les numéros de page s'affichent au bas de 
chaque page.

Bar Numbers Sélectionnez cette option pour 
afficher le nombre de mesures au début de 
chaque système au-dessus de la portée du haut.

Track Names Sélectionnez cette option pour 
afficher le nom des pistes pour chaque portée au 
début de la partition.

Chord Symbols Sélectionnez cette option pour 
afficher les symboles d'accord dans la partition.

Fenêtre Score Setup
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Diagrammes d'accord Sélectionnez cette option 
pour afficher les diagrammes d'accord (tablature 
de la guitare) dans la partition (voir 
“Diagrammes et symboles d'accords”, page 113).

Spacing

Between Staves Spécifiez l'espacement que vous 
souhaitez appliquer entre chaque portée.

Between Systems Spécifiez l'espacement que 
vous souhaitez appliquer entre chaque système.

Below Title and Composer Indiquez l'espacement 
à appliquer entre l'indication du titre et du 
compositeur et la première portée de la 
partition.

Below Chord Symbols and Diagrams Indiquez 
l'espacement à appliquer entre les symboles et 
les diagrammes d'accords et la portée supérieure 
de chaque système.

Layout

Page Size Sélectionnez le format de page (Letter, 
Legal, Tabloid ou A4).

Portrait Cette option applique une orientation 
de type portrait à la page.

Landscape Cette option applique une 
orientation de type paysage à la page.

Staff Size Indiquez la taille de la portée.

Page Margins Indiquez les valeurs des marges 
supérieure, inférieure, gauche et droite. 

Inches Sélectionnez cette option si vous voulez 
indiquer la taille de portée et les marges de la 
page en pouces.

Millimeters Sélectionnez cette option si vous 
voulez indiquer la taille de portée et les marges 
de la page en millimètres.

Edition des notes
L'édition de notes MIDI dans la fenêtre Edit, les 
fenêtres de l'éditeur MIDI et la fenêtre de 
l'éditeur Score affectent toutes les mêmes 
données MIDI. Lorsque vous effectuez des 
modifications dans une fenêtre, celles-ci sont 
reflétées dans toutes les autres fenêtres. L'éditeur 
Score fournit des outils d'édition simples pour la 
saisie, le déplacement et la transposition des 
notes MIDI en notation musicale : 

• L'outil de trimming vous permet d'allonger ou 
de raccourcir la durée des notes.

• Le sélecteur de notes vous permet de 
sélectionner des notes en tant qu'objets sur la 
partition.

• La main vous permet de sélectionner des 
notes et de les déplacer à un autre 
emplacement temporel ou à une autre 
hauteur sur la même piste. 

• Le crayon vous permet d'insérer des notes et 
de les déplacer à un autre emplacement 
temporel ou à une autre hauteur sur la même 
piste.

Désactivez l'option Chord Diagrams lorsque 
vous voulez imprimer une partition sur 
laquelle seuls les symboles d'accord sont 
visibles.

Sur les pages sur lesquelles la partition est 
justifiée verticalement, la distance entre les 
portées et les systèmes sera supérieure aux 
valeurs indiquées.
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Sélection de notes

Pour sélectionner des notes sur une ou plusieurs 
portées, vous pouvez utiliser le sélecteur de 
notes ou la main.

Pour sélectionner des notes sur une ou plusieurs 
protées à l'aide du sélecteur de notes :

1  Cliquez sur le sélecteur de notes.

2  Cliquez en déplaçant le curseur sur la partition 
afin de mettre en surbrillance les notes à 
sélectionner.

Pour sélectionner une ou plusieurs portées avec un 
rectangle de sélection à l'aide de la main :

1  Cliquez sur la main.

2  Cliquez en déplaçant le curseur sur la partition 
afin de mettre en surbrillance les notes à 
sélectionner.

Transposition des notes

Vous pouvez transposer une note vers le haut ou 
vers le bas à l'aide de la main ou du crayon. 
Vous pouvez également utiliser les opérations 
d'événement de transposition (Event > Event 
Operations > Transpose) pour transposer les notes 
sélectionnées.

Pour transposer une seule note :

1  Cliquez sur la main.

2  Cliquez et faites glisser la note à transposer 
vers le haut ou vers le bas.

Pour transposer toutes les notes sélectionnées :

1  Cliquez sur la main.

2  Cliquez et faites glisser le curseur autour des 
notes à transposer pour les sélectionner.

3  Cliquez sur l'une des notes sélectionnées et 
faites-la glisser vers le haut ou vers le bas pour la 
transposer.

Déplacement des notes

Utilisez l'outil Main pour déplacer les notes 
sélectionnées d'un emplacement temporel à un 
autre sur la même portée. Lorsque vous déplacez 
des notes dans l'éditeur Score, les notes MIDI 
sous-jacentes conservent leur position par 
rapport à la grille.

Pour déplacer les notes vers un autre emplacement 
temporel :

1  Cliquez sur la main.

2  Pour déplacer plusieurs notes en même temps, 
cliquez et faites glisser le curseur autour des 
notes à déplacer pour les sélectionner.

Sélection de notes avec le sélecteur de notes

Sélection de notes à l'aide de la main

Transposition d'une note à l’aide de l'outil Main

Transposition des notes sélectionnées à l'aide de l'outil 
Main
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3  Cliquez sur l'une des notes sélectionnées et 
faites-la glisser vers un autre emplacement 
temporel sur la même portée.

Insertion de notes

Utilisez le crayon pour insérer manuellement 
des notes dans l'éditeur Score. Lorsque vous 
insérez une note, l'éditeur Score la place 
automatiquement sur la grille et crée des soupirs 
aux emplacements appropriés.

Pour insérer une note manuellement :

1  Sélectionnez le paramètre Default Note 
Duration de votre choix (voir “Default Note 
Duration”, page 97).

2  Sélectionnez le paramètre de grille de votre 
choix (voir “Grid”, page 99).

3  Sélectionnez la valeur du paramètre Default 
Note On Velocity (voir “Default Note On 
Velocity”, page 97).

4  Cliquez sur le crayon et sélectionnez Main 
levée.

5  A l'aide du crayon à main levée, procédez de 
l'une des façons suivantes :

• Cliquez à l'emplacement temporel et de 
hauteur auquel vous voulez entrer la note 
de la durée de note par défaut sélectionnée.

– ou –

• Cliquez à l'emplacement temporel et de 
hauteur souhaité et faites glisser le curseur 
vers la droite pour allonger la durée de la 
note. Lorsque vous avez obtenu la durée 
souhaitée, relâchez la souris.

Pour insérer manuellement plusieurs notes de 
hauteur identique :

1  Sélectionnez le paramètre Default Note 
Duration de votre choix (voir “Default Note 
Duration”, page 97).

2  Sélectionnez le paramètre de grille de votre 
choix (voir “Grid”, page 99).

Déplacement des notes sélectionnées à l'aide de l'outil 
Main

Vous pouvez également appliquer aux notes 
dans l'éditeur de score un incrément 
(fonction Nudge) de la valeur de grille 
actuellement sélectionnée.

Vous pouvez également entrer des notes en 
enregistrant du contenu MIDI, en important 
du contenu MIDI d'un fichier, ou à l'aide de 
la fonction Step Input (Event > Event 
Operations > Step Input).

Saisie d'une note à l'aide du crayon

Saisie d'une note plus longue à l'aide du crayon
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3  Sélectionnez la valeur du paramètre Default 
Note On Velocity (voir “Default Note On 
Velocity”, page 97).

4  Cliquez sur le crayon et sélectionnez l'une des 
formes de tracé suivantes :

• Line

• Triangle

• Square

• Random

5  Cliquez à l'emplacement temporel et de 
hauteur souhaité et faites glisser le curseur sur la 
droite. Une succession de notes de la durée par 
défaut sélectionnée est entrée sur la grille de 
votre choix. La vélocité de chaque note est 
déterminée en partie par le paramètre Default 
Note On Velocity et par la forme de l'outil 
Crayon sélectionnée (voir “Crayon”, page 96).

Soupirs

L'éditeur de Score insère automatiquement des 
soupirs aux endroits requis. Il n'est pas possible 
d'insérer ou de déplacer manuellement des 
soupirs.

Menu contextuel de l'éditeur 
Score
Le menu contextuel de l'éditeur Score fournit 
plusieurs commandes utiles pour l'édition, 
l'exportation et la mise en forme de la partition 
et des données MIDI.

Pour accéder au menu contextuel de l'éditeur 
Score :

Cliquez dans la partition avec le bouton droit 
de la souris.

Tools

Le sous-menu Tools vous permet de sélectionner 
des outils d'édition appropriés pour l'éditeur 
Score.

Zoom Sélectionne l'outil de zoom.

Note Selector Sélectionne le sélecteur de notes.

Grabber Sélectionne l'outil Main.

Pencil Sélectionne le crayon.

Insert

Le sous-menu Insert vous permet d'insérer dans 
la partition des changements de tonalité et de 
métrique, ainsi que des symboles d'accords à 
l'emplacement du curseur d'édition.

Key Insère un changement de tonalité.

Meter Insère un changement de métrique.

Chord Insère un symbole d'accord.

Cut

La commande Cut coupe la sélection d'édition 
active.

Saisie de plusieurs notes de même hauteur à l'aide du 
crayon Ligne
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Copy

La commande Copy copie la sélection d'édition 
active.

Paste

La commande Paste colle le contenu du presse-
papiers dans la sélection d'édition ou à 
l'emplacement du curseur d'édition actuel. 
Toute note MIDI figurant déjà au même 
emplacement est remplacée.

Merge

La commande Merge colle le contenu du presse-
papiers dans la sélection d'édition ou à 
l'emplacement du curseur d'édition actuel et 
fusionne les données collées avec les notes MIDI 
déjà présentes au même emplacement.

Clear

La commande Clear efface (supprime) la 
sélection d'édition active.

Event Operations 

Le sous-menu Event Operations vous permet de 
sélectionner l'une des fenêtres Event Operations 
(par exemple, Quantize ou Change Velocity).

Open in MIDI Editor

L'option Open in MIDI Editor permet d'ouvrir les 
pistes affichées dans l'éditeur Score dans une 
fenêtre de l'éditeur MIDI.

Open in MIDI Event List

L'option Open In MIDI Event List ouvre la piste 
sélectionnée dans la liste des événements MIDI.

Option Notation Display Track Settings

L'option Notation Display Track Settings permet 
d'ouvrir la boîte de dialogue Notation Display 
Track Settings (voir “Option Notation Display 
Track Settings”, page 103).

Score Setup

L'option Score Setup permet d'ouvrir la boîte de 
dialogue Score Setup (voir “Score Setup”, 
page 105).

Send to Sibelius

La commande Send to Sibelius permet d'envoyer 
la partition exactement comme elle se présente 
dans la fenêtre de l'éditeur Score vers le logiciel 
de notation Sibelius (voir “Améliorations de la 
commande Send To Sibelius”, page 115).

Print Score

La commande Print Score vous permet 
d'imprimer le score (voir “Impression de 
partitions”, page 115).

Changements de tonalité
Vous pouvez ajouter, modifier et supprimer des 
signatures de tonalité dans votre partition. 
Les signatures de tonalité affectent l'écriture des 
notes MIDI dans la partition. Par exemple, le 
numéro de note MIDI 58 (si bémol 3) est un si 
bémol en fa majeur, mais c'est un la dièse en si 
majeur.

Vous pouvez également ajouter et supprimer 
des signatures de tonalité avec la règle des 
signatures de tonalité dans la fenêtre Edit ou 
dans une fenêtre de l'éditeur MIDI.
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Pour ajouter une signature de tonalité :

1  Avec le sélecteur de notes, la main ou le 
crayon, cliquez avec le bouton droit de la souris 
à l'emplacement auquel vous voulez modifier la 
tonalité et sélectionnez Insert > Key Change.

2  Dans la boîte de dialogue Key Change, 
sélectionnez le mode (majeur ou mineur), la 
tonalité, l'emplacement et la durée, puis 
indiquez le type de modification apportée à la 
hauteur.

3  Cliquez sur OK.

La signature de tonalité sélectionnée s'affiche 
dans la partition et l'écriture des notes est mise à 
jour pour refléter la modification de tonalité.

Pour modifier une signature de tonalité :

1  A l'aide de la Main, cliquez deux fois sur la 
signature de tonalité à modifier.

2  Dans la boîte de dialogue Key Change, 
effectuez les modifications souhaitées, puis 
cliquez sur OK.

Pour supprimer une signature de tonalité :

Maintenez enfoncée la touche Alt (Windows) 
ou Option (Mac) pendant que vous cliquez avec 
la main sur la signature de tonalité à supprimer.

Changements de métrique
Vous pouvez ajouter, modifier et supprimer des 
métriques dans votre partition. Les 
modifications apportées aux métriques affectent 
le nombre de mesures de la partition (et de votre 
session). Lorsque vous modifiez la métrique, les 
notes ne sont pas déplacées, mais les barres de 
mesure sont redessinées.

Pour ajouter un changement de métrique :

1  Effectuez l'une des opérations suivantes :

• Sélectionnez Event > Time Operations > 
Change Meter.

– ou –

• Avec le sélecteur de notes, la main ou le 
crayon, cliquez avec le bouton droit de la 
souris à l'emplacement auquel vous voulez 
modifier la tonalité et sélectionnez Insert > 
Meter Change.

2  Dans la boîte de dialogue Meter Change, 
procédez comme suit :

• Renseignez les champs Location and Meter 
de la fenêtre Meter Change.

– et –

Vous pouvez également ajouter et supprimer 
des métriques dans la règle des métriques de 
la fenêtre Edit ou dans les fenêtres de 
l'éditeur MIDI.

Boîte de dialogue Meter Change
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• Pour placer l'événement de métrique inséré 
précisément sur le premier temps de la 
mesure la plus proche, cochez l'option Snap 
To Bar.

3  Choisissez une valeur de note (ronde, blanche, 
noire, etc.) pour le nombre de clics entendus 
dans chaque mesure. Sélectionnez l'option 
point (.) si vous voulez ajouter une valeur 
pointée à la valeur de note.

4  Cliquez sur OK pour insérer la nouvelle 
métrique.

Pour modifier un changement de métrique :

1  A l'aide de la Main, cliquez deux fois sur 
l'événement de métrique à modifier.

2  Dans la boîte de dialogue Meter Change, 
effectuez les modifications souhaitées, puis 
cliquez sur OK.

Pour supprimer un changement de métrique :

Maintenez enfoncée la touche Alt (Windows) 
ou Option (Mac) pendant que vous cliquez avec 
la main sur l'événement de métrique à 
supprimer.

Diagrammes et symboles 
d'accords
Vous pouvez ajouter, modifier et supprimer des 
symboles d'accords et des diagrammes d'accords 
(tablature de guitare) dans votre partition. Les 
symboles d'accord n'ont aucun effet sur les 
données MIDI. 

Les symboles d'accord ne sont pas inclus lors de 
l'exportation des données MIDI de Pro Tools 
vers un fichier MIDI, mais ils sont inclus lors de 
l'exportation vers un fichier Sibelius (.sib) ou 
lors de l'utilisation de la commande Send to 
Sibelius.

Pour insérer un symbole d'accord :

1  Avec le sélecteur de notes, la main ou le 
crayon, cliquez avec le bouton droit de la souris 
à l'emplacement auquel vous voulez insérer un 
symbole d'accord et sélectionnez Insert > Chord.

2  Dans la boîte de dialogue Chord Change, 
sélectionnez le nom de la racine de l'accord dans 
le sélecteur d'accord (ré par exemple).

Avec certaines métriques, il peut être 
souhaitable d'utiliser une valeur pointée. 
Par exemple, dans le cas d'une métrique de 
6/8, le choix d'une noire pointée (donnant 
deux battements par mesure) est 
généralement mieux adapté qu'une croche 
simple (six battements par mesure). Vous pouvez également ajouter et supprimer 

des symboles d'accords dans la règle des 
symboles d'accord de la fenêtre Edit ou dans 
les fenêtres de l'éditeur MIDI. Les 
diagrammes d'accords (tablatures de 
guitare) s'affichent uniquement dans la 
fenêtre de l'éditeur Score.
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3  Sélectionnez la qualité de l'accord à partir du 
sélecteur d'accord (majeur ou mineur).

4  Sélectionnez la basse de l'accord dans le 
sélecteur de basse (par exemple, un si bémol 
pour l'accord de sol mineur inversé).

5  Sélectionnez le diagramme d'accord souhaité 
(tablature de guitare) parmi les options 
disponibles.

6  Cliquez sur OK.

Le symbole d'accord sélectionné est placé au 
dessus de la portée supérieure dans le système.

Pour modifier un symbole d'accord :

1  A l'aide de la main, cliquez deux fois sur le 
symbole d'accord à modifier.

2  Dans la boîte de dialogue Chord Change, 
effectuez les modifications souhaitées, puis 
cliquez sur OK.

Pour déplacer un symbole d'accord :

Avec la main, cliquez sur le symbole d'accord 
et faites-le glisser à un nouvel emplacement.

Pour supprimer un symbole d'accord :

Maintenez enfoncée la touche Alt (Windows) 
ou Option (Mac) pendant que vous cliquez avec 
la main sur le symbole d'accord à supprimer.

Pour afficher ou masquer les symboles d'accord 
dans la partition :

Dans la boîte de dialogue Score Settings (File > 
Score Setup), activez ou désactivez l'option Chord 
Symbols.

Pour afficher ou masquer les diagrammes d'accord 
(tablature de guitare) dans la partition :

Dans la boîte de dialogue Score Settings (File > 
Score Setup), activez ou désactivez l'option Chord 
Diagrams.

Boîte de dialogue Chord Change

Sélecteur
Sélecteur de qualité 

Sélecteur

Diagrammes d'accord

de l'accord
de bassed'accord

Symbole d'accord dans la partition

Symbole d'accord
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Exportation de partitions
Pro Tools vous permet d'exporter la partition de 
votre session sous forme de fichier Sibelius (.sib). 
Vous pouvez ensuite ouvrir votre partition dans 
Sibelius comme transcrite par Pro Tools, 
modifier la notation dans Sibelius comme 
souhaité, et imprimer la partition et les 
différents instruments à partir de Sibelius.

Pour exporter une partition depuis Pro Tools :

1  Configurez la partition pour votre session 
dans la fenêtre de l'éditeur Score.

2  Choisissez File > Export > Sibelius.

3  Sélectionnez une destination et cliquez sur 
Save.

Améliorations de la commande 
Send To Sibelius

Des améliorations ont été apportées à la 
commande Send to Sibelius, qui permet 
d'exporter des pistes MIDI et d'instrument dans 
l'éditeur de Score vers le logiciel de notation 
Sibelius en tant que fichier .sib. Si Sibelius est 
installé sur votre ordinateur, la commande Send 
to Sibelius démarre Sibelius. Vous pouvez 
apporter des modifications supplémentaires à la 
notation dans Sibelius et imprimer la musique 
ou certaines partitions de votre session. 

Pour envoyer la partition de votre session Pro Tools 
vers Sibelius, procédez de l'une des façons 
suivantes :

1  Configurez la partition pour votre session 
dans la fenêtre de l'éditeur Score.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez File > Send to Sibelius.

– ou –

• Cliquez avec le bouton droit de la souris 
dans l'éditeur Score et sélectionnez Send to 
Sibelius.

Pro Tools exporte toutes les pistes d'instrument 
et MIDI affichées dans l'éditeur Score vers 
Sibelius en tant que fichier .sib. Vous pouvez 
apporter des modifications supplémentaires à la 
notation dans Sibelius et imprimer la musique 
ou certaines partitions depuis Sibelius.

Impression de partitions
Pro Tools vous permet d'imprimer la partition 
de votre session Pro Tools. Celle-ci est imprimée 
exactement comme elle se présente dans la 
fenêtre de l'éditeur Score. Configurez la fenêtre 
Score Setup et affichez ou masquez toutes les 
pistes MIDI et d'instrument que vous souhaitez. 
Seules ces pistes seront visibles sur la partition 
imprimée.

Pour imprimer la partition à partir de votre session 
Pro Tools :

1  Ouvre la fenêtre de l'éditeur Score et 
configurez votre partition comme vous le 
souhaitez.

2  Sélectionnez File > Print Score.

3  Configurez la boîte de dialogue d'impression 
comme vous le souhaitez, puis cliquez sur OK 
(Windows) ou Print (Mac)

Sibelius 5.x ou une version plus récente est 
requise pour ouvrir des fichiers .sib exportés 
de Pro Tools.

Appuyez sur Pomme+P (Mac) ou sur Ctrl+P 
(Windows) pour imprimer la partition.
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chapitre 8

Nouvelles fonctions et amélioration de 
mixage et d'automation Pro Tools

Lignes d'automation et du 
contrôleur
Dans la fenêtre Edit, vous pouvez afficher les 
données d'automation et de contrôleur sous une 
piste (indépendamment de la vue de la piste 
sélectionnée). Chaque piste fournit des lignes 
Automation et Controller qui vous permettent 
de modifier les données d'automation et de 
contrôleur, sans changer la vue de la piste. Vous 
pouvez modifier les données d'automation et de 
contrôleur dans les lignes de la même façon que 
dans les différentes vues de piste d'automation 
et de contrôleur.

Les lignes Automation et Controller peuvent 
être affichées ou masquées. Vous pouvez aussi 
ajouter et supprimer des lignes. Ces lignes 
restent toujours sous la piste, mais vous pouvez 
redimensionner ou réordonner les lignes 
indépendamment les unes des autres.

Pour afficher ou masquer des lignes d'automation 
sous la vue de piste principale :

Cliquez sur le bouton d'affichage/de 
masquage des lignes.

Pour ajouter une ligne :

Cliquez sur le bouton Add Lane.

Pour supprimer des lignes :

Cliquez sur le bouton Remove Lane.

Affichage d'une ligne d'automation

Sélecteur de type d'automation 

Bouton

Supprimer

Ajouter

 la ligne 

les lignes
Masquer

 la ligne

Afficher/
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Pour modifier l'automation ou le type de contrôleur 
d'une ligne :

Cliquez sur le sélecteur 
Automation/Controller Type et sélectionnez 
l'automation ou le type de contrôleur de votre 
choix.

Pour remplacer toutes les lignes d'automation et de 
contrôleur sous la piste par une seule ligne 
d'automation ou de type de contrôleur 
sélectionnée :

1  Cliquez avec le bouton droit de la souris sur le 
bouton d'affichage/de masquage des lignes.

2  Sélectionnez le type d'automation ou de 
contrôleur souhaité.

Pour redimensionner la hauteur de toutes les lignes 
d'automation ou de contrôleur pour une piste, 
effectuez l'une des opérations suivantes :

Cliquez à l'aide du bouton droit de la souris 
sur l'échelle de zoom vertical à droite des 
commandes de la piste et choisissez la hauteur 
dans le menu contextuel.

– ou –

Cliquez et faites glisser (vers le haut ou le bas) 
la ligne inférieure d'une colonne Lane Controls 
donnée. Le curseur change de forme pour 
signaler que la ligne peut être redimensionnée.

Pour redimensionner la hauteur d'une ligne 
d'automation ou de contrôleur d'une piste :

Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) pendant que vous 
sélectionnez le paramètre Lane Height.

Pour réordonner des lignes :

Pour réordonner les lignes à l'écran, faites 
glisser la section de commande de ligne vers de 
nouveaux emplacements dans la fenêtre Edit.

Sélection du type d'automation pour une ligne

Menu contextuel pour la sélection d'une ligne 
d'automation ou de contrôleur

Pour augmenter/réduire la hauteur d'une 
ligne contenant une sélection d'édition ou 
dans laquelle le curseur d'édition se trouve 
actuellement, maintenez enfoncée la touche 
Démarrer (Windows) ou Ctrl (Mac) 
pendant que vous cliquez sur la touche 
fléchée Haut/Bas.
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Dix inserts
Pro Tools 8.0 fournit cinq inserts 
supplémentaires sur les pistes audio, d'entrée 
auxiliaire, fader principal et d'instrument pour 
les plug-in logiciels et les inserts matériels. Le 
flux de signal audio est en série pour la totalité 
des dix inserts sur une piste.

Configuration de la vue Inserts 
dans les fenêtres Mix et Edit

Les pistes audio, les entrées auxiliaires, les pistes 
principales et les pistes d'instrument incluent 
deux groupes de vues Inserts : Inserts A-E 
(inserts 1 à 5) et Inserts F-J (inserts 6 à 10). 
Le menu View offre des options distinctes pour 
l'affichage de chacun de ces groupes d'inserts 
dans les fenêtres Mix et Edit.

Pour afficher les inserts dans la fenêtre Edit :

Effectuez l'une des opérations suivantes :

• View > Fenêtre Edit > Inserts A–E.

• View > Fenêtre Edit > Inserts F–J.

Pour afficher les inserts dans la fenêtre Mix :

Effectuez l'une des opérations suivantes :

• View > Fenêtre Mix > Inserts A–E.

• View > Fenêtre Mix > Inserts F–J.

Pour plus d'informations sur l'accès aux 
inserts F à J à partir des surfaces de contrôle 
de Pro Tools, voir “Accès à 10 inserts”, 
page 127.

Inserts A–E et F–J dans la fenêtre Edit

Inserts A–E et F–J dans la fenêtre Mix
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Améliorations au niveau de 
l'enregistrement avec 
compensation de retard 
automatique
La compensation de retard automatique 
s'applique désormais aux départs ainsi qu'aux 
inserts, pour compenser les retards de mixage 
inhérents aux bus. Dans la plupart des cas, vous 
pouvez désormais effectuer des enregistrements 
dans Pro Tools avec la fonction Delay 
Compensation activée. 

Lorsque la fonction Delay Compensation 
est activée, il est conseillé de ne pas utiliser 
d'inserts sur les pistes d'entrée auxiliaire ou 
de fader principal utilisées éventuellement 
pour contrôler le volume du mixage de 
retour. En outre, évitez d'utiliser des inserts 
sur des pistes d'enregistrement. Certains 
inserts de latence réduite peuvent être 
acceptables en fonction des préférences 
artistiques.
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chapitre 9

Plug-in

Plug-in Creative Collection
(RTAS uniquement)

La nouvelle suite de plug-in Pro Tools Creative 
Collection inclut plusieurs plug-in 
d'instruments virtuels et d'effets RTAS conçus 
par le groupe de recherche instrumentale 
avancée de Digidesign.

Instruments Creative Collections

Boom

Boom est un instrument de batterie pour 
Pro Tools, inspiré des boîtes à rythme classiques. 
Doté d'un séquenceur de modèles de type boîte à 
rythme, Boom offre une dizaine de kits 
différents orientés musique électronique, avec 
des fonctionnalités exceptionnelles de mise en 
forme audio.

DB-33

DB-33 est un orgue virtuel à roues phoniques 
pour Pro Tools avec enceinte acoustique à effet 
Leslie et émulation de préamplification à tube. 
Doté de tirettes et percussions variables, et de 
différents modèles de roues phoniques, le DB-33 
fournit une gamme variée de sons d'orgue 
classiques.

Pour plus d'informations, consultez le 
Guide des plug-in Pro Tools Creative 
Collection. 
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Mini Grand

Mini Grand est un piano virtuel haute qualité 
conçu pour Pro Tools. Vous pouvez choisir 
parmi sept modèles de piano, avec huit vélocités 
différentes par tonalité, afin de mieux répondre 
aux exigences acoustiques de votre piano.

Structure Free

Structure® Free est un séquenceur Pro Tools qui 
fournit certaines des fonctionnalités clés de la 
version complète de Structure. Structure Free 
vous permet d'intégrer rapidement et facilement 
un large éventail d'échantillons dans vos 
sessions Pro Tools.

Vacuum

Vacuum est un synthétiseur analogique unique 
pour Pro Tools utilisant la technologie des tubes 
à vide pour les instruments lead, les basses et des 
effets spéciaux énergiques. Doté d'un look 
vintage dépouillé en totale harmonie avec son 
son rétro, Vacuum fournit des capacités de 
modulation développées et un caractère 
acoustique prononcé.

Xpand!2

Xpand!2 est un synthétiseur virtuel pour 
Pro Tools proposant une large gamme de sons 
pratiques. Xpand!2 est fourni avec 1,5 Go de 
contenu qui comprend tout ce dont vous avez 
besoin, des claviers aux guitares, basses, 
batteries, instruments symphoniques et boucles 
rythmiques.

Si la version complète de Structure ou 
Structure LE est déjà installée sur votre 
système, Structure Free ne sera pas installé.
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Effets Creative Collection

Egaliseur

KillEQ Egaliseur 3 bandes avec commandes Kill 
sur chaque bande, permettant de couper 
complètement les fréquences basses, moyennes 
et hautes, pour des effets exceptionnels.

Vintage Filter Fournit un filtre de résonance 
multimode réglable manuellement ou 
modulable grâce à l'oscillateur à basse fréquence 
et au suiveur d'enveloppe intégrés.

Reverb

Reverb Offre une acoustique naturelle 
permettant d'émuler le son d'espaces de 
volumes différents.

Nonlinear Reverb Imite les effets de réverbération 
“coupés” classiques des années 80.

Spring Reverb Simule une réverbération à ressort 
classique des amplis de guitare et des effets 
studio rétro.

Délai

Dynamic Delay Fournit un effet d'écho atténué, 
qui est inaudible lorsqu'un signal est présent, 
puis qui s'ouvre en fondu.

MultiTap Delay Fournit plusieurs délais 
entrecroisés pour des effets d'écho complexes.

Modulation

Chorus  Fournit des effets de modulation de la 
hauteur du chorus pour la guitare, le clavier et 
les voix.

Ensemble Fournit une palette d'effets vibrants 
alliant classicisme et fluidité, parfaits pour les 
accords et les sons d'arrière-plan.

Flanger Fournit des effets de modulation de la 
hauteur de flanging pour produire des balayages 
de sons prononcés et résonnants.

MultiChorus Permet des effets de chorus empilés 
avec commande individuelle de la profondeur et 
le taux de chorus chaque couche.

Phaser Fournit des effets de modulation de la 
hauteur de phaser, avec un balayage plus lisse et 
plus subtil que l'effet Flanger.

Filter-Gate-Sequencer Effet séquenceur filtre-
porte, pour un contrôle précis du timbre et de 
l'amplitude au fil du temps. Le plug-in Filter-
Gate-Sequencer ajoute une animation 
rythmique aux notes étendues et aux parties 
rythmiques.

Harmonique

Decimator Effectue une réduction de la 
résolution et de la fréquence d'échantillonnage 
d'un signal pour ajouter des artefacts de 
craquements ou retentissants.

Distortion Amplifie le signal et l'écrête pour 
ajouter du mordant au son et le rendre plus 
crasseux et craquant. 

Enhancer Synthétise les hautes fréquences 
additionnelles pour améliorer les signaux 
sourds.

Freq Shifter Fournit des effets de décalage de 
hauteur parfaitement adaptés aux sons de 
guitare et de clavier.

Si Xpand! est déjà installé sur votre 
système, l'installation de Xpand!2 
remplacera Xpand! Toutes les présélections 
Xpand! sont copiées dans le dossier Plug-in 
Presets de Xpand!2 et seront accessibles 
dans Xpand!2.
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FuzzWah Applique une distorsion puissante et 
des effets wah-wah balayés parfaits pour la 
guitare, le piano électrique et les sons d'orgue.

Talkbox Emule une pédale wah-wah commandée 
vocalement pour des effets rétro de guitare solo.

Champ acoustique

StereoWidth Elargit les signaux mono dans le 
champ stéréo et contrôle précisément la largeur 
des signaux stéréo.

Plug-in supplémentaires 
installés avec Pro Tools
(TDM, RTAS et AudioSuite)

Les plug-in suivants, payants dans les versions 
précédentes, sont désormais gratuits et installés 
avec Pro Tools :

• Digidesign Maxim

• Digidesign D-Fi

• Sci-Fi

• Lo-Fi

• Recti-Fi

• VariFi

• Bomb Factory Sans Amp

Eleven Free

(RTAS uniquement)

Le plug-in Eleven Free est installé avec 
Pro Tools. Eleven Free offre deux amplis de 
guitare personnalisés et deux modèles 
d'enceintes, sélectionnés parmi les meilleurs 
effets rétro et modernes, toute catégorie 
confondue, de la version complète d'Eleven. 

Utilitaires TL inclus avec 
Pro Tools
(TDM et RTAS)

Les plug-in utilitaires TL™, options payantes 
dans les versions précédentes, sont désormais 
gratuits et installés avec Pro Tools.

Ils comprennent les plug-in suivants :

• TL Metro

• TL InTune

• TL MasterMeter

Pour plus d'informations sur ces plug-in en 
particulier ou d'autres plug-in, consultez le 
Guide des plug-in Digidesign et le Guide des 
plug-in Bomb Factory.

Pour plus d'informations, consultez le 
Guide Eleven Free.

Pour plus d'informations sur les utilitaires 
TL et autres plug-in TL Labs, consultez le 
Guide des plug-in TL Labs.
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Améliorations des plug-in 
DigiRack

Version stéréo de DigiRack EQ III

Les plug-in DigiRack™ EQ III sont désormais 
disponible en version stéréo, ainsi que mono et 
multimono. Notez que pour la version stéréo, les 
indicateurs d'entrée et de sortie affichent la 
somme des canaux droit et gauche.

Amélioration de RTAS DigiRack 
D-Verb 

La version RTAS de DigiRack D-Verb™ inclut 
désormais un effet chorus très subtil dans les 
options Church et Hall. Cela donne plus de 
corps au son de réverbération, permettant ainsi 
d'imiter davantage l'acoustique d'une église ou 
d'une salle de concert. 

L'effet chorus a toujours existé pour les options 
Church et Hall des versions AudioSuite et TDM, 
mais il ne figurait pas à l'origine dans la version 
RTAS afin de limiter la sollicitation du 
processeur hôte. 

Amélioration du 
glisser-déposer dans les 
plug-in

Régions MIDI

Pro Tools permet désormais le glisser-déposer de 
régions MIDI à partir des pistes, de la liste des 
régions ou des navigateurs DigiBase vers certains 
plug-in d'instruments virtuels. Cela est 
particulièrement utile pour certains instruments 
virtuels, comme Transfuser de Digidesign, qui 
fournit des séquenceurs MIDI. 

Groupes de régions

Pro Tools permet désormais le glisser-déposer de 
groupes de régions à partir des pistes, de la liste 
des régions ou des navigateurs DigiBase vers 
certains plug-in d'instruments virtuels. Cela est 
particulièrement utile pour certains plug-in 
d'instrument comme Transfuser de Digidesign.

Recherche et rétablissement 
des liens des plug-in 
Lors de l'ouverture d'une session Pro Tools avec 
certains plug-in d'instrument permettant 
l'importation et la lecture de fichiers audio 
(Transfuser de Digidesign, par exemple), la 
commande Find and Relink est lancée 
automatiquement s'il manque des fichiers audio 
pour le plug-in.
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Améliorations des aperçus 
AudioSuite
La fenêtre AudioSuite fournit désormais le 
contrôle du volume et des vumètres pour les 
aperçus du traitement AudioSuite. Des 
améliorations ont également été apportées au 
délai nécessaire pour le lancement et l'arrêt de 
l'aperçu AudioSuite, ainsi qu'au délai de réponse 
pour le déplacement des commandes de plug-in 
au cours de l'aperçu.

Preview Volume

La commande Preview Volume vous permet de 
régler le volume d'aperçu du traitement 
AudioSuite.

Pour régler le volume d'aperçu du traitement 
AudioSuite :

1  Cliquez sur la commande Preview Volume.

2  Dans la fenêtre contextuelle de fader qui 
s'affiche, faites glisser le curseur vers le haut pour 
augmenter le volume d'aperçu et vers le bas pour 
le diminuer.

Vumètres du niveau de volume de l'aperçu

Ces vumètres affichent les niveaux d'aperçu du 
traitement AudioSuite. Cela vous permet 
notamment de surveiller l'écrêtage du signal 
traité.

Chemins d'écoute des aperçus 
AudioSuite

(Pro Tools HD uniquement)

Sur les systèmes Pro Tools|HD dotés de plusieurs 
interfaces audio, l'aperçu AudioSuite peut 
désormais être assigné à n'importe quel chemin 
de sortie audio sur une interface du système.

Pour configurer un chemin d'écoute :

1  Sélectionnez Setup > I/O et cliquez sur l'onglet 
Output.

2  Dans le menu déroulant Audition Paths, 
sélectionnez le chemin d'écoute de votre choix.

 Fenêtre AudioSuite, plug-in Invert affiché

Réglage du volume d'aperçu du traitement AudioSuite

Vumètres de niveau de l'aperçu
Volume de l'aperçu
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chapitre 10

Améliorations et nouveautés du contrôleur 
Pro Tools

Pro Tools 8.0 fournit de nombreuses nouveautés 
et améliorations des surfaces de contrôle 
Digidesign et des surfaces de travail ICON.

Accès à 10 inserts

Accès aux inserts sur D-Control

Lorsque vous appuyez sur la touche Inserts 
d'une voie, les noms de plug-in s'affichent en 
deux groupes de cinq (Inserts A–E ou Inserts F–J) 
sur les affichages des codeurs. 

Vous pouvez utiliser le mode Flip pour transférer 
les commandes d'un insert (A–J) des codeurs du 
canal vers les faders. 

Pour basculer entre l'affichage des inserts A à E et 
F à J sur une voie :

1  Appuyez sur la touche Inserts dans la section 
de commandes Channel Strip Mode de la voie 
pour afficher les inserts de niveau supérieur.

2  Appuyez sur les touches Page Up et Page Down 
pour alterner cet affichage entre les deux 
ensembles de cinq inserts (A à E et F à J). 

Pour afficher les paramètres d'un plug-in 
individuel :

Appuyez sur la touche Select du codeur 
correspondant. 

Pour revenir à l'affichage de plug-in supérieur sur la 
voie :

Appuyez sur la touche Inserts.

Accès aux inserts sur D-Command

Lorsque vous appuyez sur la touche Inserts, vous 
passez en mode Inserts et les noms des deux 
premiers plug-in de cette voie s'affichent sur les 
affichages de codeurs. Les 10 inserts disponibles 
s'affichent sous la forme de cinq paires (A–B, 
C–D, E–F, G–H, I–J).

Pour faire défiler l'affichage des inserts A à J sur 
une voie :

Appuyez sur la touche Page préc. ou Page suiv.
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Accès aux inserts sur ProControl

La section DSP Edit/Assign permet d'afficher et 
d'assigner des inserts en deux groupes de cinq 
(inserts A à E et inserts F à J) pour toute voie.

Pour afficher des inserts dans la section DSP 
Edit/Assign :

1  Appuyez sur la touche INS/SEND d'un canal 
pour le sélectionner dans la section DSP 
Edit/Assign.

2  Appuyez sur la touche INSERT/PARAM de la 
section DSP Edit/Assign.

3  Appuyez sur la touche PRE/POST située en bas 
de la section DSP Edit/Assign pour basculer 
l'affichage entre les inserts A à E et F à J.

Pour visualiser et basculer entre l'affichage des 
inserts A à E et F à J dans la section DSP 
Edit/Assign :

1  Appuyez sur la touche INS/SEND d'un canal 
pour le sélectionner dans la section DSP 
Edit/Assign.

2  Maintenez la touche Maj enfoncée et appuyez 
sur la touche INSERT/PARAM de la section DSP 
Edit/Assign.

Accès aux inserts sur C|24

Lorsque vous appuyez sur la touche Insert d'une 
voie, C|24™ passe en vue Insert Select, dans 
laquelle les commandes d'insert du canal sont 
affichées horizontalement sur l'écran à cristaux 
liquides. 

Pour afficher des inserts sur une piste :

1  Appuyez sur la touche Insert dans la voie de la 
piste. La touche s'allume pour signaler la 
sélection de la piste.

Le volet gauche de l'écran à cristaux liquides 
affiche le nom de la piste sur la première ligne et 
“Inserts” sur la dernière ligne. 

2  Le cas échéant, appuyez sur les touches 
Channel Bar Scroll pour permuter l'affichage des 
inserts A à E et F à J.

Pour chaque insert attribué à la piste, l'écran à 
cristaux liquides affiche la position et le nom de 
l'insert sur la première ligne, et le statut de 
désactivation de l'insert, ainsi que la mention 
“more” sur la ligne du bas.

Pour chaque position d'insert sans attribution, 
l'écran à cristaux liquides affiche “No Insert” sur 
la première ligne et “assign” sur la dernière 
ligne.

Accès aux inserts sur Control|24

Lorsque vous appuyez sur la touche Insert d'une 
voie, Control|24™ passe en vue Insert Select, 
dans laquelle les inserts du canal sont affichés 
horizontalement sur les écrans de l'afficheur 
alphanumérique. 

Pour afficher des inserts sur une piste :

1  Appuyez sur la touche Inserts dans la voie de la 
piste.

Le nom de la piste s'affiche sur l'écran Channel 
Bar et les cinq premiers inserts s'affichent sur les 
afficheurs alphanumériques du canal. 

2  Le cas échéant, appuyez sur les touches 
Channel Bar Scroll pour permuter l'affichage des 
inserts A à E et F à J.

Les afficheurs alphanumériques du canal 
affichent le nom de l'insert pour chaque insert 
attribué sur la piste.

Pour chaque position d'insert sans attribution, 
l'afficheur alphanumérique indique la mention 
“No Insert”.
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Accès aux inserts sur Command|8

Inserts en mode Console View

Lorsque Command|8 est en mode Console 
View, l'affichage permet de voir le nom des 
inserts actuellement attribués placés sur toutes 
les voies pour une position d’insert donnée 
(inserts A à J dans Pro Tools).

Pour afficher les inserts sur une position d’insert 
sur toutes les pistes :

1  Pour faire passer Command|8 en mode 
Console, appuyez sur la touche Insert située à 
gauche des codeurs rotatifs. 

2  Effectuez l'une des opérations suivantes :

• Pour afficher une position d'insert A à E, 
appuyez sur la touche A à E 
correspondante. 

– ou –

• Pour afficher l'un des inserts F à J, 
maintenez la touche Shift/Add enfoncée et 
appuyez sur la touche correspondante (A=F, 
B=G, C=H, D=I, ou E=J). Le clignotement 
des touches indique l'affichage des inserts 
F à J.

Inserts en mode Channel View

Lorsque Command|8 est en mode Channel 
View, l'écran affiche les noms de tous les inserts 
de la piste sélectionnée. 

Pour afficher tous les inserts sur une seule piste 
(Channel View) :

1  Dans la ligne Channel View, appuyez sur la 
touche Insert :

2  Appuyez sur une touche de sélection de canal 
allumée. 

3  Effectuez l'une des opérations suivantes :

• Pour afficher les inserts A à E, appuyez sur 
la touche Page gauche. 

– ou –

• Pour afficher les inserts F à J, appuyez sur la 
touche Page droite.

Affectation de plug-in
Pro Tools vous permet de personnaliser la 
disposition des paramètres de plug-in sur les 
surfaces de contrôle prises en charge. Vous 
pouvez enregistrer ces assignations de plug-in 
personnalisées en tant que présélections afin de 
les utiliser sur différentes sessions et systèmes.

Mode d'apprentissage des plug-in

Vous pouvez placer les plug-in en mode Learn, à 
partir duquel tous les paramètres de plug-in 
automatisables peuvent être affectés à un 
codeur, une touche ou, en mode Flip, un fader 
de voie sur la surface de contrôle. 

Présélections d'assignations de plug-in

Vous pouvez enregistrer une assignation de 
plug-in et la rappeler pour tout autre plug-in de 
même type. 

Il est possible d'enregistrer plusieurs 
présélections d'assignation pour un même 
plug-in et de passer d'une assignation à l'autre à 
tout moment au cours d'une session. 

Vous pouvez également utiliser plusieurs 
présélections sur différentes instances d'un 
plug-in simultanément. Cela peut s'avérer utile 
pour les plug-in d'instruments virtuels à 
plusieurs configurations ou pour les 
environnements de travail multi-utilisateurs sur 
des systèmes de grande envergure.
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Vous pouvez définir une assignation 
personnalisée de plug-in en tant qu'assignation 
par défaut, de manière à ce que la même 
assignation soit utilisée pour toutes les instances 
par défaut de ce plug-in.

Fichiers d'assignations de plug-in

Les fichiers d'assignations de plug-in peuvent 
être exportés (en tant que fichiers .pim) pour être 
utilisés dans d'autres sessions et sur d'autres 
systèmes avec une surface de contrôle de type 
similaire (surface 8 faders ou 24 faders ou surface 
ICON). 

Assignation de surfaces de contrôle

Lorsque vous créez une assignation de plug-in 
personnalisée, ses paramètres sont disposés sur 
des pages correspondant aux commandes de la 
surface de contrôle. La taille d'une page 
correspond au type de surface de contrôle. 
Chaque assignation de plug-in personnalisée 
permet de stocker jusqu'à 200 pages de 
paramètres assignés.

Les assignations de plug-in sont stockées en 
fonction des types de surfaces de contrôle 
suivantes : 

Surfaces à 8 faders Les modèles suivants 
disposent d'une taille de page de 8 
codeurs/touches assignables :

• Command|8

Surfaces à 24 faders Les modèles suivants 
disposent d'une taille de page de 24 
codeurs/touches assignables :

• C|24

• Control|24

Surfaces ICON Les modèles suivants sont dotés 
de codeurs et de touches assignables séparément 
avec les tailles de page suivantes :

• D-Control®

• Les faders personnalisés comprennent 6 
rangées (pages) de 8 codeurs et touches 
chacune

• Les voies comprennent 1 colonne (page) de 
6 codeurs et touches chacune

• D-Command

• Les faders personnalisés comprennent 
2 rangées (pages) de 8 codeurs et touches 
chacune

• Les voies comprennent 1 colonne (page) de 
6 codeurs et touches, deux par deux

Commandes d'assignation de 
plug-in

Lorsqu'une surface de contrôle prise en charge 
est déclarée dans Pro Tools, des commandes 
d'assignation de plug-in s'affichent dans la 
fenêtre du plug-in. 

Menu Map Options Permet de créer, renommer, 
enregistrer, supprimer, importer, exporter et 
définir des assignations de plug-in par défaut. 

Les assignations de plug-in ne sont pas 
prises en charge avec ProControl™.

Si vous importez une assignation de plug-in 
créée sur un type de surface de contrôle 
différent, elle s'affichera comme option 
inactive dans le menu Map Presets.

Commandes d'assignation de plug-in dans la fenêtre de 
plug-in

Menu Map Options

Menu Map Presets

Bouton Learn

Menu Parameter
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Menu Map Presets Permet de choisir parmi les 
assignations personnalisées de plug-in 
disponibles pour le plug-in. 

Bouton Learn Place le plug-in en mode 
d'apprentissage, dans lequel vous pouvez 
assigner les paramètres de plug-in à une surface 
de contrôle. 

Menu Parameter En mode d'apprentissage, vous 
permet de sélectionner un paramètre sur le 
plug-in pour l'assignation. En mode 
d'apprentissage, si vous cliquez sur un paramètre 
dans la fenêtre de plug in, ce menu affiche le 
nom du paramètre. 

Création d'assignations de plug-in

Cette section détaille la création d'assignations 
de plug-in sur les surfaces de contrôle suivantes :

• C|24

• Control|24 :

• Command|8

Pour plus de détails sur l'assignation des plug-in, 
voir “Assignation de plug-in sur D-Control”, 
page 135 et “Assignation de plug-in sur 
D-Command”, page 139. 

Passage d'un plug-in en mode 
d'apprentissage

La première fois que vous placez un plug-in en 
mode d'apprentissage, une nouvelle assignation 
de plug-in est créée (intitulée par défaut Custom 
Map) et le focus du plug-in se trouve sur la 
surface de contrôle, affichant une page de 
commandes vide prête pour l'assignation.

Un seul plug-in peut être en mode 
d'apprentissage au même moment.

Pour placer un plug-in en mode d'apprentissage, 
effectuez l'une des opérations suivantes :

Cliquez sur le bouton Learn de la fenêtre du 
plug-in.

– ou –

Dans le menu déroulant Map Options, 
choisissez New Map.

Pour enlever un plug-in du mode d'apprentissage, 
effectuez l'une des opérations suivantes :

Cliquez sur le bouton Learn actif de la fenêtre 
du plug-in. 

Fermez la fenêtre du plug-in.

Cliquez sur le bouton Learn dans une autre 
fenêtre de plug-in. 

Création et modification d'assignations 
de plug-in

Pour créer une assignation personnalisée de 
paramètres de plug-in : 

1  Ouvrez le plug-in dont vous voulez 
personnaliser les assignations. 

2  Placez-le en mode d'apprentissage. Le plug-in 
est sélectionné sur la surface de contrôle, mais il 
s'affiche avec une page de commandes vide, 
prête à recevoir des assignations. 

3  Dans la fenêtre du plug-in, cliquez sur le 
paramètre de plug-in à assigner. Le nom du 
paramètre s'affiche dans le menu Parameter. 

Les plug-in sont automatiquement enlevés 
du mode Learn lorsqu'ils sont déplacés vers 
une autre position d'insert, qu'ils sont 
rendus inactifs ou que vous les convertissez 
du format TDM à RTAS. 
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4  Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Réglez le codeur ou appuyez sur la touche 
de sélection du canal sur lequel vous voulez 
assigner le paramètre. 

– ou –

• Si la surface de contrôle est en mode Flip, 
déplacez le fader ou appuyez sur la touche 
de sélection du canal à l'endroit où vous 
voulez assigner le paramètre. 

5  Répétez les étapes 3 à 4 pour chaque paramètre 
à assigner. 

6  Enlevez le plug-in du mode d'apprentissage.

Pour modifier le mappage d'un paramètre dans une 
assignation de plug-in :

1  Ouvrez le plug-in dont vous voulez modifier 
les assignations personnalisées.

2  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

3  Placez-le en mode d'apprentissage. Le plug-in 
est sélectionné sur la surface de contrôle.

4  Procédez comme suit pour chaque assignation 
de paramètre à modifier :

• Dans la fenêtre du plug-in, cliquez sur le 
nouveau paramètre de plug-in à assigner. 
Le nom du paramètre s'affiche dans le 
menu Parameter. 

– et –

• Sur la surface de contrôle, accédez au 
codeur ou à la touche où vous voulez 
modifier l'assignation, puis faites pivoter le 
codeur ou appuyez sur la touche.

5  Enlevez le plug-in du mode d'apprentissage.

Pour supprimer le mappage d'un paramètre d'une 
assignation de plug-in :

1  Ouvrez le plug-in dont vous voulez modifier 
les assignations personnalisées.

2  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

3  Placez-le en mode d'apprentissage. Le plug-in 
est sélectionné sur la surface de contrôle.

4  Procédez comme suit pour chaque assignation 
de paramètre à supprimer :

• Vérifiez que le menu Parameter affiche 
l'option No Control. 

– et –

• Sur la surface de contrôle, accédez au 
codeur ou à la touche où vous voulez 
supprimer l'assignation, puis faites pivoter 
le codeur ou appuyez sur la touche.

5  Enlevez le plug-in du mode d'apprentissage.

Gestion des assignations de 
plug-in

Vous pouvez enregistrer des assignations de 
plug-in en tant que présélections, pour les 
réutiliser sur le même système Pro Tools ou pour 
les exporter afin de les utiliser sur d'autres 
systèmes Pro Tools avec une surface de contrôle 
identique.

Enregistrement des assignations de 
plug-in

Les assignations de plug-in sont enregistrées en 
tant que préférences globales dans le système 
Pro Tools et sont par conséquent disponibles 
pour toutes les sessions créées sur le système. 

Lorsque vous créez une assignation pour un 
plug-in, elle devient disponible pour tous les 
autres plug-in du même type et du même format 
de canal. 
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Pour enregistrer une copie d'une assignation de 
plug-in personnalisée :

1  Ouvrez le plug-in dont vous voulez copier 
l'assignation.

2  Choisissez l'assignation à copier dans le menu 
contextuel Map Presets. 

3  Dans le menu déroulant Map Options, 
choisissez Save Map As. 

4  Saisissez un nom pour l'assignation de plug-in.

5  Cliquez sur OK. La nouvelle copie devient 
l'assignation de plug-in active.

Pour renommer une assignation de plug-in 
personnalisée :

1  Ouvrez le plug-in dont vous voulez renommer 
l'assignation.

2  Choisissez l'assignation à renommer dans le 
menu contextuel Map Presets. 

3  Dans le menu déroulant Map Options, 
choisissez Rename Map. 

4  Saisissez un nouveau nom pour l'assignation 
de plug-in.

5  Cliquez sur OK.

Suppression des assignations de 
plug-in

Dans la fenêtre de plug-in, vous pouvez 
supprimer des assignations individuelles de 
plug-in. 

Vous pouvez également supprimer toutes les 
assignations de plug-in personnalisées en 
rétablissant les paramètres d'usine par défaut des 
affectations de plug-in.

Pour supprimer une assignation de plug-in 
personnalisée :

1  Ouvrez le plug-in dont vous voulez supprimer 
l'assignation.

2  Choisissez l'assignation à supprimer dans le 
menu contextuel Map Presets. 

3  Dans le menu déroulant Map Options, 
choisissez Delete Current Map.

4  Cliquez sur Delete.

Pour supprimer toutes les assignations de plug-in 
du système :

1  Ouvrez l'un des plug-in de la session. 

2  Dans le menu déroulant Map Options, 
choisissez Delete All Maps.

3  Cliquez sur Delete.

Pour assigner le même plug-in dans des 
formats de canal différents (par exemple, 
stéréo et Surround 5.1), vous devez créer une 
assignation de plug-in distincte pour chaque 
format.

Sur les systèmes D-Control et D-Command, 
lorsque vous supprimez toutes les 
assignations de plug-in, vous supprimez 
également toutes les assignations Custom 
Fader Plug-in. Pour plus d'informations, 
voir le Guide D-Control ou le Guide 
D-Command.
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Définition d'une assignation de plug-in 
personnalisée comme assignation par 
défaut

Vous pouvez définir une assignation de plug-in 
personnalisée en tant qu'assignation par défaut 
pour un plug-in, à la place de Factory Default 
(paramètres d'usine).

Lorsque vous définissez une assignation de 
plug-in comme configuration par défaut, cela 
s'applique à la totalité de la session. Toutes les 
instances de ce plug-in qui étaient définies sur la 
configuration Factory Default ou sur une autre 
assignation personnalisée par défaut, adoptent 
la nouvelle assignation par défaut.

Si vous modifiez l'assignation de paramètres 
dans l'assignation de plug-in personnalisée 
définie comme configuration par défaut, les 
modifications se propagent à toutes les 
instances du plug-in qui utilisent cette 
configuration.

Stockage des paramètres d'assignation de 
plug-in par défaut

Les paramètres d'assignation par défaut sont 
stockés comme préférences Pro Tools globales 
(sur l'ensemble du système), ils sont donc 
appliqués à toutes les sessions ouvertes ou créées 
ultérieurement sur ce système.

Pour définir une assignation de plug-in comme 
l'assignation par défaut :

1  Ouvrez le plug-in dont vous voulez modifier 
l'assignation par défaut.

2  Choisissez l'assignation à utiliser comme 
nouvelle configuration par défaut dans le menu 
contextuel Map Presets. 

3  Dans le menu déroulant Map Options, 
choisissez Set As Default.

Masquage des pages d'assignation de 
plug-in par défaut

Lorsque vous créez une assignation de plug-in 
personnalisée, ses paramètres sont disposés sur 
des pages correspondant aux groupes de 
commandes affichés sur la surface de contrôle. 

Lorsque vous naviguez dans les commandes de 
plug-in sur une surface de contrôle, les pages des 
assignations de plug-in personnalisées 
s'affichent en premier et les pages de 
l'assignation Factory Default s'affichent après les 
pages personnalisées.

Vous pouvez masquer les pages Factory Default 
d'un plug-in, de manière à ce que seules les 
pages personnalisées soient visibles sur la 
surface de contrôle. Cela s'applique à toutes les 
instances du plug-in. 

Lorsque vous exportez une assignation de 
plug-in, le paramètre d'assignation par 
défaut pour ce plug-in est également exporté. 
Lorsque cette assignation est importée, le 
paramètre par défaut est également mis à 
jour et toutes les instances du plug-in 
adoptent la nouvelle configuration par 
défaut. 

Si vous prévoyez d'utiliser la même 
assignation de plug-in sur plusieurs 
sessions, sauvegardez vos paramètres en 
exportant régulièrement toutes les 
assignations de plug-in et en enregistrant le 
fichier .pim avec chaque session.
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Pour masquer les pages Factory Default d'une 
assignation de plug-in :

1  Ouvrez le plug-in dont vous voulez masquer 
l'assignation par défaut.

2  Dans le menu déroulant Map Options, 
choisissez Hide Factory Default Pages.

Exportation et importation 
d'assignations de plug-in

Vous pouvez exporter les assignations de plug-in 
en tant que fichiers .pim pour les utiliser sur 
d'autres systèmes Pro Tools. 

Lorsque vous exportez des assignations de 
plug-in, vous pouvez choisir d'enregistrer des 
fichiers d'assignation personnalisés pour chaque 
plug-in ou un fichier unique qui contiendra 
toutes les assignations de plug-in du système. 

Pour exporter une assignation de plug-in 
individuelle :

1  Ouvrez le plug-in dont vous voulez exporter 
l'assignation.

2  Choisissez l'assignation à exporter dans le 
menu contextuel Map Presets. 

3  Dans le menu déroulant Map Options, 
choisissez Export Current Plug-in Map.

4  Choisissez un emplacement pour le fichier 
d'assignation.

5  Cliquez sur Save. 

Pour exporter toutes les assignations de plug-in du 
système dans un fichier unique :

1  Ouvrez l'un des plug-in de la session. 

2  Dans le menu déroulant Map Options, 
choisissez Export All Plug-in Maps.

3  Choisissez un emplacement pour le fichier 
d'assignation.

4  Cliquez sur Save. 

Pour importer un fichier d'assignation :

1  Ouvre le plug-in dans lequel vous voulez 
importer une assignation de plug-in.

2  Dans le menu déroulant Map Options, 
choisissez Import Plug-in Maps From File.

3  Localisez le fichier d'assignation (.pim) à 
importer. 

4  Cliquez sur Open.

Assignation de plug-in sur 
D-Control

Avec D-Control, vous pouvez faire passer un 
plug-in en mode d'apprentissage, sélectionner 
les paramètres pour l'assignation, puis assigner 
indépendamment deux ensembles de 
paramètres de plug-in à chaque codeur ou à sa 
touche B/M/P associée, directement à partir de 
la surface de contrôle.

Vous pouvez assigner des paramètres aux 
codeurs et aux touches B/M/P dans la section 
Custom Faders, ainsi que dans les voies. 

Sur les systèmes D-Control et D-Command, 
lorsque vous exportez toutes les 
assignations de plug-in, vous supprimez 
également toutes les assignations Custom 
Fader Plug-in qui existent vers le même 
fichier. Pour plus d'informations, voir le 
Guide D-Control ou le Guide D-Command.

Il n'est pas possible d'assigner des 
commandes aux sections EQ et Dynamics 
de D-Control.
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Lorsque vous placez un plug-in en mode 
d'apprentissage, sa piste est sélectionnée dans la 
voie Focus et elle passe automatiquement en 
mode Custom Fader Plug-in. En mode 
d'apprentissage, les affichages de codeur d'un 
plug-in sélectionné sont vides, indiquant que 
celui-ci est prêt pour l'assignation de paramètres 
aux codeurs et aux touches B/M/P. 

Préférence de la console LrnTch (Learn Touch) 

La préférence Learn Touch (dans les touches 
programmables Operation) détermine si les 
commandes sont actives lorsqu'un plug-in est 
en mode d'apprentissage. Lorsque cette 
préférence est activée, les commandes et les 
touches n'envoient pas de commandes à 
Pro Tools alors que celui-ci est en mode 
d'apprentissage, mais permettent uniquement 
les opérations du mode d'apprentissage. Cela 
vous permet de sélectionner des paramètres 
pour l'assignation à partir de la surface de 
contrôle.

Assignation de plug-in et voies

Les paramètres d'assignation de plug-in de D-
Control sont répartis par pages Channel Strip de 
6 codeurs et touches assignables séparément. 
Ces pages s'affichent, une page entière à la fois 
sur les 6 codeurs des voies dans D-Control. 

Assignation de plug-in et taille de la banque 
Custom Fader

Les paramètres d'assignation de plug-in de 
D-Control sont répartis par pages Custom Fader 
de 8 codeurs et touches assignables séparément. 

Lorsque les assignations de plug-in sont 
affichées dans les banques Plug-in Custom 
Fader, la disposition des pages d'assignation de 
plug-in suivent la valeur du paramètre 
Maximum Custom Fader Bank Size for Plug-ins 
(dans les touches programmables Operation).

Par défaut, la banque de faders personnalisés de 
gauche est utilisée, à moins que le paramètre 
Left Custom Fader Bank Size (LCF) soit défini sur 
0 ou que les faders personnalisés de gauche 
soient verrouillés. Dans ce cas, la banque de 
faders personnalisés de droite est utilisée. 

Passage d'un plug-in en mode 
d'apprentissage

Vous pouvez faire passer un plug-in en mode 
d'apprentissage directement depuis D-Control.

Pour placer un plug-in en mode d'apprentissage à 
partir de la surface de contrôle :

1  Donnez la priorité au plug-in en mode Custom 
Fader.

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
la touche Map dans la section Custom Faders.

Pour enlever un plug-in du mode d'apprentissage à 
partir de la surface de contrôle, effectuez l'une des 
opérations suivantes :

Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
la touche Map qui clignote dans la section 
Custom Faders.

– ou –

Appuyez sur la touche Win de la section 
Custom Faders pour fermer la fenêtre du 
plug-in.

Lorsque vous créez ou rappelez des 
assignations de plug-in, il est important 
d'utiliser le même paramètre Custom Fader 
Bank Size, afin de permettre la cohérence 
d'affichage des assignations de plug-in. 
Les exemples de cette section sont prévus 
pour une taille Custom Fader Bank Size de 8 
canaux.
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Création et modification d'assignations 
de plug-in

Pour créer une assignation personnalisée de 
paramètres de plug-in :

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez 
personnaliser les assignations. 

3  Placez-le en mode d'apprentissage. Le plug-in 
est sélectionné avec des codeurs et des touches 
vides, prêt pour l'assignation.

4  Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Dans le cas d'un plug-in égaliseur ou 
dynamique, vérifiez qu'un plug-in du 
même type est affiché dans la section EQ 
ou Dynamics de la surface de contrôle.

– ou –

• Pour tous les autres types de plug-in, 
affichez une instance différente du même 
type de plug-in à un deuxième 
emplacement (par exemple, sur une voie en 
mode Normal ou dans une autre banque de 
faders personnalisés).

5  Faites pivoter le codeur ou appuyez sur la 
touche correspondant au paramètre à assigner. 
Le voyant Auto du codeur ou les voyants Mute 
de la touche s'affichent. 

6  Sur le codeur sur lequel vous voulez assigner le 
paramètre, appuyez sur la touche Select du 
codeur pour permuter entre les deux affichages 
disponibles sur la commande.

7  Assignez la paramètre en procédant de l'une 
des façons suivantes :

• Faites pivoter le codeur pour assigner un 
paramètre continu ou commuté ou 
appuyez sur les touches B/M/P pour 
assigner un paramètre commuté. 

– ou –

• Si D-Control est en mode Flip, faites pivoter 
le fader pour assigner un paramètre 
continu ou commuté ou appuyez sur la 
touche Select du canal pour assigner un 
paramètre commuté. 

8  Enlevez le plug-in du mode d'apprentissage.

Pour modifier le mappage d'un paramètre dans une 
assignation de plug-in :

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez modifier 
les assignations. 

3  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

4  Placez-le en mode d'apprentissage. 
L'assignation de plug-in est sélectionnée sur la 
surface de contrôle.

5  Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Dans le cas d'un plug-in égaliseur ou 
dynamique, vérifiez qu'un plug-in du 
même type est affiché dans la section EQ 
ou Dynamics de la surface de contrôle.

– ou –

• Pour tous les autres types de plug-in, 
affichez une instance différente du même 
type de plug-in à un deuxième 
emplacement (par exemple, sur une voie en 
mode Normal ou dans une autre banque de 
faders personnalisés).
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6  Faites pivoter le codeur ou appuyez sur la 
touche correspondant au paramètre à assigner. 
Le voyant Auto du codeur ou les voyants Mute 
de la touche s'affichent. 

7  Localisez le codeur sur lequel vous voulez 
modifier le paramètre, et le cas échéant, appuyez 
sur la touche Select du codeur pour permuter 
entre les deux affichages disponibles sur la 
commande.

8  Faites pivoter le codeur ou appuyez sur la 
touche B/M/P pour assigner le paramètre.

9  Enlevez le plug-in du mode d'apprentissage.

Pour supprimer le mappage d'un paramètre d'une 
assignation de plug-in :

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez modifier 
les assignations. 

3  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

4  Placez-le en mode d'apprentissage. 
L'assignation de plug-in est sélectionnée sur la 
surface de contrôle.

5  Localisez le codeur sur lequel vous voulez 
modifier le paramètre, et le cas échéant, appuyez 
sur la touche Select du codeur pour permuter 
entre les deux affichages disponibles sur la 
commande.

6  Procédez de l'une des façons suivantes pour 
chaque assignation de paramètre à supprimer :

• Si le menu Parameter affiche No Control, 
faites pivoter le codeur ou appuyez sur la 
touche B/M/P pour supprimer l'assignation 
de paramètre.

– ou –

• Si le menu Parameter affiche le nom d'une 
présélection, maintenez enfoncée la touche 
Ctrl (Windows) ou Pomme (Mac) et 
appuyez sur la touche B/M/P pour 
supprimer l'assignation de paramètre.

7  Enlevez le plug-in du mode d'apprentissage.

Modification des présélections 
d'assignations de plug-in sur D-Control

Vous pouvez sélectionner l'assignation de 
plug-in précédente ou suivante d'un plug-in 
directement à partir de D-Control. 

Pour activer l'assignation suivante ou précédente 
d'un plug-in à partir d'une voie :

1  Donnez la priorité au plug-in dans la voie de 
sorte à afficher ses commandes sur les codeurs 
de celle-ci.

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
les touches Page Up (Suivant) ou Page Down 
(Précédent) dans les commandes Channel Strip 
Mode de la voie. Le nom de la présélection 
d'assignation de plug-in s'affiche 
momentanément dans l'affichage inférieur du 
codeur. 

Pour activer l'assignation suivante ou précédente 
d'un plug-in à partir des faders personnalisés :

1  Donnez la priorité à un plug-in de la section 
Custom Faders. 

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
les touches Page Up (Suivant) ou Page Down 
(Précédent) dans un canal Custom Fader. Le 
nom de la présélection d'assignation de plug-in 
s'affiche momentanément dans l'affichage du 
canal Custom Fader. 
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Assignation de plug-in sur 
D-Command

Avec D-Command, vous pouvez faire passer un 
plug-in en mode d'apprentissage, sélectionner 
les paramètres pour l'assignation, puis assigner 
indépendamment deux ensembles de 
paramètres de plug-in à chaque codeur ou à sa 
touche B/M/P associée, directement à partir de 
la surface de contrôle.

Vous pouvez assigner des paramètres aux 
codeurs et aux touches B/M/P dans la section 
Custom Faders, ainsi que dans les voies. 

Lorsque vous placez un plug-in en mode 
d'apprentissage, sa piste est sélectionnée dans la 
voie Focus et elle passe automatiquement en 
mode Custom Fader Plug-in. En mode 
d'apprentissage, les affichages de codeur d'un 
plug-in sélectionné sont vides, indiquant que 
celui-ci est prêt pour l'assignation de paramètres 
aux codeurs et aux touches B/M/P. 

Préférence de la console LrnTch (Learn Touch) 

La préférence Learn Touch (dans les touches 
programmables Operation) détermine si les 
commandes sont actives lorsqu'un plug-in est 
en mode d'apprentissage. Lorsque cette 
préférence est activée, les commandes et les 
touches n'envoient pas de commandes à 
Pro Tools alors que celui-ci est en mode 
d'apprentissage, mais permettent uniquement 

les opérations du mode d'apprentissage. 
Cela vous permet de sélectionner des 
paramètres pour l'assignation à partir de la 
surface de contrôle.

Assignation de plug-in et voies

Les paramètres d'assignation de plug-in de 
D-Command sont répartis par pages Channel 
Strip de 6 codeurs et touches assignables 
séparément. Ces pages s'affichent sous la forme 
de deux codeurs à chaque fois sur les voies 
D-Command.

Assignation de plug-in et taille de la banque 
Custom Fader

Les paramètres d'assignation de plug-in de D-
Command sont répartis par pages Custom Fader 
de 8 codeurs et touches assignables séparément. 

Lorsque les assignations de plug-in sont 
affichées dans les banques Plug-in Custom 
Fader, la disposition des pages d'assignation de 
plug-in suivent la valeur du paramètre 
Maximum Custom Fader Bank Size for Plug-ins 
(dans les touches programmables Operation).

Pour sélectionner l'assignation de plug-in 
précédente ou suivante sur plusieurs 
canaux, utilisez les touches Do To All et Do 
To Selected de D-Control.

Il n'est pas possible d'assigner des 
commandes aux sections EQ et Dynamics 
de D-Command.

Lorsque vous créez ou rappelez des 
assignations de plug-in, il est important 
d'utiliser le même paramètre Custom Fader 
Bank Size, afin de permettre la cohérence 
d'affichage des assignations de plug-in. 
Les exemples de cette section sont prévus 
pour une taille Custom Fader Bank Size de 
8 canaux.
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Passage d'un plug-in en mode 
d'apprentissage

Vous pouvez faire passer un plug-in en mode 
d'apprentissage directement depuis 
D-Command.

Pour placer un plug-in en mode d'apprentissage à 
partir de la surface de contrôle :

1  Donnez la priorité au plug-in en mode Custom 
Fader.

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
la touche Map dans la section Custom Faders.

Pour enlever un plug-in du mode d'apprentissage à 
partir de la surface de contrôle, effectuez l'une des 
opérations suivantes :

Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
la touche Map qui clignote dans la section 
Custom Faders.

– ou –

Appuyez sur la touche Win de la section 
Custom Faders pour fermer la fenêtre du 
plug-in.

Création et modification d'assignations 
de plug-in

Pour créer une assignation personnalisée de 
paramètres de plug-in : 

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez 
personnaliser les assignations. 

3  Placez-le en mode d'apprentissage. Le plug-in 
est sélectionné avec des codeurs et des touches 
vides, prêt pour l'assignation.

4  Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Dans le cas d'un plug-in égaliseur ou 
dynamique, vérifiez qu'un plug-in du 
même type est affiché dans la section EQ 
ou Dynamics de la surface de contrôle.

– ou –

• Pour tous les autres types de plug-in, 
affichez une instance différente du même 
type de plug-in à un deuxième 
emplacement (par exemple, sur une voie en 
mode Normal ou dans une autre banque de 
faders personnalisés).

5  Faites pivoter le codeur ou appuyez sur la 
touche correspondant au paramètre à assigner. 
Le voyant Auto du codeur ou les voyants Mute 
de la touche s'affichent. 

6  Sur le codeur sur lequel vous voulez assigner le 
paramètre, appuyez sur la touche Select du 
codeur pour permuter entre les deux affichages 
disponibles sur la commande.

7  Assignez la paramètre en procédant de l'une 
des façons suivantes :

• Faites pivoter le codeur pour assigner un 
paramètre continu ou commuté ou 
appuyez sur les touches B/M/P pour 
assigner un paramètre commuté. 

– ou –

• Si D-Command est en mode Flip, faites 
pivoter le fader pour assigner un paramètre 
continu ou commuté ou appuyez sur la 
touche Select du canal pour assigner un 
paramètre commuté. 

8  Enlevez le plug-in du mode d'apprentissage.
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Pour modifier le mappage d'un paramètre dans une 
assignation de plug-in :

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez modifier 
les assignations. 

3  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

4  Placez-le en mode d'apprentissage. 
L'assignation de plug-in est sélectionnée sur la 
surface de contrôle.

5  Sur la surface de contrôle, effectuez l'une des 
opérations suivantes : 

• Dans le cas d'un plug-in égaliseur ou 
dynamique, vérifiez qu'un plug-in du 
même type est affiché dans la section EQ 
ou Dynamics de la surface de contrôle.

– ou –

• Pour tous les autres types de plug-in, 
affichez une instance différente du même 
type de plug-in à un deuxième 
emplacement (par exemple, sur une voie en 
mode Normal ou dans une autre banque de 
faders personnalisés).

6  Faites pivoter le codeur ou appuyez sur la 
touche correspondant au paramètre à assigner. 
Le voyant Auto du codeur ou les voyants Mute 
de la touche s'affichent. 

7  Localisez le codeur sur lequel vous voulez 
modifier le paramètre, et le cas échéant, appuyez 
sur la touche Select du codeur pour permuter 
entre les deux affichages disponibles sur la 
commande.

8  Faites pivoter le codeur ou appuyez sur la 
touche B/M/P pour assigner le paramètre.

9  Enlevez le plug-in du mode d'apprentissage.

Pour supprimer le mappage d'un paramètre d'une 
assignation de plug-in :

1  Vérifiez que la préférence LrnTch (Learn 
Touch) (touches programmables Operation) est 
définie sur On. 

2  Ouvrez le plug-in dont vous voulez modifier 
les assignations personnalisées.

3  Choisissez l'assignation à modifier dans le 
menu contextuel Map Preset. 

4  Placez-le en mode d'apprentissage. 
L'assignation de plug-in est sélectionnée sur la 
surface de contrôle.

5  Localisez le codeur sur lequel vous voulez 
modifier le paramètre, et le cas échéant, appuyez 
sur la touche Select du codeur pour permuter 
entre les deux affichages disponibles sur la 
commande.

6  Procédez de l'une des façons suivantes pour 
chaque assignation de paramètre à supprimer :

• Si le menu Parameter affiche No Control, 
faites pivoter le codeur ou appuyez sur la 
touche B/M/P pour supprimer l'assignation 
de paramètre.

– ou –

• Si le menu Parameter affiche le nom d'une 
présélection, maintenez enfoncée la touche 
Ctrl (Windows) ou Pomme (Mac) et 
appuyez sur la touche B/M/P pour 
supprimer l'assignation de paramètre.

7  Enlevez le plug-in du mode d'apprentissage.
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Modification des présélections 
d'assignations de plug-in sur 
D-Command

Vous pouvez sélectionner l'assignation de 
plug-in précédente ou suivante d'un plug-in 
directement à partir de D-Command. 

Pour activer l'assignation suivante ou précédente 
d'un plug-in à partir d'une voie :

1  Donnez la priorité au plug-in dans la voie de 
sorte à afficher ses commandes sur les codeurs 
de celle-ci.

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
les touches Page Up (Suivant) ou Page Down 
(Précédent) dans les commandes Channel Strip 
Mode de la voie. Le nom de la présélection 
d'assignation de plug-in s'affiche 
momentanément dans l'affichage inférieur du 
codeur. 

Pour activer l'assignation suivante ou précédente 
d'un plug-in à partir des faders personnalisés :

1  Donnez la priorité à un plug-in de la section 
Custom Faders. 

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, appuyez sur 
les touches Page Up (Suivant) ou Page Down 
(Précédent) dans un canal Custom Fader. Le 
nom de la présélection d'assignation de plug-in 
s'affiche momentanément dans l'affichage du 
canal Custom Fader. 

Améliorations ICON
(Tous les systèmes D-Control et D-Command)

Affichage des pistes esclaves et 
des pistes de VCA principal

Vous pouvez désactiver l'affichage des 
commandes de pistes esclaves dans les codeurs 
de pistes de VCA principal si vous ne voulez pas 
afficher ou régler les commandes de pistes 
esclaves de la voie de VCA principal. 

Pour permuter l'affichage des commandes de 
pistes esclaves dans les VCA principaux :

1  Dans la section Console Prefs Soft Keys, 
appuyez sur la touche Operation plusieurs fois 
afin d'afficher la page contenant la préférence 
d'affichage Encoder VCA (EncVCA).

2  Appuyez sur la touche programmable 
correspondant à “EncVCA” pour permuter le 
paramètre entre Yes (affichage des commandes 
de pistes esclaves dans les codeurs) et No (pas 
d'affichage des commandes de pistes esclaves). 

3  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Operations pour quitter.

Suppression des assignations de 
sortie et de départ

Lorsque vous êtes en mode Assign (normal ou 
via Assign Matrix), vous pouvez supprimer 
rapidement des assignations de sortie et de 
départ à partir de D-Control et D-Command.

Pour supprimer une assignation de sortie ou de 
départ :

Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) et appuyez sur la 
touche Select pour chaque assignation de sortie 
ou de départ à supprimer.

Pour sélectionner l'assignation de plug-in 
précédente ou suivante sur plusieurs 
canaux, utilisez les touches Do To All et Do 
To Selected de D-Command.
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Affichage des assignations d'E/S

Sur D-Control et D-Command, vous pouvez 
visualiser les assignations d'E/S de chaque canal 
dans un nouvel affichage d'E/S.

Les assignations d'E/S s'affichent dans la partie 
inférieure du codeur du canal, selon le type de 
piste. Les assignations sont affichées du haut 
vers le bas, comme suit : 

• Pistes d'entrée audio et auxiliaire

• Entrée

• Sortie

• Pistes d'instrument

• Entrée MIDI

• Sortie MIDI

• Entrée Aux

• Sortie Aux

• Pistes MIDI

• Entrée MIDI

• Sortie MIDI

• Pistes de fader principal

• Sortie

• Pistes de VCA principal

• Assignation de groupe

Pour afficher les assignations d'E/S d'une piste : 

Maintenez enfoncée la touche Sends sur la 
piste. La touche Sends s'allume pour signaler 
l'affichage d'E/S (I/O View). 

Affichage des assignations de sorties 
multiples (pistes audio ou MIDI)

Pour les pistes audio ou MIDI possédant 
plusieurs assignations de sortie, un signe plus (+) 
précède le nom de la sortie.

Pour afficher les noms de plusieurs assignations de 
sortie :

1  Maintenez enfoncée la touche Sends sur la 
piste comprenant plusieurs assignations de 
sortie. La touche Sends s'allume pour signaler 
l'affichage d'E/S (I/O View).

2  Appuyez sur la touche B/M/P sous un nom de 
sortie précédé du signe plus (+). Les noms de 
chemins de sortie s'étendent sur les affichages 
des codeurs de la piste. 

3  Pour quitter cet affichage des sorties, appuyez 
sur l'une des touches B/M/P allumées de chemin 
de sortie. 

Pour renommer un chemin d'E/S sur une piste 
audio :

1  Maintenez enfoncée la touche Sends sur la 
piste. La touche Sends s'allume pour signaler 
l'affichage d'assignations d'E/S.

2  Si plusieurs assignations sont présentes sur la 
piste, appuyez sur la touche B/M/P sous un nom 
de sortie précédé du signe plus (+). Les noms de 
chemins de sortie s'étendent sur les écrans du 
codeur de la piste. 

3  Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) et appuyez sur la 
touche B/M/P sous le chemin d'E/S à renommer.

4  Entrez le nouveau nom du chemin.

5  Cliquez sur OK. 

Sur D-Command, lorsque les assignations 
d'E/S d'une piste d'instrument sont 
affichées, appuyez sur les touches Page Up 
et Page Down pour afficher les assignations 
supplémentaires.
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Affichage de plusieurs assignations 
(départs)

Un signe plus (+) précède le nom des départs 
possédant plusieurs assignations.

Pour afficher les noms de plusieurs assignations de 
départ :

1  Appuyez sur la touche Sends sur la piste 
comprenant plusieurs assignations.

2  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche B/M/P sous un nom de sortie précédé du 
signe plus (+). Les noms de chemins de départs 
s'étendent sur les écrans du codeur de la piste.

3  Pour quitter cet affichage, appuyez sur l'une 
des touches B/M/P allumées de chemin de 
départ. 

Pour renommer un nom de départ :

1  Appuyez sur la touche Sends de la piste 
contenant le départ à renommer.

2  Si la piste comporte plusieurs départs, 
maintenez la touche Ctrl (Windows) ou Pomme 
(Mac) enfoncée, appuyez sur la touche B/M/P 
sous un nom de sortie précédé du signe plus (+). 
Les noms de chemins de départs s'étendent sur 
les écrans du codeur de la piste.

3  Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) et appuyez sur la 
touche B/M/P sous le nom du chemin de départ.

4  Entrez le nouveau nom du chemin.

5  Cliquez sur OK. 

Interrogation du bus et des 
assignations d'E/S

Sur D-Control et D-Command, vous pouvez 
identifier rapidement les assignations de bus et 
d'E/S d'une session.

Fonctionnement temporaire ou permanent

Lors de l'interrogation des assignations de bus 
ou d'E/S, vous pouvez choisir de les afficher 
momentanément ou de façon permanente. 
(Voir les sections Interrogation des assignations de 
bus et Interrogation des assignations d'E/S, 
ci-dessous.) L'affichage permanent des 
assignations est utile lors de la création de 
banques de faders pour localiser les indications 
hors banque.

Pour afficher momentanément les assignations 
d'E/S ou de bus : 

Faites pivoter le codeur qui affiche 
l'attribution :

Pour afficher de façon permanente les assignations 
d'E/S ou de bus :

Appuyez deux fois sur le codeur qui affiche 
l'attribution : 

Pour quitter le mode d'affichage permanent des 
assignations d'E/S ou de bus :

Appuyez sur la touche Escape qui clignote. 
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Indications hors banque

Lors de l'interrogation des assignations de bus 
(en mode d'affichage temporaire ou 
permanent), les assignations hors banque sont 
indiquées par des touches Bank/Nudge 
clignotantes. Lorsque la lumière clignote 
lentement, cela signifie que l'assignation est à 
une pression d'écart sur le bouton ; si le 
clignotement est rapide, elle est à plusieurs 
pressions d'écart sur le bouton. Les indications 
hors banque sont affichées comme suit :

D-Control Lors de l'interrogation d'un bus ou 
d'une assignation d'E/S, la touche 
programmable affiche Nudge 1, Nudge 8 et 
Bank. Les touches programmables gauche et 
droite clignotent pour indiquer la présence 
d'assignations hors banque. 

D-Command Les touches Bank/Nudge clignotent 
pour indiquer la présence d'assignations hors 
banque. 

Interrogation des assignations de bus

D-Control et D-Command permettent 
l'interrogation vers l'avant des sorties vers les 
chemins de bus et l'interrogation vers l'arrière 
d'entrées depuis les chemins de bus sur les pistes 
audio et les pistes d'entrée auxiliaires. 

Pour interroger une sortie de piste vers un bus 
(interrogation de bus vers l'avant) :

1  Maintenez enfoncée la touche Sends sur la 
piste comprenant le bus comme assignation de 
sortie. Le canal passe en vue I/O, affichant 
l'entrée et la sortie de la piste dans ses codeurs de 
voies.

2  Faites pivoter le codeur affichant l'assignation 
de bus sur la sortie (ou appuyez deux fois 
dessus). La touche Select du canal clignote sur 
les pistes sur lesquelles ce bus est assigné comme 
entrée.

Pour interroger un départ vers un bus (interrogation 
de bus vers l'avant) :

1  Appuyez sur la touche Sends sur la piste 
comprenant le bus comme assignation de 
départ. 

2  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et appuyez sur la touche B/M/P 
sous le nom du départ. Tous les départs de cette 
piste s'étendent sur les codeurs de piste.

3  Faites pivoter le codeur affichant l'assignation 
de bus sur le départ (ou appuyez deux fois 
dessus). La touche Select du canal clignote sur 
les pistes sur lesquelles ce bus est assigné comme 
entrée.

Pour interroger une entrée de piste depuis un bus 
(interrogation de bus vers l'arrière) : 

1  Maintenez enfoncée la touche Sends sur la 
piste comprenant le bus comme assignation 
d'entrée. Le canal passe en vue I/O, affichant 
l'entrée et la sortie de la piste dans ses codeurs de 
voies.

2  Faites pivoter le codeur affichant l'assignation 
de bus sur l'entrée (ou appuyez deux fois dessus). 
La touche Select du canal clignote sur les pistes 
comprenant le bus comme entrée. La touche 
Select et la touche Send du canal clignotent sur 
les pistes comprenant ce bus comme assignation 
de départ. 

Interrogation des assignations d'E/S

D-Control et D-Command permettent 
l'interrogation des assignations d'entrée et de 
sortie correspondantes (notamment les chemins 
d'interface, de bus ou MIDI) sur les pistes audio, 
d'entrée auxiliaire, MIDI, d'instrument ou de 
fader principal.
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Pour interroger une entrée ou une sortie de piste : 

1  Maintenez enfoncée la touche Sends sur la 
piste comprenant l'assignation d'entrée ou de 
sortie. Le canal passe en vue I/O, affichant 
l'entrée et la sortie de la piste dans ses codeurs de 
voies.

2  Maintenez la touche Maj enfoncée et faites 
pivoter le codeur affichant l'assignation d'entrée 
ou de sortie (ou appuyez deux fois dessus). 
La touche Select du canal clignote sur toutes les 
pistes comprenant la même entrée ou sortie. 

Matrice d'assignation

D-Control et D-Command permettent 
l'assignation rapide de plug-in, de départs et 
d'acheminements d'E/S aux pistes d'une session. 
Au lieu d'effectuer l'assignation en développant 
chaque niveau du codeur jusqu'au plus détaillé, 
la fonctionnalité Assign Matrix utilise 
temporairement une section de 6 x 8 codeurs 
(sur D-Control) et une section de 2 x 8 codeurs 
(sur D-Command), permettant d'afficher 
plusieurs couches de navigation simultanément.

Activation du fonctionnement Assign 
Matrix

La préférence de console AsnMtx (Assign 
Matrix) (dans les touches programmables 
Operation) détermine si la surface de contrôle 
suit le même comportement que le mode Assign 
hérité ou le fonctionnement Assign Matrix. 

Lorsque cette préférence est activée, la fonction 
Assign Matrix est utilisée pour assigner des 
inserts, des départs ou les acheminements d'E/S 
sur la surface de contrôle.

Mode Insert Assign Matrix

Le mode Insert Assign Matrix affiche les 
positions d'insert (A à J) et les informations 
relatives aux inserts, tel le type d'insert (TDM, 
RTAS, HW), la catégorie de plug-in (EQ ou DYN, 
par exemple), le fabricant et le nom du plug-in 
dans les codeurs Assign Matrix.

Pour passer en mode Insert Assign Matrix :

1  Appuyez sur la touche Inserts du canal auquel 
vous voulez assigner un insert.

2  Procédez de l'une des façons suivantes pour 
l'insert à assigner : 

• Si aucun insert ne figure à la position 
d'insert, appuyez sur la touche Select du 
codeur.

– ou –

• Si un insert est déjà présent, appuyez sur la 
touche Select du codeur et maintenez-la 
enfoncée. 

Mode Send Assign Matrix

La matrice Send Assign affiche les positions de 
départ (A à J) et les informations relatives aux 
départs, comme le type de départ (HW, Bus) et le 
nom du départ dans les codeurs Assign Matrix.

Pour passer en mode Send Assign Matrix :

1  Appuyez sur la touche Sends du canal auquel 
vous voulez assigner un départ.

2  Procédez de l'une des façons suivantes pour le 
départ à assigner : 

• Si aucun départ ne figure à la position de 
départ, appuyez sur la touche Select du 
codeur.

Pour plus d'instructions relatives à 
l'interrogation des assignations de bus et 
d'E/S dans la matrice d'assignation, voir le 
Guide D-Control ou le Guide D-Command.

Pour des instructions détaillées sur 
l'utilisation de la fonction Assign Matrix 
pour l'assignation d'inserts, de départs et 
d'acheminements d'E/S, voir le Guide 
D-Control ou D-Command.
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– ou –

• Si un départ est déjà présent, appuyez sur la 
touche Select du codeur et maintenez-la 
enfoncée. 

Mode I/O Assign Matrix

Selon le type de piste, la matrice I/O Assign 
affiche l'entrée et la sortie audio ou MIDI, les 
assignations de groupes VCA ou la sortie de 
fader principal dans les codeurs Assign Matrix.

Pour passer en mode I/O Assign Matrix :

1  Maintenez enfoncée la touche Sends du canal 
auquel vous voulez assigner l'acheminement 
d'E/S.

2  Appuyez sur la touche Select du codeur pour 
l'entrée, la sortie ou l'assignation de groupe à 
assigner.

Modifications des touches 
programmables

Pro Tools 8.0 apporte les modifications 
suivantes aux pages de touches programmables 
de D-Control et D-Command.

Touches programmables lorsque 
aucune session n'est ouverte

Lorsque aucune session Pro Tools n'est ouverte, 
les touches programmables D-Control et D-
Command affichent les commandes suivantes :

Touche Window

Page 1

• Task Managr : Window > Task Manager

• Disk Space : Window > Disk Space

• System Usage : Window > System Usage

Page 2

• I/O Setup : Setup > I/O

• HW Setup : Setup > Hardware

• PB Engine : Setup > Playback Engine

• Preferences : Setup > Preferences

• Peripherals : Setup > Peripherals

Touche Audio Files

• Sessions récentes (jusqu'à 2 pages)

Touches programmables dans Pro Tools

Sur D-Control et D-Command, la disposition 
des commandes sur les pages de touches 
programmables suivantes a changé. 

Touche Window

La touche Window affiche les commandes 
suivantes :

Page 4

• Window Confgs : Window > 
Configurations > Window Configuration 
List

• MIDI Editor : Window > MIDI Editor

• Score Editor : Window > Score Editor

Page 5

• Tile Windws : Window > Arrange > Tile

• Tile Hrzntl : Window > Arrange > Tile 
Horizontal

• Tile Vertcl : Window > Arrange > Tile 
Vertical

• Cascde Windws : Window > Arrange > 
Cascade
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Touche Audio Files

La touche Audio Files affiche les commandes 
suivantes :

Page 1

• New Sessn : File > New Session

• Open Sessn : File > Open Session

• Close Sessn : File > Close Session

• Revert Sessn : File > Revert to Saved

• Save As : File > Save As

• Save Copy In : File > Save Copy In

Page 2

• Import Audio : File > Import > Audio

• Import MIDI : File > Import > MIDI

• Import SesDat : File > Import > Session 
Data

• Import RgnGrp : File > Import > Region 
Groups

• Import Video : File > Import > Video

Page 3

• Export Region : Region List Menu > Export 
Regions as Files

• Export MIDI : File > Export > MIDI

• Export OMFAAF : File > Export > Selected 
Tracks as New AAF/OMF

• Export Text : File > Export > Session Info As 
Text

Pages 4 et 5

• Recent Sessns : Open Recent Sessions (par 
nom)

Touche Edit Modes

La touche Edit Modes affiche les commandes 
suivantes :

Page 2

• Tab Trnsnt : Tab to Transients

• Dynamc Trnspt : Options > Dynamic 
Transport

• Loop Plybck : Options > Loop Playback

• Loop Record : Options > Loop Record

Configuration de fenêtres

Vous avez la possibilité d'afficher, de créer et de 
modifier les configurations de fenêtres à partir 
des touches programmables.

Pour afficher les configurations de fenêtres dans 
les touches programmables :

1  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Pomme (Mac), appuyez 
sur la touche Mem Loc de la section Select/MIDI 
Soft Keys. La touche Mem Loc clignote pour 
indiquer l'affichage des configurations de 
fenêtres. 

2  Si plus de six configurations de fenêtres 
s'affichent, appuyez sur les touches 
programmables correspondant à Page Up et 
Page Down, pour afficher les configurations 
supplémentaires.

Pour rappeler une configuration de fenêtre dans les 
touches programmables :

1  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Pomme (Mac), appuyez 
sur la touche Mem Loc de la section Select/MIDI 
Soft Keys. 

2  Appuyez sur la touche programmable 
correspondant à la configuration de fenêtre que 
vous voulez rappeler.
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Pour créer une configuration de fenêtre à partir des 
touches programmables :

1  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Pomme (Mac), appuyez 
sur la touche Mem Loc de la section Select/MIDI 
Soft Keys. 

2  Appuyez sur une touche programmable 
correspondant à un affichage vide.

3  Définissez les propriétés de la nouvelle 
configuration de fenêtre dans la boîte de 
dialogue New Window Configuration. 

4  Appuyez sur la touche programmable 
correspondant à Entrée pour enregistrer la 
configuration de fenêtre.

Pour modifier une configuration de fenêtre à partir 
des touches programmables :

1  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Pomme (Mac), appuyez 
sur la touche Mem Loc de la section Select/MIDI 
Soft Keys.

2  Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée pendant que vous appuyez 
sur la touche programmable correspondant à la 
configuration de fenêtre à modifier.

3  Modifiez les propriétés de la configuration de 
fenêtre dans la boîte de dialogue Edit Window 
Configuration. 

4  Appuyez sur la touche programmable 
correspondant à Entrée pour enregistrer la 
configuration de fenêtre.

Pour supprimer une configuration de fenêtre à 
partir des touches programmables :

1  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Pomme (Mac), appuyez 
sur la touche Mem Loc de la section Select/MIDI 
Soft Keys.

2  Maintenez la touche Alt (Windows) ou 
Pomme (Mac) enfoncée pendant que vous 
appuyez sur la touche programmable 
correspondant à la configuration de fenêtre à 
supprimer.

Emplacements mémoire

Vous pouvez créer des emplacements mémoire à 
partir des touches programmables.

Pour créer un emplacement mémoire à partir des 
touches programmables :

1  Dans la section Select/MIDI Soft Keys, appuyez 
sur la touche Mem Loc. La touche Mem Loc 
s'allume pour indiquer l'affichage des 
emplacements mémoire. 

2  Appuyez sur une touche programmable 
correspondant à un affichage vide.

3  Définissez les propriétés du nouvel 
emplacement mémoire dans la boîte de dialogue 
New Memory Location. 

4  Appuyez sur la touche programmable 
correspondant à Entrée pour enregistrer 
l'emplacement mémoire.

Pour modifier un emplacement mémoire à partir 
des touches programmables :

1  Dans la section Select/MIDI Soft Keys, appuyez 
sur la touche Mem Loc. La touche Mem Loc 
s'allume pour indiquer l'affichage des 
emplacements mémoire. 

2  Si plus de six emplacements mémoire 
s'affichent, appuyez sur les touches 
programmables correspondant à Page 
précédente et Page suivante, pour afficher les 
emplacements supplémentaires.



Nouveautés de Pro Tools HD 8.0150

3  Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée pendant que vous appuyez 
sur la touche programmable correspondant à 
l'emplacement mémoire à modifier.

4  Modifiez les propriétés de l'emplacement 
mémoire dans la boîte de dialogue Edit Memory 
Location. 

5  Appuyez sur la touche programmable 
correspondant à Entrée pour enregistrer 
l'emplacement mémoire.

Pour supprimer un emplacement mémoire à partir 
des touches programmables :

1  Dans la section Select/MIDI Soft Keys, appuyez 
sur la touche Mem Loc.

2  Maintenez la touche Alt (Windows) ou 
Pomme (Mac) enfoncée pendant que vous 
appuyez sur la touche programmable 
correspondant à l'emplacement mémoire à 
supprimer.

Améliorations D-Control
Les améliorations suivantes ont été apportées 
aux systèmes D-Control. 

Affichage des positions d'insert et 
de départ

Vous pouvez définir D-Control de sorte qu'il 
affiche les lettres de départ et d'insert sur les 
positions de départ et d'insert qui n'ont reçu 
aucune assignation.

Pour activer l'affichage des lettres d'insert et de 
départ :

1  Dans la section Console Prefs Soft Keys, 
appuyez sur la touche Operation plusieurs fois 
afin d'afficher la page contenant la préférence 
d'affichage Show Send/Insert Letters (Lettrs).

2  Appuyez sur la touche programmable 
correspondant à Lettrs pour activer ou 
désactiver ce paramètre.

3  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Operations pour quitter.

Les écrans du codeur et de la voie D-Control et 
D-Command affichent les informations d'insert 
et de départ, comme suit :

• Lorsque la préférence Show/Send Insert 
Letters est activée, les inserts sans 
assignation affichent uniquement des 
lettres en majuscule (A à J) aux positions 
correspondantes.

• Lorsque la préférence Show/Send Insert 
Letters est activée, les départs sans 
assignation affichent uniquement des 
lettres en minuscule (a à j) aux positions 
correspondantes.

• Les inserts et les départs dotés d'assigna-
tions affichent uniquement le nom de l'in-
sert ou du départ, sans aucune lettre.

Sélection des plug-in en mode 
Custom Fader

Vous pouvez définir D-Control pour qu'il 
sélectionne les plug-in directement dans les 
faders personnalisés plutôt que les voies.

Pour activer la sélection des plug-in dans les faders 
personnalisés sur D-Control :

1  Dans la section Console Prefs Soft Keys, 
appuyez sur la touche Operation plusieurs fois 
afin d'afficher la page contenant Channel 
Editing for Plug-ins (ChanPI).

2  Appuyez sur la touche programmable 
correspondant à ChanPI pour activer le 
paramètre (sélectionner les plug-in sur les faders 
personnalisés) ou le désactiver (sélectionner les 
plug-in dans les voies). 
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3  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Operations pour quitter.

Pour donner la priorité à un plug-in dans les faders 
personnalisés :

1  Appuyez sur la touche Inserts du canal pour 
afficher les noms des plug-in sur les codeurs du 
canal. Appuyez sur les touches Page Up et Page 
Down du canal pour afficher des plug-in 
supplémentaires.

2  Appuyez sur la touche Select du codeur pour le 
plug-in auquel vous souhaitez donner la 
priorité.

Les commandes du plug-in sélectionné 
s'affichent en mode Custom Fader Plug-in.

Pour sélectionner un plug-in à l'aide du mode 
opposé du paramètre ChanPI actuel :

Maintenez les touches Ctrl+Alt (Windows) ou 
Pomme+Option (Mac) enfoncées et appuyez sur 
la touche Select d'un plug-in. 

Modifications des touches 
programmables

Sur D-Control, plusieurs pages de touches 
programmables ont des commandes nouvelles 
ou disposées à un autre emplacement.

Touche Operation

Page 6

AsnMtx (Assign Matrix Enable) Détermine si le 
mode d'assignation normal ou via la fonction 
Assign Matrix doit être utilisé pour l'assignation 
des entrées, des sorties, des inserts et des départs. 

MtxJst (Matrix Select Area Justification) 

Détermine si les lignes de matrice d'assignation 
sont disposées de haut en bas ou de bas en haut 
sur les codeurs.

PIClmn (Plug-in Menu Column Width) Détermine 
le nombre de noms de plug-in affichés par ligne 
dans la matrice d'assignation.

IOClmn (I/O Menu Column Width) Détermine le 
nombre d'étiquettes d'E/S affichées par ligne 
dans la matrice d'assignation.

MtxRws (Assign Matrix Rows) Détermine le 
nombre de lignes utilisé pour afficher des 
éléments dans la matrice d'assignation.

MtxLck (Assign Matrix Lock) Détermine si la 
matrice d'assignation est verrouillée par défaut 
ou si elle doit être placée en mode verrouillé 
manuellement.

Page 7

ChanPI (Channel Strip Editing for Plug-ins) Active 
ou désactive le paramètre de préférence qui 
active l'affichage des paramètres de plug-in 
directement sur les codeurs de canaux D-
Control. 

EncVCA (VCA Encoder Display) Détermine si les 
commandes de pistes esclaves VCA sont 
affichées dans les codeurs des canaux VCA 
principaux.

LrnTch (Learn Touch)  Détermine si les codeurs et 
les touches D-Control sont actifs lorsqu'un 
plug-in est en mode d'apprentissage. 

Lettrs (Show Send/Insert Letters) Détermine si D-
Control doit afficher les lettres de départ et 
d'insert sur les positions de départ et d'insert qui 
n'ont reçu aucune assignation.
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Améliorations D-Command
Les améliorations suivantes ont été apportées 
aux systèmes D-Command. 

Prise en charge d'une 
configuration à 40 faders

Vous pouvez ajouter jusqu'à deux modules de 
fader à l'unité principale D-Command, pour un 
total de 40 faders. Vous pouvez disposer l'unité 
principale et les modules de fader dans l'ordre de 
votre choix, de gauche à droite.

Taille maximale de la banque de faders 
personnalisés

L'option Maximum Custom Fader Bank Size 
détermine le nombre de canaux utilisés lors de 
l'affichage des canaux en modes Custom Fader. 

Vous pouvez choisir les paramètres des 
configurations à 32 et 40 faders (indiquées par le 
préfixe Min) qui utilisent le nombre minimum 
de canaux nécessaires, de sorte que la section 
Custom Fader est redimensionnée 
dynamiquement pour correspondre au nombre 
de canaux du groupe.

Dans le cas d'un système D-Command à 
40 faders, les choix d'options Maximum 
Custom Fader Bank Size sont les suivants : 4, 8, 
16, 24, 32, Min32, 40 et Min40.

Pour configurer la taille maximum de la banque de 
faders personnalisés :

1  Dans la section Soft Keys, appuyez sur la 
touche Operation plusieurs fois afin d'afficher la 
page contenant les préférences Custom Fader 
Bank Size suivantes :

CFPIug (Taille de banque de faders personnalisés 
pour les plug-in) Détermine le nombre de canaux 
alloués pour le mode Custom Fader Plug-in.

CF Grp (Taille de banque de faders personnalisés 
pour les groupes personnalisés et les groupes de 
mixage et d'édition) Détermine le nombre de 
canaux alloués pour le mode Custom Groups.

CFTyp (Taille de banque de faders personnalisés 
pour le type de piste) Détermine le nombre de 
canaux alloués pour le mode Custom Fader 
Tracks.

2  Effectuez l'une des opérations suivantes :

• Pour accroître le nombre de voies, appuyez 
sur la touche correspondant au paramètre 
de préférence à modifier.

– ou –

• Pour réduire le nombre de voies, maintenez 
la touche Maj enfoncée, puis appuyez sur la 
touche correspondant au paramètre de 
préférence à modifier.

3  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Operation pour quitter.

Nouvelle présentation de la 
touche Auto Write To

Sur D-Command, les touches Auto Write To 
appellent désormais les commandes manuelles 
Write to Start/End/All/Punch/Next et les 
commandes d'automation Write to 
Start/End/All/Punch/Next on Stop 
automatiques dans Pro Tools. 

La nouvelle présentation inclut toutes les 
commandes Manual Write et Write on Stop 
disponibles dans la fenêtre Automation de 
Pro Tools. 

Les commandes Write to Start/End/All/Punch/ 
Next peuvent également être appelées à partir de 
la section Soft Keys de D-Control. 
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Etiquettes de touche D-Command

D-Command ES Si vous disposez d'une unité D-
Command ES, vous devrez supprimer la 
superposition Lexan temporaire sur la section 
Auto Write To de l'unité principale, pour que les 
nouvelles étiquettes de touche Auto Write To 
soient visibles. 

D-Command Si vous possédez une unité 
D-Command, vous aurez besoin d'une nouvelle 
superposition Lexan pour mettre à jour la 
section Auto Write de l'unité principale. Pour 
plus d'informations concernant l'obtention de 
cette superposition Lexan, contactez le service 
clientèle de Digidesign. Vous trouverez les 
coordonnées du service clientèle de Digidesign 
correspondant à votre pays sur le site Web de 
Digidesign, à l'adresse www.digidesign.com.

Touche All

Lors d'une passe d'automation, la touche All 
applique la valeur d'automation actuelle à une 
sélection ou à une piste entière, pour tous les 
paramètres activés pour l'automation.

Pour écrire manuellement les valeurs d'automation 
sur la totalité d'une piste ou d'une sélection :

Appuyez sur la touche All pendant la lecture.

Pour écrire les valeurs d'automation sur la totalité 
d'une piste ou d'une sélection à l'arrêt  :

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis appuyez sur la touche 
All.

Pour configurer l'option Write to All on Stop afin 
qu'elle reste activée après chaque passe 
d'automation :

Maintenez enfoncées les touches Option+Ctrl 
(Mac) ou Alt+Démarrer (Windows), puis 
appuyez sur la touche All. 

Pour désactiver la fonction automatique Write to All 
à l'arrêt :

Appuyez sur la touche All.

Touche Start

Lors d'une passe d'automation, la touche Start 
applique la valeur d'automation actuelle au 
début d'une sélection ou d'une piste, pour tous 
les paramètres activés pour l'automation. 

Pour écrire manuellement les valeurs d'automation 
au début d'une piste ou d'une sélection :

Appuyez sur la touche Start pendant la 
lecture.

Les commandes Write/Trim/Glide to 
Current et Write/Trim/Glide to All Enabled 
restent accessibles à partir des touches 
programmables D-Command.

Touches Auto Write To

Touche 

Touche Touche

Touche Touche 

Automation 
Write to All

Automation 
Write to End

Automation 
Write to Next Write to Punch

Automation

 Write to Start
 Automation
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Pour écrire les valeurs d'automation au début d'une 
piste ou d'une sélection à l'arrêt :

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis appuyez sur la touche 
Start.

Pour configurer l'option Write to Start on Stop afin 
qu'elle reste activée après chaque passe 
d'automation :

Maintenez enfoncées les touches Option+Ctrl 
(Mac) ou Alt+Démarrer (Windows), puis 
appuyez sur la touche Start. 

Pour désactiver la fonction Write to Start on Stop : 

Appuyez sur la touche Start.

Touche End

Lors d'une passe d'automation, la touche End 
applique la valeur d'automation actuelle à la fin 
d'une sélection ou d'une piste, pour tous les 
paramètres activés pour l'automation.

Pour écrire manuellement les valeurs d'automation 
à la fin d'une piste ou d'une sélection :

Appuyez sur la touche End pendant la lecture.

Pour écrire les valeurs d'automation à la fin d'une 
piste ou d'une sélection à l'arrêt :

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis appuyez sur la touche 
End. 

Pour configurer l'option Write to End on Stop afin 
qu'elle reste activée après chaque passe 
d'automation :

Maintenez enfoncées les touches Option+Ctrl 
(Mac) ou Alt+Démarrer (Windows), puis 
appuyez sur la touche End. 

Pour désactiver la fonction automatique Write to 
End à l'arrêt :

Appuyez sur la touche End.

Touche Punch

La touche Punch écrit la valeur d'automation 
actuelle de tous les paramètres modifiables en 
écriture jusqu'à la valeur de point d'inflexion 
(emplacement de la piste sur lequel la passe 
d'automation actuelle a commencé). 

Pour écrire manuellement les valeurs d'automation 
jusqu'au point d'inflexion précédent :

Appuyez sur la touche Punch pendant la 
lecture.

Pour écrire les valeurs d'automation jusqu'au point 
d'inflexion précédent à l'arrêt :

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis appuyez sur la touche 
Punch. 

Pour configurer l'option Write to Punch on Stop afin 
qu'elle reste activée après chaque passe 
d'automation :

Maintenez enfoncées les touches Option+Ctrl 
(Mac) ou Alt+Démarrer (Windows), puis 
appuyez sur la touche Punch. 

Pour désactiver la fonction automatique Write to 
Punch on Stop :

Appuyez sur la touche Punch.
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Touche Next

La touche Next écrit la valeur d'automation 
actuelle de tous les paramètres modifiables en 
écriture jusqu'au point d'inflexion d'automation 
suivant. 

A l'inverse des autres commandes Write To, la 
commande Write to Next on Stop reste toujours 
activée après chaque passe d'automation, 
jusqu'à ce que vous la désactiviez. 

Pour écrire manuellement les valeurs d'automation 
jusqu'au point d'inflexion suivant :

Appuyez sur la touche Next pendant la 
lecture.

Pour configurer l'option Write to Next on Stop afin 
qu'elle reste activée après chaque passe 
d'automation :

Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis appuyez sur la touche 
Next. 

Pour désactiver la fonction automatique Write to 
Next on Stop :

Appuyez sur la touche Next.

Affichage des positions d'insert et 
de départ

Les écrans du codeur et de la voie D-Control 
affichent les informations d'insert et de départ, 
comme suit :

• Les inserts sans assignation affichent 
uniquement des lettres en majuscule (A à J) 
aux positions correspondantes.

• Les départs sans assignation affichent 
uniquement des lettres en minuscule (a à j) 
aux positions correspondantes.

• Les inserts et les départs dotés 
d'assignations affichent uniquement le 
nom de l'insert ou du départ, sans aucune 
lettre.

Sélection des plug-in dans les 
voies

Vous pouvez définir D-Command pour qu'il 
sélectionne les plug-in directement dans les 
voies plutôt que dans les faders personnalisés, 
afin que vous puissiez modifier et automatiser 
les paramètres de plug-in directement à partir 
des voies. 

Pour activer la sélection des plug-in dans les pistes 
D-Command :

1  Dans la section Console Prefs Soft Keys, 
appuyez sur la touche Operation plusieurs fois 
afin d'afficher la page contenant Channel 
Editing for Plug-ins (ChanPI).

2  Appuyez sur la touche programmable 
correspondant à ChanPI pour activer le 
paramètre (sélectionner les plug-in sur les voies) 
ou le désactiver (sélectionner les plug-in sur les 
faders personnalisés). 

3  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Operations pour quitter.

Pour donner la priorité à un plug-in sur une voie :

1  Appuyez sur la touche Inserts du canal pour 
afficher les noms des plug-in sur les codeurs du 
canal. Appuyez sur les touches Page Up et Page 
Down du canal pour afficher des plug-in 
supplémentaires.

2  Appuyez sur la touche Select du codeur pour le 
plug-in auquel vous souhaitez donner la 
priorité.
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Les commandes du plug-in sélectionné 
s'affichent sur les codeurs du canal. Vous pouvez 
passer d'une commande de plug-in à l'autre à 
l'aide des touches Page Up et Page Down du 
canal.

Pour sélectionner un plug-in à l'aide du mode 
opposé du paramètre ChanPI actuel :

Maintenez les touches Ctrl+Alt (Windows) ou 
Pomme+Option (Mac) enfoncées et appuyez sur 
la touche Select d'un plug-in. 

Modification des présélections de 
plug-in à partir des voies

Vous pouvez activer les paramètres précédents 
ou suivants du menu Librarian du plug-in, 
directement à partir d'une voie ou de la section 
Custom Fader.

Pour activer le paramètre suivant ou précédent d'un 
plug-in à partir de D-Command :

1  Effectuez l'une des opérations suivantes :

• Donnez la priorité au plug-in dans une voie 
de sorte à afficher ses commandes sur les 
codeurs de celle-ci.

– ou –

• Donnez la priorité à un plug-in de la 
section Custom Faders.

2  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur les 
touches Page Up (Suivant) ou Page Down 
(Précédent) dans les commandes Channel Strip 
Mode de ce canal. 

Modifications des touches 
programmables

Sur D-Command, plusieurs pages de touches 
programmables ont des commandes nouvelles 
ou disposées à un autre emplacement.

Touche Actions

Pour refléter plus précisément la disposition des 
touches Auto Write To sur la surface 
D-Command, les pages suivantes de la touche 
Actions présentent une nouvelle disposition des 
commandes :

Page 2

Wrt To All (Write to All) Ecrit les valeurs 
d'automation actuelles sur la totalité d'une 
sélection ou d'une piste lorsqu'une passe 
d'automation est effectuée. 

Snap Back : Force toutes les pistes activées pour 
l'écriture en mode Write ou Latch à quitter leur 
passe d'automation actuelle et à revenir 
instantanément aux niveaux d'automation 
écrits précédemment. Au cours de la lecture, 
cette commande arrête l'écriture de 
l'automation sans appliquer de rampe de niveau 
AutoMatch.

Wrt To Start (Write To Start) Ecrit les valeurs 
d'automation actuelles à partir du point 
d'insertion précédent jusqu'au début d'une 
sélection ou d'une piste, en effectuant une passe 
d'automation. 

Wrt To End (Write to End) Ecrit les valeurs 
d'automation actuelles à partir du point 
d'insertion suivant jusqu'à la fin d'une sélection 
ou d'une piste, en effectuant une passe 
d'automation. 

Wrt To Punch (Write To Punch Point) Ecrit les 
valeurs d'automation actuelles jusqu'au point 
précédent auquel l'écriture d'automation a 
commencé 
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Wrt To Next (Write to Next Breakpoint) Permet 
d'écrire, lors d'une passe d'automation, les 
valeurs d'automation actuelles du point 
d'insertion au prochain point d'inflexion. 

Touche Automation Modes

Pour refléter plus précisément la disposition des 
touches Auto Write To sur la surface 
D-Command, les pages suivantes de la touche 
Modes présentent une nouvelle disposition des 
commandes :

Page 1

AWrtTo All (Auto Write to All on Stop) Ecrit les 
valeurs d'automation actuelles sur la totalité 
d'une sélection ou d'une piste lorsque le 
transport est arrêté après une passe 
d'automation. 

Par défaut, le mode Automatic Write to All on 
Stop est activé uniquement pour une seule passe 
d'automation. Pour configurer ce mode afin 
qu'il reste activé après une passe d'automation, 
maintenez enfoncées les touches Démarrer+Alt
(Windows) ou Ctrl+Option (Mac) et appuyez sur 
la touche AWrtTo All.

AWrtTo Start (Auto Write to Start on Stop) Ecrit 
automatiquement vers l'arrière les valeurs 
d'automation actuelles à partir du point 
d'insertion jusqu'au début d'une sélection ou 
d'une piste, lorsque le transport est arrêté après 
une passe d'automation. 

Par défaut, le mode Automatic Write to Start on 
Stop est activé uniquement pour une seule passe 
d'automation. Pour configurer ce mode afin 
qu'il reste activé après une passe d'automation, 
maintenez enfoncées les touches Démarrer+Alt 
(Windows) ou Ctrl+Option (Mac), tout en 
appuyant sur la touche AWrtTo Strt.

AWrtTo Punch (Auto Write to Punch Point on Stop) 

Ecrit les valeurs d'automation actuelles jusqu'au 
point précédent auquel la passe d'automation 
actuelle a commencé. 

Par défaut, le mode Automatic Write to Punch 
Point on Stop est activé uniquement pour une 
seule passe d'automation. Pour configurer ce 
mode afin qu'il reste activé après une passe 
d'automation, maintenez enfoncées les touches 
Alt (Windows) ou Option (Mac), tout en 
appuyant sur la touche AWrtTo Punch.

Auto Join En mode Latch, la touche AutoJoin 
permet de reprendre automatiquement l'écriture 
de l'automation après l'arrêt, puis le redémarrage 
du transport au cours d'une passe d'automation.

AWrtTo End (Auto Write to End on Stop) Ecrit vers 
les valeurs d'automation actuelles à partir du 
point d'insertion suivant jusqu'à la fin d'une 
sélection ou d'une piste, lorsque le transport est 
arrêté après une passe d'automation. 

Par défaut, le mode Automatic Write to End on 
Stop est activé uniquement pour une seule passe 
d'automation. Pour configurer ce mode afin 
qu'il reste activé après une passe d'automation, 
maintenez enfoncées les touches Démarrer+Alt 
(Windows) ou Ctrl+Option (Mac), tout en 
appuyant sur la touche AWrtTo End. 

AWrtTo Next (Auto Write to Next Breakpoint on 
Stop) Permet d'écrire les valeurs d'automation 
actuelles du point d'insertion au prochain point 
d'inflexion, lorsque le transport est arrêté après 
une passe d'automation. 

La fonction Automatic Write to Next Breakpoint 
on Stop reste activée après chaque passe 
d'automation, jusqu'à ce que vous la désactiviez 
en appuyant sur la touche AWrtTo Next 
allumée.
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Touche Operation

Page 4

Import PIMaps (Import Plug-in Maps) Ouvre une 
boîte de dialogue “Choose a mapping file” dans 
Pro Tools.

Export PIMaps (Export Plug-in Maps) Ouvre une 
boîte de dialogue “Save Plug-in Mapping As” 
dans Pro Tools. 

Faders (Faders On/Off) Désactive les faders de 
D-Command pour empêcher tout mouvement 
lors de l'écoute d'un mixage.

FilBnk (Always Fill Channel Strips When Banking)  

Active ou désactive le paramètre de préférence 
qui optimise le nombre de canaux affichés en 
mode Normal lors de la création des banques. 
Lorsque cette option est activé, la création de 
banques suit le comportement d'arrêt de fin. 

FillCF (Always Fill Custom Faders When Banking)  

Active ou désactive le paramètre de préférence 
qui optimise le nombre de canaux affichés en 
mode Custom Faders lors de la création des 
banques. Lorsque cette option est activé, la 
création de banques suit le comportement 
d'arrêt de fin. 

ChanPI (Channel Strip Editing for Plug-ins) Active 
ou désactive le paramètre de préférence qui 
active l'affichage des paramètres de plug-in 
directement sur les codeurs de canaux 
D-Command. 

Touche Operation

Page 5

AsnMtx (Assign Matrix Enable) Détermine si le 
mode d'assignation normal ou via la fonction 
Assign Matrix doit être utilisé pour l'assignation 
des entrées, des sorties, des inserts et des départs. 

MtxJst (Matrix Select Area Justification) 

Détermine si les lignes de matrice d'assignation 
sont disposées de haut en bas ou de bas en haut 
sur les codeurs.

PIClmn (Plug-in Menu Column Width) Détermine 
le nombre de noms de plug-in affichés par ligne 
dans la matrice d'assignation.

IOClmn (I/O Menu Column Width) Détermine le 
nombre d'étiquettes d'E/S affichées par ligne 
dans la matrice d'assignation.

MtxLck (Assign Matrix Lock) Détermine si la 
matrice d'assignation est verrouillée par défaut 
ou si elle doit être placée en mode verrouillé 
manuellement.

EncVCA (VCA Encoder Display) Détermine si les 
commandes de pistes esclaves VCA sont 
affichées dans les codeurs des canaux VCA 
principaux.
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chapitre 11

Option logicielle Pro Tools Satellite Link

L'option Satellite Link de Digidesign vous 
permet de relier jusqu'à 5 systèmes Pro Tools (ou 
jusqu'à 4 systèmes Pro Tools et un système Avid 
Media Composer ou Video Satellite LE) sur un 
réseau Ethernet. Vous pouvez lire, arrêter et 
placer à un endroit spécifique les transports, 
effectuer des sélections de lecture et lire des 
pistes en solo, pour tout système et à partir de 
n'importe quelle station de travail reliée.

A partir de chaque système Pro Tools relié, 
Satellite Link vous permet de relier et de 
dissocier des systèmes en réseau et de voir l'état 
de liaison des autres systèmes connectés.

En définissant les préférences Satellite Link, 
vous pouvez configurer ces systèmes Pro Tools 
pour des environnements de travail mono ou 
multi-opérateurs

Vous pouvez utiliser Satellite Link 
simultanément avec MachineControl™. 
Satellite Link permet à un système Pro Tools 
relié de passer en ligne et de piloter un 
périphérique 9 broches. 

Sur les systèmes possédant une console 
D-Control, Satellite Link peut être utilisé avec le 
mode multiple D-Control, qui vous permet de 
piloter les transports de n'importe quel système 
Pro Tools en réseau à partir de la section 
D-Control Transport. 

Configuration système 
requise
Satellite Link requiert un système Pro Tools|HD 
agréé Digidesign exécutant Pro Tools 8.0 ou 
version supérieure. 

Chaque système satellite Pro Tools doit disposer 
d'une clé iLok autorisée pour l'option Satellite 
Link et d'une connexion via Ethernet à un 
réseau local (LAN). Le système administrateur 
Pro Tools n'a pas besoin de clé iLok autorisée.

En outre, chaque système Pro Tools d'un réseau 
Satellite Link doit être synchronisé sur une 
référence vidéo commune, ou “house sync”, à 
l'aide de Digidesign SYNC HD™ ou SYNC I/O™. 

Pour utiliser Media Composer avec Satellite 
Link, Media Composer 3.1 avec l'option Video 
Satellite est requis.

Video Satellite LE fournit des fonctionnalités 
Satellite Link limitées. Pour plus 
d'informations sur l'utilisation de Satellite 
Link avec Video Satellite LE, consultez le 
Guide Video Satellite LE.
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Connexions du système
Satellite Link exige que tous les systèmes reliés 
soient connectés à un réseau local Ethernet et 
synchronisés sur une référence vidéo commune 
à l'aide de Digidesign SYNC HD ou SYNC I/O. 

Tous les systèmes doivent obligatoirement être 
placés sur le même sous-réseau et il est 
recommandé que tous les systèmes soient placés 
sur le même commutateur Ethernet, afin de 
limiter les délais de réponse sur le réseau. 

Configuration de Satellite 
Link

Configuration des paramètres 
réseau

Les système Satellite Link communiquent sur un 
réseau local Ethernet. Vous pouvez configurer 
les paramètres réseau sur chaque système 
Pro Tools afin de créer un ou plusieurs réseaux 
Satellite Link sur le même réseau local. 

Interface Ethernet

Sur les ordinateurs dotés de plusieurs interfaces 
Ethernet, vous pouvez sélectionner l'interface à 
utiliser pour les communications Satellite Link.

Pour sélectionner l'interface Ethernet pour Satellite 
Link :

1  Sélectionnez Setup > Peripherals, puis cliquez 
sur Satellites.

2  Sous Advanced Network Settings, sélectionnez 
l'interface Ethernet à partir du menu déroulant 
Interface. 

3  Cliquez sur OK.

TCP/UDP Port

Les systèmes d'un réseau Satellite Link doivent 
utiliser le même port TCP/UDP pour pouvoir 
communiquer entre eux. Les systèmes satellites 
disponibles n'apparaîtront que sur les autres 
systèmes satellites utilisant le même port.

Par défaut, Satellite Link utilise le port TCP/UDP 
28282. 

Si le port par défaut est déjà en cours 
d'utilisation ou si vous voulez définir des 
réseaux Satellite Link distincts, vous pouvez 
sélectionner un port TCP/UDP différent pour la 
communication Satellite Link.

Pour sélectionner le port TCP/UDP pour la 
communication Satellite Link :

1  Sélectionnez Setup > Peripherals, puis cliquez 
sur Satellites.

2  Sous Advanced Network Settings, saisissez le 
numéro du port TCP/UDP que vous voulez que 
le système utilise.

3  Cliquez sur OK.

Configuration d'un réseau 
Satellite Link

Pour configurer des systèmes Pro Tools ou Video 
Satellite LE pour fonctionner avec Satellite Link, 
vous devez désigner un système Pro Tools du 
réseau comme système administrateur. 

Les autres systèmes du réseau sont définis 
comme systèmes satellites, puis ils sont 
référencés à partir du système administrateur. 
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Configuration de systèmes satellites

Procédez comme suit pour chaque système 
Pro Tools que vous voulez configurer en tant que 
satellite Satellite Link :

1  Sélectionnez Setup > Peripherals, puis cliquez 
sur Satellites.

2  Dans la zone de texte System Name, tapez le 
nom du système.

3  Sous Mode, sélectionnez Satellite.

4  Cliquez sur OK.

Pour configurer un système Media Composer en 
tant que Video Satellite :

1  Dans Media Composer, sélectionnez Edit > 
Preferences.

2  Dans la fenêtre Project, cliquez sur l'onglet 
Settings, puis cliquez deux fois sur Video Satellite.

3  Dans la fenêtre Video Satellite Settings, 
sélectionnez Video Satellite Mode. 

4  Cliquez sur OK.

Configuration d'un système 
administrateur

Si l'option Satellite Link n'est pas installée sur un 
système Pro Tools, celui-ci ne pourra 
fonctionner uniquement qu'en mode 
administrateur. Il est cependant possible de 
changer un système satellite en système 
administrateur. 

Pour configurer un système Pro Tools en tant 
qu'administrateur Satellite Link :

1  Sélectionnez Setup > Peripherals, puis cliquez 
sur Satellites.

2  Dans la zone de texte System Name, tapez le 
nom du système.

3  Sous Mode, sélectionnez Administrator.

4  Sous Administrator, sélectionnez le système actif 
dans le menu déroulant System 1. 

5  Cliquez sur OK.

Configuration d'un satellite dans la page Satellites de la 
boîte de dialogue Peripherals

Configuration d'un satellite dans la page Satellites de la 
boîte de dialogue Peripherals
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Déclaration de satellites

Lorsque les systèmes ont été configurés comme 
satellites, ils deviennent disponibles sur le 
système administrateur. Les systèmes satellites 
sont alors déclarés pour créer le réseau Satellite 
Link.

Pour déclarer des systèmes satellites :

1  Sur le système administrateur, sélectionnez 
Setup > Peripherals, puis cliquez sur Satellites.

2  Sous Administrator, déclarez les systèmes que 
vous voulez utiliser comme satellites dans les 
menus déroulants System 2–5. 

3  Cliquez sur OK.

Les systèmes 1–5 s'affichent, ordonnés de 
gauche à droite, dans la section Synchronization 
de la fenêtre Transport.

Liaison de systèmes 
satellites
Lorsqu'un système Pro Tools a été déclaré 
comme satellite, vous pouvez le faire passer dans 
l'état lié. Lorsqu'un système est lié, vous pouvez 
contrôler les commandes/fonctionnalités 
suivantes sur tous les systèmes liés :

• Liaison et dissociation du système

• Commandes de transport (Arrêt, Lecture, 
Avance rap., Retour arr.)

• Lecture des sélections

• Emplacement Scrub/Shuttle

• Solo d'un canal (touche Solo Clear incluse)

• Suppression des erreurs système (telles que 
les erreurs DAE)

Commandes Satellite Link

Lorsqu'un système Pro Tools a été déclaré 
comme satellite, les commandes Satellite Link 
suivantes s'affichent dans la fenêtre Transport : 

Bouton Link Contrôle l'état de liaison du système 
local.

Boutons Satellite Link Contrôle l'état de liaison 
des autres systèmes satellites. Sur chaque 
système, un de ces boutons correspond au 
bouton Link principale de ce système.

Les boutons Link s'affichent en surbrillance 
pour indiquer l'état lié.

Satellites déclarés dans la page Satellites de la boîte de 
dialogue Peripherals

Satellites déclarés dans la section Synchronization de 
la fenêtre Transport
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Pour afficher les commandes Satellite Link dans la 
fenêtre Transport :

Sélectionnez View > Transport > Synchronization 
et View > Transport > Expanded.

Pour lier ou désactiver la liaison du système 
Pro Tools local :

Dans la fenêtre Transport, cliquez sur le 
bouton Link. 

Pour lier ou désactiver la liaison d'autres systèmes 
satellites :

Dans la fenêtre Transport, cliquez sur le 
bouton Satellite Link correspondant.

Pour lier ou désactiver la liaison de tous les 
systèmes satellites déclarés :

Cliquez sur le bouton Link ou sur un bouton 
Satellite Link de la fenêtre Transport en 
maintenant enfoncée la touche Option (Mac) 
ou Alt (Windows).

Liaison de systèmes en cours de lecture

Vous pouvez relier un système lorsque lui ou un 
autre système est en cours de lecture (liaison en 
cours de lecture) ; la lecture des transports 
s'effectuera alors de façon synchronisée. Dans le 
cas où les deux systèmes sont en cours de 
lecture, le système qui vient d'être relié avance 
jusqu'à l'emplacement du système sur lequel la 
liaison a été initiée. 

Liaison des sélections de lecture

Vous pouvez définir les systèmes Pro Tools liés 
pour qu'ils transmettent et reçoivent des 
sélections de lecture d'autres systèmes satellites. 
Cela vous permet de personnaliser votre 
configuration de sorte qu'elle duplique de façon 
sélective les sélections de la fenêtre Edit entre les 
systèmes, ou que tous les systèmes dupliquent 
les sélections de la fenêtre Edit sur tous les autres 
systèmes. 

Si vous travaillez dans un environnement de 
doublage multi-utilisateurs dans lequel les 
dialogues, les effets et la musique se trouvent sur 
différents systèmes, il peut s'avérer utile de 
configurer ces systèmes de sorte qu'ils ne 
transmettent que les sélections de lecture, et de 
définir le système d'enregistrement/vidéo 
Pro Tools afin qu'il ne reçoive que les sélections 
de lecture.

Si votre environnement de mixage est mono-
utilisateur et que vous passez d'un système à 
l'autre, il peut être préférable de définir tous les 
systèmes de sorte qu'ils transmettent et 
reçoivent toutes les sélections de lecture, afin 
que vous puissiez accéder à la même sélection 
sur tous les systèmes.

Pour configurer le systèmes satellites Pro Tools afin 
qu'ils dupliquent les sélections de lecture sur tous 
les autres systèmes satellites

1  Procédez comme suit sur les systèmes sur 
lesquels vous effectuez vos sélections de lecture :

• Sélectionnez Setup > Preferences, puis 
cliquez sur Synchronization. 

– et –

• Dans la section Satellites de la page 
Synchronization, sélectionnez l'option 
Transmit Play Selections.

Commandes Satellite Link de la fenêtre Transport

Link, bouton

Boutons Satellite Link
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2  Procédez comme suit sur les systèmes sur 
lesquels vous voulez dupliquer les sélections de 
lecture :

• Sélectionnez Setup > Preferences, puis 
cliquez sur Synchronization. 

• Dans la section Satellites de la page 
Synchronization, sélectionnez l'option 
Receive Play Selections.

3  Vérifiez que les systèmes sont bien reliés.

Liaison solo

Vous pouvez définir les systèmes Pro Tools liés 
pour la transmission du statut solo de leurs 
pistes et la réception des informations de statut 
solo d'autres systèmes satellites. 

Si vous travaillez dans un environnement de 
doublage multi-utilisateurs dans lequel les 
dialogues, les effets et la musique se trouvent sur 
différents systèmes, il peut s'avérer utile de 
configurer ces systèmes de sorte qu'ils 
transmettent et reçoivent les statuts solo, et de 
définir le système d'enregistrement/vidéo 
Pro Tools afin qu'ils ne puissent ni transmettre, 
ni recevoir les solos. 

Si votre environnement de mixage est mono-
utilisateur et que vous passez d'un système à 
l'autre, il peut être préférable de définir tous les 
systèmes de sorte qu'ils transmettent et 
reçoivent les solos, afin que les solos soient 
propagés à l'ensemble des systèmes.

Lorsque l'option Solo Linking est activée, les 
pistes de tous les systèmes conservent leur état 
Solo Safe.

Lorsque l'option Solo Linking est activée, une 
opération Solo Clear (Option+Solo) supprime 
tous les solos sur les systèmes définis pour la 
réception des solos. 

Pour configurer les systèmes satellites Pro Tools 
afin qu'ils transmettent ou reçoivent l'état des 
solos :

1  Procédez comme suit sur les systèmes sur 
lesquels vous voulez écouter des pistes en solo :

• Sélectionnez Setup > Preferences, puis 
cliquez sur Synchronization. 

– et –

• Dans la section Satellites de la page 
Synchronization, sélectionnez l'option 
Transmit Solos. 

2  Dans les systèmes sur lesquels vous voulez que 
les pistes suivent le comportement des solos 
d'autres systèmes, procédez comme suit :

• Sélectionnez Setup > Preferences, puis 
cliquez sur Synchronization. 

– et –

• Dans la section Satellites de la page 
Synchronization, sélectionnez l'option 
Receive Solos.

3  Vérifiez que les systèmes sont bien reliés.

Utilisation de la fonctionnalité Solo 
Link sans liaison des commandes de 
transport

Si vous synchronisez plusieurs systèmes 
Pro Tools sur un synchroniseur externe, vous 
pouvez toujours utiliser la fonctionnalité Solo 
Link. 

Vous pouvez configurer un système satellite 
Pro Tools afin qu'il envoie toujours son état 
solo, qu'il soit lié ou non, ce qui vous permet 
d'écouter en solo des pistes sur plusieurs 
systèmes sans lier les commandes de transport. 
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Pour définir un système satellite Pro Tools pour une 
écoute solo systématique même lorsqu'il n'est 
pas lié :

1  Sélectionnez Setup > Preferences, puis cliquez 
sur Synchronization. 

2  Dans la section Satellites de la page 
Synchronization, sélectionnez l'option Solo 
Independent of Linked State.

Comportement de la fonction Solo Link 
dans les modes Solo

Solo in Place Avec Solo Link, lorsque vous 
utilisez l'option Solo In Place, le mode 
d'opération solo est déterminé par le système 
qui transmet le solo.

Si un système lié se trouve en mode Solo 
Latch, la mise en solo d'une piste sur ce système 
s'ajoute au nombre de pistes en solo, quel que 
soit le mode solo défini sur les autres systèmes 
pour la réception des solos.

Si un système lié se trouve en mode Solo 
X-OR, la mise en solo d'une piste sur ce système 
annule les solos de tous les autres systèmes, quel 
que soit le mode solo défini sur les autres 
systèmes pour la réception des solos.

Modes AFL et PFL Avec Solo Link, les solos AFL et 
PFL sur un système lié n'ont aucun effet sur les 
autres systèmes.

Le son d'une piste AFL mise en solo sur un 
système lié peut être coupé par une commande 
Solo In Place d'un autre système. Pour éviter que 
cela ne se produise, utilisez PFL au lieu d'AFL. 

Fonctionnement de Satellite Link 

Suppression des erreurs sur les 
systèmes liés

Par défaut, les systèmes liés continuent à 
fonctionner si une erreur se produit sur l'un des 
systèmes et que son transport s'arrête. 
Les messages d'erreur sur les systèmes liés 
s'affichent dans l'info-bulle du bouton Satellite 
Link correspondant de la fenêtre Transport.

Vous pouvez configurer chaque système de sorte 
qu'il interrompe la lecture en cas d'erreur. 

Pour supprimer un message d'erreur sur un système 
lié :

Dans la fenêtre Transport d'un autre système 
lié, cliquez en maintenant la touche Maj 
enfoncée sur le bouton Satellite Link 
correspondant au système affecté. 

Pour configurer un système lié afin qu'il arrête les 
transport sur tous les systèmes en cas d'erreur :

Vérifiez que l'option DAE Errors Stop All Linked 
Systems est sélectionnée dans les préférences de 
synchronisation.

Pour configurer tous les systèmes afin qu'ils 
arrêtent le transport en cas d'erreur, vérifiez que 
cette option est sélectionnée sur tous les 
systèmes liés.
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Lecture et boîtes de dialogue

Les systèmes liés arrêtent la lecture (ou 
l'empêchent de démarrer) si une boîte de 
dialogue modale (par exemple, les boîtes de 
dialogue I/O Setup, Hardware Setup ou Playback 
Engine) est ouverte sur un système lié. 

Utilisation de Satellite Link 
avec MachineControl
Satellite Link vous permet d'utiliser 
MachineControl sur un système Pro Tools lié à 
la fois. 

Lorsqu'un système Pro Tools lié est déjà en 
ligne et que vous faites passer en ligne un autre 
système Pro Tools lié, Satellite Link met 
automatiquement le premier système hors ligne.

Tout système Pro Tools lié défini sur 
“Transport=Pro Tools” suivra les commandes de 
transport Satellite Link. 

Tout système Pro Tools lié défini sur 
“Transport=Machine” ne peut pas transmettre 
les commandes de transport Satellite Link, mais 
suivra les commandes de transport uniquement 
si elles sont hors ligne. 

Prise en charge des surfaces 
de contrôle pour Satellite 
Link

Liaison de systèmes satellites
(D-Control, D-Command et C|24)

Pour lier ou désactiver la liaison du système 
Pro Tools local :

Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Online dans la section Transport. 

Touches programmables Satellite 
Link
(D-Control et D-Command)

Pour lier ou désactiver la liaison d'autres systèmes 
satellites :

1  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Modes de la section Automation Soft 
Keys.

2  Appuyez sur la touche programmable 
correspondant au nom du système à lier ou 
dissocier. 

La touche programmable s'allume en continu 
pour indiquer que le système correspondant est 
lié et elle clignote pour indiquer que le système 
correspondant affiche une erreur. 

Pour lier ou désactiver la liaison de tous les 
systèmes satellites déclarés :

Tout en maintenant enfoncées les touches 
Alt+Ctrl (Windows) ou Option+Pomme (Mac), 
appuyez sur la touche Online dans la section 
Transport.

Pour éviter l'interruption de la lecture sur un 
autre système lors de l'ouverture d'une boîte 
de dialogue modale, désactivez la liaison du 
système avant d'ouvrir la boîte de dialogue.
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Pour définir le système local pour la 
transmission solo :

Pour permuter l'état de transmission solo du 
système Pro Tools local :

1  Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, appuyez sur la 
touche Modes de la section Automation Soft 
Keys.

2  Appuyez sur la touche programmable 
correspondant à Transmit Solo.

La touche programmable reste allumée pour 
indiquer que la transmission solo est activée.
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chapitre 12

Améliorations de Pro Tools en matière de 
vidéo et de compatibilité avec Avid

Prise en charge de 
QuickTime HD
Pro Tools 8.0 offre un support de qualité 
professionnelle pour la plupart des formats 
QuickTime de définition standard (SD) ou haute 
définition (HD), y compris 720p, 1080p et 1080i 
à toutes les fréquences d'images standard.

Les codecs QuickTime les plus communs sont 
désormais pris en charge, y compris les codecs 
HD tels que h.264, DVCPro 100 et HDV.

Visualisation de QuickTime HD ou SD 
Video via une carte vidéo PCIe

(Mac uniquement)

Avec une carte vidéo PCIe agréée par Digidesign, 
Pro Tools peut lire et afficher sur divers 
moniteurs HD professionnels les fichiers vidéo 
QuickTime SD ou HD avec sortie vidéo HD 
verrouillée sur le début d'image.

Pour lire un fichier vidéo QuickTime via PCIe : 

1  Importez un fichier vidéo QuickTime dans 
une session Pro Tools.

2  Sélectionnez Options > Video Out PCIe. 

Lorsque cette option est activée, Pro Tools lit la 
vidéo sur le moniteur HD connecté par le biais 
de la carte vidéo PCIe. 

Si la fenêtre Video est ouverte pendant la lecture 
vidéo via le port PCIe, elle affichera un message 
à cet effet.

Pour basculer la sortie des vidéos QuickTime entre 
la fenêtre Video et le port PCIe, procédez de l'une 
des manières suivantes :

Sélectionnez (ou désélectionnez) Options > 
Video Out PCIe.

– ou –

Cliquez avec le bouton droit de la souris ou 
maintenez la touche Ctrl enfoncée et cliquez sur 
la fenêtre Video, puis sélectionnez (ou 
désélectionnez) Video Out PCIe.

Référence vidéo

La sortie vidéo peut être verrouillée sur une 
référence vidéo externe, y compris Black Burst et 
Tri-Level Sync.

Pro Tools HD doit être verrouillé sur une 
référence d'horloge adaptée, par exemple un 
périphérique SYNC Digidesign. Si aucune 
horloge audio externe n'est référencée, la 
piste audio ne sera pas alignée sur le début 
d'image et un décalage est alors probable. 
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Codecs QuickTime pris en charge

Les codecs QuickTime les plus communs sont 
pris en charge, y compris les codecs HD tels que 
h.264, DVCPro 100 et HDV.

Formats vidéo pris en charge

* Le format de sortie vidéo peut s'afficher sur un 
moniteur externe.

Amélioration des 
panoramiques de séquences 
AAF avec DigiTranslator 2.0
Avec DigiTranslator 2.0, Pro Tools 8.0 inclut des 
améliorations pour l'importation de séquences 
AAF générées par Avid avec des panoramiques 
en fonction des clips et la prise en charge de 
l'automation des panoramiques (clés).

Prise en charge Pro Tools 
pour Avid Interplay sous 
Windows Vista
Les système Pro Tools HD exécutés sous 
Windows Vista sont désormais compatibles avec 
le système de gestion des supports d'Avid 
Interplay Media Management.

Formats vidéo pris en charge avec PCIe

Format 
vidéo*

Fréquence 
de 
référence 
vidéo

Fréquence 
d'images 
PT

Format de 
la sortie 
vidéo*

23,976p 
NTSC

NTSC 23.976 NTSC

720p/
23,976

720p/
59,94 ou 
NTSC

23.976 720p/
59,94

1080p/
23,976

1080psf/
23,98

23.976 1080psf/
23,98

24p NTSC NTSC 24 NTSC

24p PAL PAL 24 PAL

1080p/24 1080psf/
24

24 1080psf/
24

25p PAL PAL 25 PAL

25i PAL PAL 25 PAL

1080p/25 1080i/50 
ou PAL

25 1080i/50

30i NTSC NTSC 29.97 NTSC

720p/
29,97 HDV

720p/
59,94 ou 
NTSC

29.97 720p/
59,94

720p/50 720p/50 
ou PAL

25 720p/50

1080i/50 1080i/50 
ou PAL

25 1080i/50

720p/
59,94

720p/
59,94 ou 
NTSC

29.97 720p/
59,94

1080i/
59,94

1080i/
59,94 ou 
NTSC

29.97 1080i/
59,94

Formats vidéo pris en charge avec PCIe

Format 
vidéo*

Fréquence 
de 
référence 
vidéo

Fréquence 
d'images 
PT

Format de 
la sortie 
vidéo*
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Option logicielle Media 
Composer Video Satellite
En s'appuyant sur les fonctions éprouvées de 
l'option Video Satellite basée sur Media 
Station|PT, la nouvelle option logicielle Media 
Composer Video Satellite offre les améliorations 
suivantes : 

Prise en charge de la vidéo HD

• Ajoute à Pro Tools les modèles de production 
vidéo HD Avid 

• Fournit des E/S vidéo HD Avid de qualité 
professionnelle à l'aide de Mojo DX ou 
Nitris DX

Amélioration des performances

• La richesse des fonctions logicielles de Media 
Composer permet d'accéder à une vaste 
gamme de fonctionnalités de station vidéo

• Prise en charge de Windows Vista

Option logicielle Video 
Satellite LE
L'option logicielle Video Satellite LE permet de 
préparer un système Pro Tools LE dédié pour la 
lecture vidéo et synchronisé à un système 
Pro Tools|HD principal via ethernet. Le système 
Pro Tools|HD principal joue le rôle de transport 
maître. Le système Pro Tools LE satellite 
comprenant l'option Video Satellite LE fournit 
une lecture QuickTime HD et SD de haute 
qualité, ou une lecture vidéo Avid SD avec Mojo 
SDI, sur un moniteur vidéo externe. Cela vous 
permet de placer la totalité du traitement vidéo 
sur un seul système Pro Tools LE dédié, pour 
libérer ainsi le système Pro Tools|HD principal 
pour le mixage audio et les tâches de traitement.

L'option Video Satellite LE est prise en charge 
avec un ordinateur Mac agréé Digidesign, un 
système Pro Tools LE avec Mbox 2 Micro et une 
carte vidéo Blackmagic agréée par Digidesign ou 
Avid Mojo SDI. Le système Pro Tools|HD peut 
être exécuté sous Mac ou Windows.

Pour plus d’informations, consultez le 
Guide Video Satellite LE.
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